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Use the following sections to find information on surface modelling: 

What is a surface? (see page 41) 

Surface creation (see page 49) 

Primitive surfaces (see page 4) 

Surfaces from wireframe (power surfaces) (see page 54) 

Editing power surfaces (see page 112) 

Filleting and blending (see page 186) 

Wrapping (see page 218) 

Surface morphing (see page 236) 

Trimming surfaces (see page 272) 

Preparing for manufacture (see page 307) 

 

Surface modelling 
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Primitive surfaces 
The following sections contain information on primitive surfaces: 

Creating a primitive surface (see page 4) 

Editing a primitive surface (see page 7) 

Creating a surface of revolution (see page 23) 

Editing a surface of revolution (see page 24) 

Creating an extruded surface (see page 29) 

Editing an extruded surface (see page 32) 
 

Creating a primitive surface 
1 Click the required primitive type on the Surface Creation toolbar. 

 Plane 

 Block 

 Sphere 

 Cylinder 

 Cone 

 Torus 

 Spring 

Plane — This creates a rectangular, planar surface. 
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Block — This creates an extruded rectangle (with open ends). 

 
Sphere — This creates a spherical surface by revolving a semi-
circle around the sphere's axis. 

 
Cylinder — This creates a cylindrical surface (an extruded circle 
with open ends). 
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Cone — This creates a conical surface (with open ends). 

 
Torus — This creates a toroidal surface by revolving a circle 
around an axis outside the circle. 

 
Spring — This creates a Surface Spring Primitive. 

 
2 Input a position on the screen to create a default primitive of the 

required type. 

You can exit surface creation mode at any time by clicking Select 

 on the main toolbar. A surface is not created until its origin 

is defined; if you click Select  before a surface is positioned, 
no new surface is created. 
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3 To edit the new surface: 

 use the graphical handles. 

 right-click on the surface and select Modify from the menu. 

 double-click the surface. 

If you click on the surface just created, you start editing that 
surface; if it is clicked anywhere else, a new surface of the same 
type is created in that location. 

If you wish to create a different primitive surface, select it from 
the Surface toolbar and the cursor changes accordingly to 
indicate which type of surface is created next. 

 

Editing a primitive surface 
You can edit a primitive surface in one of the following ways: 

 With the primitive selected, use its graphical handles to change 
the dimensions and orientation. 

 Use one of the operations from the Edit menu: 

 Edit > Modify — displays the primitive's dialog. 

 Edit > Convert > Surface — converts a primitive into a power 
surface. This implies that any future edits to the surface must 
be performed using methods for power surfaces and not those 
used for primitives. 

 Double-click the primitive to display its dialog. 

 You can also simultaneously edit multiple primitive surfaces (see 
page 21). 
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 Right-click the primitive to display edit menu available for 
primitives. At the top of the menu, you can see the type of the 
surface, its name and the level on which it lies. 

 
 

Graphically editing primitives 
Select the primitive to display its graphical handles. 
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Each primitive has handles similar to a workplane's graphical 
handles, as shown below. Other graphical handles which appear are 
unique to each primitive. 

 
These workplane type handles are used to: 

 move the primitive. 

 change its direction. 

 twist it about its axis. 

The unique graphical handles for each primitive are described 
below. In general: 

1 Select the handle of the dimension you wish to edit. 

2 Drag the handle to the required dimension. 

As you drag the handle, the new dimension is displayed on the 
screen. How the dimension value increases and decreases 
depends upon the zoom factor. To work with small increments, 
zoom in; to work with large increments, zoom out. 

The drag handles of primitive surfaces snap to other geometry in 
the model 

Plane graphical handles 

 
Select an edge and drag to change the width or length of a plane. 



 

10 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

Select a corner handle  and drag to move the corner to a new 
position. This will automatically convert the surface to a Power 
Surface. 

 
Block graphical handles 

 
Select the top handle  and drag to edit the height of the block. 

Select the edge handles  and drag to edit the draft angle of a 
side. 

Select an edge and drag to change width or length of the block. 
Sphere graphical handles 

 
Select and drag any of the blue curves  to edit the radius of the 
sphere. 
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Cylinder graphical handles 

 

Select the top handle  and drag to change the height of the 
cylinder. 

Select the edge and drag to change the radius of the cylinder. 
Cone graphical handles 

 
Select the top handle  and drag to change the height of the cone. 

Select the top edge  and drag to change the top radius of the 
cone. 

Select the bottom edge  and drag to select the base radius of the 
cone. 
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Torus graphical handles 

 

Select the inner curve  and drag to change the minor radius of 
the torus. 

Select the outer curve  and drag to change the major radius of 
the torus. 
Spring graphical handles 

 
Select either of these handles  and drag to change the base 
radius of the spring.  

Select this handle  and drag to change the top radius of the 
spring 

 If the Constant Radii option is ON (default), the top and 
bottom radii will be adjusted simultaneously. 

Select the top handle  and drag to change the height of the 
spring. 

 

Primitive surface dialog 
To edit a primitive surface using the dialog: 
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1 Double-click on the primitive you want to edit to display the 
following dialog: 

 
2 Use the two pages of the dialog to define the changes you want 

to make. 

 Dimensions (see page 13) 

 Workspace (see page 15) 
 

Primitive surface dialog - Dimensions 
Use the Dimensions page of the dialog to edit a surface primitive. 

 
Name - This is the name of the selected primitive. You can edit the 
name. 

Specify the following dimensions for the selected primitive: 

 Plane - Specify the Width (X), Length (Y) 
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 Block - Specify the Length (X), Width (Y), Height (Z). You can also 
apply Draft angles to four sides of a block. 

 Cylinder - Radius or Diameter is selected from the drop down list. 
You can also specify the Length. 

 Cone is specified as follows: 

a Enter the Length of the cone. 

b Select one of the options from the drop-down list.  

 
c Your selection determines the other options that are available 

on the dialog. It also affects the dimensions of the cone that 
can be changed using graphical editing. 

d Enter the other parameters. 

e Click OK. 

 Sphere - Radius or Diameter is selected from the drop down list.  

 Torus - Specify the Major Radius, Minor Radius. 

Draft - Enter draft angles for the following sides, when looking down 
the Z axis: 

 
 - Top 

 - Right 

 - Bottom 

 - Left 

You can also define the draft angles by using the drag handles that 
are displayed in the centre of each top edge of the block. 

OK - Saves the edits carried out on the primitive and removes the 
dialog from the screen. 

Cancel - Closes the dialog and discards any edits carried out on the 
primitive whilst it was displayed. 
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Primitive surface dialog - Workspace 
Use the Workspace page of the dialog to specify the primitive. 

 
You can: 

 define the Workspace in which to edit the primitive. 

 create a copy of the workplane by clicking  on the dialog. 

 define a new origin of the primitive by entering new X, Y, Z 

values or clicking  to display the Position dialog. 

 change the direction of its Axis. 
 Twist it about its axis. 
Position  

 This option is only displayed when editing a block.  

Use this option to position the origin of the block. The default option 
is centre of the base of the block. Other available options are shown 
below. All positions are relative to the default. 

 
 Top left corner. 

 Middle of top edge. 
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 Top right corner. 

 Middle of right edge. 

 Bottom right corner. 

 Middle of bottom edge. 

 Bottom left corner. 

 Middle of left edge. 
 

Spring dialog 
Use this dialog to specify or edit the dimensions for a solid spring or 
a surface spring primitive. 

1 Double-click on an existing spring to display this dialog: 

 
2 Click on the tabs to define the spring: 

 Dimensions (see page 17) 

 Workspace (see page 18) 

 Section (see page 18) 
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Spring dialog - Dimensions 
Use this page of the dialog to specify the dimensions of the spring. 

 
Name - Enter a name for the spring. 

Height - Enter the overall vertical height of the spring. The height 
can also be changed by dynamically dragging the arrow handle at 
the top of the spring. 

 The Height, Pitch and number of Turns are inter-related. If 
one value is changed another value must also change in order 
to keep the definition of the spring consistent. 

Pitch - Enter the vertical distance between consecutive turns. 

Turns - Enter the number of turns in the spring. 

  - Lock or unlock the Height, Pitch and number of Turns for the 
helix. When a dimension is locked it will not change when another 
dimension is changed. For example, if the height is locked and the 
user changes the pitch, the number of turns will change to keep the 
definition consistent. 

Top Radius - Enter the radius for the top of the spring. The top 
radius can also be changed by dynamically dragging the arrow 
handle at the top of the spring. 

Base Radius - Enter radius for the bottom of the spring. The base 
radius can also be changed by dynamically dragging the arrow 
handle at the bottom of the spring. 

Constant Radii - Select this option to keep the base and top radii 
equal. The default setting is ON. 

Flip Direction - Select this option to flip the direction of the spring 
between clockwise and anti-clockwise. 
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Spring dialog - Workspace 
Use this page of the dialog to specify the Workspace details of the 
spring. 

 
Workspace options - These options allow you to: 

 define the workspace in which to edit the primitive. 

 change the primitive's workspace. 

 move the primitive’s origin. 

 change the direction of its axis. 

 twist it about its axis. 
 

Spring dialog - Section 
Use this dialog to specify the Section details for a solid spring or a 
surface spring primitive. 

 
Type - Select one of the options:  
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 Circle - Select this option to create a circle type spring: 

 
 Polygon - Select this option to create a polygon type spring: 

 

 Additional options for polygon type springs are displayed. For 
further details see Polygon Options (see page 20). 

Top scale factor - Enter a factor by which the scale of the section 
radius increases along the height. The example below shows a 
polygon type solid spring with a section radius of 35 and a scale 
factor of 5. 

 
Radius - Enter the radius for the section. 
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Spring dialog - Section - Polygon options 
When you select a Polygon type spring on the Section page of the 
Spring dialog, additional options are displayed. 

 
Number of sides - Specify the number of sides for the polygon type 
spring. 

Rotation angle - Specify the rotation angle for the section. The 
example below shows two, four-sided polygon solid springs. The 
spring on the left was created with a rotation angle of 0. The spring 
on the right was created with a rotation angle of 30. 

 
Fillet radius - Enter a radius to create fillet arcs between each 
straight edge of the polygon type spring. If set to zero, no arcs will 
be created. 
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The example below shows two, four-sided polygon type solid 
springs. The spring on the left was created with a Fillet radius of 0. 
The spring on the right was created with a Fillet radius of 3 and is 
highlighted to show the fillets. 

 
 

Editing multiple primitive surfaces 
You can edit multiple primitive surfaces of the same type at the 
same time. 

This function is available for surface: 

 planes 

 blocks 

 cylinders 

 cones 

 spheres 

 tori 

 springs 

To edit multiple primitive surfaces of the same type: 

 This example shows how to edit multiple surface blocks, 
however the same concepts apply for all surface primitives. 

1 Select a number of primitive surfaces that you want to edit (for 
example blocks) with one of the following methods: 

 Press and hold the Shift key and click the blocks. 

 Press and hold the Ctrl key and click the blocks. 

 Click and drag the cursor over the blocks. 
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2 Right-click one of the selected primitives, and select Modify. 

 
The dialog to edit the appropriate selected primitives is displayed 
(for example, the Block dialog). The dialog is similar to that of 
editing a single primitive of the same type, with the following 
differences: 

 — The properties that differ between the selected primitives 
are highlighted in pink. 
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 — The range of values is displayed when you hover the cursor 
over a property. 

 

 You can also double-click one of the selected primitives to 
display the dialog. 

3 Edit the properties. 

4 Click OK to apply the changes to the selected primitives and 
close the dialog. 

 

Creating a surface of revolution 
A surface of revolution is created from a wireframe object which is 
rotated around one of the axes of the current workspace. We 
recommend you create a workplane to make sure the surface of 
revolution is created around the correct axis. 

1 Select a wireframe object. 

 

2 In the status bar, select the Principal plane button  for 
the axis you want to rotate around. 

To rotate the curve around the Y axis, select the Y Principal plane 
button. 

3 Click  (Surface toolbar). 
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The new surface is created. 

 
 

Editing a surface of revolution 
You can edit a surface of revolution in one of the following ways: 

 With the surface of revolution selected, use its graphical handles 
to change the orientation. 

 Use one of the operations from the Edit menu: 

 Edit > Modify... - displays the surface of revolution's dialog. 

 Edit > Convert > Surface - converts a primitive surface into a 
power surface. This implies that any future edits to the 
surface must be performed using methods for power surfaces 
and not those used for primitives. 

 Double-click the surface of revolution to display its dialog. 
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 Right-click the surface of revolution to display edit options 
available for surfaces of revolution. At the top of the context 
menu, you can see the type of the surface, its name and the 
level on which it lies. 
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Graphically editing a surface of revolution 
Select the surface of revolution to display its graphical handles. 

 
These handles are used to: 

 move the revolution. 

 change its direction. 

 twist it about its axis. 
 

Revolution dialog 
Use this dialog to edit a surface of revolution: 

 
Click on the tabs to define the revolution: 

 Dimensions (see page 27) 

 Workspace (see page 27) 

 Sketch (see page 28) 
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Revolution dialog - Dimensions page 
Use this page of the dialog to define the dimensions for the surface 
of revolution. 

 
Name - This is the name of the selected surface of revolution. The 
name can be edited. 

Angle - This is the angle that the wireframe object is rotated around 
the axis. 

 

 Angle = 360  

 Angle = 270  

 - Reverse direction. This reverses the surface so that the outside 
of the surface becomes the inside, and the inside becomes the 
outside. 

OK - Saves the edits carried out on the surface of revolution and 
closes the dialog. 

Cancel - Closes the dialog and discards any edits carried out on the 
surface of revolution whilst it was displayed. 

 

Revolution dialog - Workspace 
Use this dialog to edit the workspace options for the surface of 
revolution. 
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It is the same as Primitive Surface dialog - Workspace (see page 
15) 

 

Revolution dialog - Sketch page 
Use this page of the dialog to edit the wireframe for the surface of 
revolution. 

 

Create a copy of the sketch 
Click this button to add a copy of the composite curve to the model. 
The Information dialog is displayed to confirm the copy. 

 

Replace sketch 
Click this button to replace the sketch curve. Use the dialog to 
select the curve to replace. 

 

Edit sketch 
Click this button to edit the wireframe. The example below is used 
to show you how to edit the wireframe. 

1 Click Edit sketch. The following is displayed: 

 wireframe. 

 Curve Edit toolbar.  
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  is displayed on the dialog. 

 
2 Delete two of the points, by using the graphical handles or the 

options on the Curve edit toolbar. 

 

3 Once you have finished editing the wireframe, click  to accept 
the edit or  to cancel the edit. 

 
 

Creating an extruded surface 
You can create extruded surfaces from single or multiple wireframe 
objects. 
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1 Select one or more wireframe objects. 

 

2 Click  (Surface toolbar). 

3 If a single wireframe object was selected, it is extruded to form a 
surface. 

 
4 If multiple wireframe objects were selected, the Extrusion 

Dimensions dialog is displayed. This dialog allows you to set the 
dimensions of the extruded surfaces. 

 
Select the following wireframe objects: 

 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 31  

Input the values for the length and draft angle for the extruded 
surfaces. You can create an extrusion in both directions by 
entering values for Direction 1 - Length and Direction 2 - Length. 

Click Preview to see the extruded surfaces. 

 
You can change the values and click Preview again to update the 
surfaces. 

 
5 Click OK to accept the surfaces that you have previewed and 

close the dialog. 

To edit an extruded surface see Editing an extruded surface (see 
page 32) 

If the wireframe is non-planar, the extrusion is in the positive 
direction of the axis normal to the principal plane. 

If the wireframe is planar, the extrusion is normal to the plane in 
which the wireframe lies. You can change this default by deselecting 
the Create extrusions normal to planar base option on the Tools > 
Options > Object > Surfaces dialog. 

The wireframe used to create the extruded surface is removed from 
the model by default. You can add the wireframe to the model again 
using the Extrusion dialog. This is displayed by double-clicking the 
surface. 
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To keep the wireframe in the model whenever you create an 
extruded surface, select the Keep Wireframe option on the Tools > 
Options > Object > Surfaces dialog. 

 

Editing an extruded surface 
You can edit an extruded surface in one of the following ways: 

 With the extruded surface selected, use its graphical handles to 
change the orientation. 

 Use one of the operations from the Edit menu:  

 Edit > Modify - displays the extruded surface's dialog. 

 Edit > Convert > Surface converts an extruded surface into a 
power surface. This implies that any future edits to the 
surface must be performed using methods for power surfaces 
and not those used for extruded surfaces. 

 Double-click the extruded surface to display its dialog. 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 33  

 Right-click the extruded surface to display edit options available 
for extruded surfaces. At the top of the context menu, you can 
see the type of the surface, its name and the level on which it 
lies. 
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Graphically editing an extruded surface 
1 Select the extruded surface to display its graphical handles. 

 
The workplane type handles are used to: 

 move the extrusion. 

 change its direction. 

 twist it about its axis. 

The blue handles  edit the length and negative length of the 
extruded surface. 

 
1 To edit the length, select the top handle and drag it to the 

required height. 

As you drag the handle, the new dimension is displayed on the 
screen. 
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How the dimension value increases and decreases depends upon 
the zoom factor. To work with small increments, zoom in; to 
work with large increments, zoom out. 

 
You can also drag the handle in the negative Z direction. 
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Extrusion dialog 
This dialog is used to edit an extruded surface. 

 
The dialog has three pages: 

 Dimensions (see page 36) 

 Workspace (see page 38) 

 Sketch (see page 39) 
 

Extrusion dialog - Dimensions 
Use this page of the dialog to specify the dimensions for the surface 
extrusion. 

 
Name - This is the name of the selected extrusion. The name can be 
edited. 

Direction 1 - Length - This is the Length of the extrusion. The length 
can be zero if the length specified in Direction 2 is non-zero. 
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Direction1 - Draft Angle - This is the Draft Angle from the base of the 
extrusion. The angle is measured from the axis normal to the 
principal plane. 

 
Direction 2 - Length - This is the negative length of the extrusion. 

Direction 2 - Draft Angle - This is the draft angle of the extrusion in 
the negative length. 

 
After you have entered a value, the model updates dynamically 
to reflect the change. 

If required, click  to check that the draft angle is constant. 

Select Equal lengths to set the same Length for Direction 1 and 
Direction 2. 

Click  to Reverse direction. This reverses the surface so that the 
outside of the surface becomes the inside, and the inside becomes 
the outside. 

Click OK to save the edits carried out on the extruded surface and 
remove the dialog from the screen. 

Click Cancel to close dialog and discard any edits carried out on the 
extruded surface whilst it was displayed. 
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Extrusion dialog - Workspace 
Use this dialog to edit the workspace of an extrusion. 

 
Workspace options - Use these options to: 

 define the workspace in which to edit the extrusion. 

 change the extrusion's workspace. 

 move the extrusion's origin. 

 change the direction of the extrusion's axis. 

 twist the extrusion about its axis. 

 create a copy of the workplane by clicking  on the dialog. 

Enter the X Y Z coordinates or click the Position  button to open 
the Position dialog where you can use position entry tools. 

Skew - If selected, any changes to the workplane will change the 
direction of the extrusion without affecting the base curve. If 
deselected, then changes to the workplane will change the 
orientation and position of the whole extrusion. 

 - This makes the Z axis of the workplane perpendicular to the 
plane in which the base curve lies. If the base curve is non-planar 
then the plane of best fit is calculated. 
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Extrusion dialog - Sketch 
Use this page of the dialog to edit the wireframe for the extrusion. 

 

Create a copy of the sketch 
Click this button to add a copy of the composite curve to the model. 
The Information dialog is displayed to confirm the copy. 

 

Replace sketch 
Click this button to replace the sketch curve. Use the dialog to 
select the curve to replace. 

 

Edit sketch 
Click this button to edit the wireframe. The example below is used 
to show you how to edit the wireframe. 

1 Click Edit sketch. The following is displayed: 

 wireframe. 

 Curve Edit toolbar.  
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  is displayed on the dialog. 

 
2 Delete two of the points, by using the graphical handles or the 

options on the Curve edit toolbar. 

 

3 Once you have finished editing the wireframe, click  to accept 
the edit or  to cancel the edit. 
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What is a surface? 
A surface can be defined as the exposed layer of a material . 

 
A surface model is a representation of a surface. A geometric 
modeller is an instrument used to model a surface. 

PowerSHAPE is a geometric modeller with wireframe and surface 
modelling capabilities. It is particularly suitable for the design and 
analysis of components with complex shapes and surfaces. 

A surface modelled using PowerSHAPE is known as a power surface. 
You can imagine a power surface to be like a skin with no thickness, 
placed on a material. 

The following figure shows how a power surface can be viewed as a 
skin. The skin is lifted up from the material. 
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Power Surface 
A Power Surface is made up of a network (or wireframe) of curves. 

 
Some curves run along the surface. These curves are called 
longitudinals . 

 
Others run across the surface. These are called laterals . 

 
The surface will always pass exactly through these curves, which 
can each be individually edited. The curves control the key points 
which the surface must pass through, and the tangent directions at 
those points. To add finer control to a surface, create an extra 
lateral or longitudinal control curve. 
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The area of the surface between adjacent pairs of laterals and 
longitudinals is called a patch . 

 
The control curves are cubic Bezier curves. This type of curve can 
be specified as a series of points through which the curve must 
pass, together with optional tangent directions into and out of each 
point. 

Power Surfaces are mainly created from a network of curves. Fillet, 
split and draft surfaces are also Power Surfaces.  

For further details, see Editing Power Surfaces (see page 112). 
 

Surfaces from wireframe 
Surfaces can be created directly from wireframe. For example, this 
wireframe: 
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gives you the following surface: 

 
 

Fillet surfaces 
Filleting allows you to take a selection of surfaces: 

 
and create fillet surfaces between them to give you this: 

 
For further details see How do I create a fillet surface? (see page 
186) 

 

Split and draft surfaces 
For further details, see Preparing surfaces for manufacture. (see 
page 307) 
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Complex surfaces 
More complicated surfaces are made by combining several power 
surfaces together. It is often convenient to define such surfaces by 
power surfaces which intersect or overlap. The power surfaces may 
be trimmed by the lines of intersection, known as trim boundaries. 
The power surfaces, together with their defining curves and 
boundaries, comprise the data for a model stored in the database. 

 

Joining surfaces 
In real life, there's usually more to surface design than handling 
single surfaces. Most design jobs involve defining, and matching up, 
two or more surfaces which have to be joined together by a 
smoothly curved surface: For example, to avoid the risk of stress 
concentrations, or merely for the sake of aesthetics. 

 

Parameterised (primitive) surfaces 
In PowerSHAPE, you can quickly create surfaces that are defined by 
a few simple parameters, rather than a network of curves. 

For example, the cylinder shown below is a parameterised surface. 
You may only edit its parameters: length, radius and orientation. To 
edit one of its curves to a new shape, it must first be converted to a 
power surface. 

 
PowerSHAPE provides the following parameterised surfaces: 

 primitives: planes, blocks, spheres, cylinders, cones, springs and 
tori. 

 extruded surfaces. 

 surfaces of revolution. 
 

Primitive surfaces 
Each of the primitive surfaces is shown below. 
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 - Plane 

 - Block 

 - Cylinder 

 - Cone 

 - Sphere 

 - Torus 

 - Spring 
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Extruded surface 
You can create surfaces by extruding composite curves as shown 
below. 

This composite curve: 

 
gives the following extruded surface: 
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Surface of revolution 
A surface of revolution  is created from a wireframe object . 

 
 

Other surface types 
As an alternative to re-designing existing objects within the 
program, surface data may be transferred from another system into 
PowerSHAPE. Various interface standards are supported, and 
surfaces read in this way may be kept in a new model and edited to 
correct errors and design flaws. 

 

NURBS surfaces 
Non-Uniform Rational B-Spline (NURBS) surfaces are a powerful 
way of representing surfaces internally in a CAD program, but users 
find it difficult to understand and control surfaces using a complex 
array of knots, weights, and so on. Power surfaces are much easier 
to control. 

NURBS surfaces can be read from other CAD systems. 
 

BCP surfaces 
Rational Bezier Control Point (BCP) surfaces can be read from other 
CAD systems. 
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Creating surfaces 
To use Surface modelling: 
1 Ensure that you have a model displayed. 

2 Select Surface  from the main toolbar. The Surface toolbar 
will be displayed. 
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This is the same as selecting Surface from the Object menu to see 
the surface creations options. 

 

When you first start PowerSHAPE and click Surface , 
PowerSHAPE automatically starts primitive plane creation. If you 
want a different surface creation option, select the option you want 
from the Surface creation menu. PowerSHAPE remembers the last 

surface creation option used when you next click Surface . 

Each button in the Surface creation toolbar is described below. 

 Smart Surfacer (see page 54) — Click this button to open the 
Smart Surfacer. 
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 Primitive surface (see page 4) flyout toolbar: 

 Plane 

 Block 

 Cylinder 

 Cone 

 Sphere 

 Torus 

 Spring 

 Revolution (see page 23) — Click this button to create a surface 
of revolution. 

 Extrude (see page 29) — Click this button to create an extruded 
surface. 

 Bead (see page 103) — Click this button to create a bead 
surface from wireframe. 

 From Patches (see page 106) — Click this button to create a 
surface from patches  

 From Mesh (see page 107) — Click this button to create a 
surface from a mesh 

 Draft (see page 324) — Click this button to create a draft 
surface 

 Split (see page 309) — Click this button to create a split 
surface 

 Extend (see page 332) — Click this button to create an 
extension of a surface 

 Fillet (see page 186) — Click this button to create a fillet 
surface. 
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 Blend (see page 214) — Click this button to create a blend 
surface 

 Wrap Triangles (see page 219) — Click this button to wrap 
triangles. 

 Addendum (see page 344) (Toolmaker only) — Click this button 
to create an addendum surface. 

 Fill edge (see page 340) (Toolmaker only) — Click this button 
to create a fillet edge surface. 

 Drawbead (see page 353) (Toolmaker only) — Click this button 
to create a drawbead surface. 

 Untrim (see page 355) (Toolmaker only) — Click this button to 
untrim a trimmed surface.  

 

Creating a surface 
There are various ways to create a surface according to the type of 
surface you require. For further details, see 

What is a surface? (see page 41) 

Surface creation (see page 49) 

Primitive surfaces (see page 4) 

Power surfaces (see page 54) 

Automatic surfacing (see page 54) 
 

Creating a surface primitive using the command window 
You can specify the dimensions of a primitive before you input the 
origin point. 

To create a block with origin at 0 0 0, you could type the following 
in the command window: 

create surface block  
length 45  
width 67.89  
height 43  
0 0 0 

If you don't specify a particular dimension, then the default value is 
used. You can specify the following dimensions: 

radius   



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 53  

width  

length   

height   

minor_radius  

major_radius  

base_radius  

top_radius 
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Surfaces from wireframe (Power 
Surfaces) 

The following sections contain detailed information on creating 
surfaces from wireframe: 

Smart Surfacer (see page 54) 

Creating a surface from a network of wireframe (see page 61) 

Creating a surface from separate wireframe curves (see page 73) 

Creating a fill-in surface (see page 77) 

Creating a plane of best fit (see page 83) 

Creating a surface from a drive curve (see page 84) 

Creating a surface from triangles (see page 90) 

Creating a surface from two rails (see page 98) 

Creating a bead surface (see page 103) 

Creating a surface from patches (see page 106) 

Creating a surface from a mesh (see page 107) 
 

The Smart Surfacer 
The Smart Surfacer selects the optimum surface creation method, 
displays the best solution in the Smart Surfacer dialog and applies it 
to the selection. All the surface creation methods are ordered in 
priority of best solution and displayed in the Smart Surfacer dialog.  

See Also: 
What is Smart Surfacer? (see page 54) 

Using Smart Surfacer (see page 55) 

Smart Surfacer dialog (see page 57) 
 

What is the Smart Surfacer? 
The Smart Surfacer uses a single dialog to create a surface from a 
selection of items. The following surface creation methods are used 
by the Smart Surfacer: 

 From network (see page 61) 

 From separate (see page 73) 

 Fill-in (see page 77) 
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 Drive-curve (see page 84) 

 Two rails (see page 98) 

 Plane of Best Fit (see page 83) 

 Developable (currently under development) 
 

Getting the best from the Smart Surfacer 
The Smart Surfacer is designed to automatically create a surface 
from selected items using the optimum surface creation method. 
This is ideal for new users to create a surface quickly and easily and 
for less complex items. 

For more advanced users, or for more complex models you may 
wish to use advanced options to fine tune the surface creation 
solution further. 

We recommend you follow the sequence described below to create 
the surface you require.  

1 Start Smart Surfacing to create a surface from your selection. For 
further details see Using the Smart Surfacer (see page 55). If the 
created surface meets your requirements, click OK on the Smart 
Surfacer dialog to complete the Smart Surfacer. 

2 If you wish to see solutions from other surface creation methods, 

click the next and previous buttons  on the Smart Surfacer 
dialog. This cycles through the other optimum surface creation 
methods and displays their surface creation solutions on the 
selection. If the displayed surface creation method meets your 
requirements, click OK to complete Smart Surfacer. 

3 If you wish to force surface creation using another method, click 
on the drop-down list on the Smart Surfacer dialog to list all the 
surface creation methods available. Select a method to try to 
force it to create a surface from the selection. If surface creation 
is not possible using the method selected, an error message is 
displayed. 

4 Enhance surface creation by improving the selection. Create 
additional Guide-Curves on the wireframe where required and 
start the Smart Surfacer again to see the results. 

5 Select Advanced on the Smart Surfacer dialog to specify 
advanced options for the current surface creation method. 

 

Using the Smart Surfacer 

1 Click the Smart Surfacer  button on the Surface toolbar. 
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This is the same as selecting Smart Surfacer from the 
Object/Surface menu.  

The Smart Surfacer dialog is displayed.  

 
2 Select the required items to automatically create a surface. 

The Smart Surfacer selects the optimum surface creation method, 
displays the best solution in the Smart Surfacer dialog and applies 
it to the selection. All the surface creation methods are ordered 
in priority of best solution and displayed in the Smart Surfacer 
dialog.  

3 Click the next and previous buttons   to cycle through the 
other optimum surface creation methods and see the effects of 
solutions on the selection. 

4 Click OK to complete the Smart Surfacer. 
 

Smart Surfacer - Changing the wireframe selection 
You can add or remove wireframe items in the selection easily by 
pressing and holding the Shift or Ctrl keys as you select them.  

The Smart Surfacer automatically applies the optimum surface 
creation method to the new wireframe selection and grows or 
reduces the surface creation accordingly. The new method used is 
displayed in the Method section of the dialog and the results are 
displayed in the graphics window. 
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Smart Surfacer dialog 
This dialog is used to create a surface automatically using the best 
solution from the available surface creation methods. 

 
Surface Type 

Select one of the surface types to change the surface type 
creation, if required. 

PowerSurface(s) — This option is automatically selected to create 
a PowerSurface from the selected items, with the exception of 
the Fill-In surface creation method which is a NURBS surface.  

If a fill-in surface fit is outside of the working tolerance, the 
words Fit:- 0.abcd is displayed in red text next to NURBS instead 
of a warning dialog. You may wish to change the fitting by using 
the Advanced options.  

NURBS — Select this option to create a NURBS surface from the 
selected items. The result is previewed automatically if Automatic 
Previewing is ON. This option is only available for the following 
surface creation methods: 
 From Network 
 From Separate 

Options 

Automatic Previewing — Select this to preview the results of the 
surface creation method automatically. The default is ON 

Tangent to Surface(s) — This option is greyed out if none of the 
selected curves have surface dependencies. If the selected 
curves have dependencies, select this option to create a surface 
that is tangent continuous to the surrounding surface. 

 The Tangent to Surfaces option is automatically remembered 
for the next surface creation of the same type.  
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CompCurve Creator — Select this option to display the Create 
Composite Curve toolbar and to create composite curves 
dynamically. For further details see, Creating Composite Curves 
during Smart Surfacer (see page 59). 
Method 

 — Click to cycle through the optimum surface creation 
methods. If the Automatic Previewing option is selected, the 
surface creation solution is displayed for the selected items. The 
currently selected surface creation method is displayed. The 
following surface creation methods can be selected: 

 From Network (see page 61) 

 From Separate (see page 73) 

 Fill-In (see page 77) 

 Drive Curve (see page 84) 

 Two Rails (see page 98) 

 Plane of Best Fit (see page 83) 

 From triangles (see page 90) 

 Network over triangles (see page 90) 

 Developable (currently under development) 

If the surface creation method selected by Smart Surfacer is not 
the one you want, you can force a different method by selecting 
it from the drop-down list.  

 

 An error message is displayed if the forced surface creation 
method is not possible for the selected items. 

Lock — Click the Lock  button to set a default method of 
surfacing. A locked method is used to create surfaces using the 
Smart Surfacer dialog, unless that method is not applicable to the 
selection. 

The following limits apply to locking a method: 

 You can lock and unlock a method at any time. 
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 Using the Previous  or Next  buttons will cancel the lock 
when multiple methods are available for your selection. 

 Selecting a method from the drop-down list in the Method 
area will cancel the lock if that method is different to your 
locked method 

Preview — Select to preview the results. You may make changes 
and preview again. 

Apply — Select to apply the results. 

Advanced — This displays the method Options dialog for the current 
surface creation method. These options are for the individual 
surface creation methods used to create the surface. 

 Press  when the main page of the Smart Surfacer is 
displayed as a shortcut to enter the guide-curve deselection 

mode. Press  again to exit the deselection mode.  

For further details on the Advanced options for the Smart Surfacer 
creation methods, see: 

 From Network (see page 62) 

 From Separate (see page 74) 

 Fill-In (see page 79) 

 Drive Curve (see page 85) 

 Two Rails (see page 99) 

 Plane of Best Fit (see page 83) 

 From triangles (see page 91) 

 Network over triangles (see page 95) 
 

Creating Composite Curves during Smart Surfacer 
You can create additional composite curves dynamically during 
automatic surfacing, by selecting the CompCurve Creator button on 
the Smart Surfacer dialog.  

1 Click the CompCurve Creator button. The Create Composite Curve 
toolbar is displayed. Use the Composite Curve toolbar to create 
the composite curve. 

2 To create another composite curve use additive picking.  

 Additive picking is the item selection method where you 
press and hold the Shift key as you select objects to add 
them to the current selection of objects. 

The newly created composite curves remain in the selection. 
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As new composite curves are added to the current selection or to 
the current surface, Smart Surfacer automatically uses the optimum 
surface creation method to create a new surface from the new 
selection of wireframe items, depending on the composite curves in 
the item selection. 

 

Creating Guide Curves dynamically 
A Create A Guide button on the Options dialogs lets you create 
guide-curves during Smart Surfacer. To display these dialogs, click 
Advanced on the Smart Surfacer dialog. 

 From Network (see page 62) 

 From Separate (see page 74) 

 Drive Curve (see page 85) 

Creating a new guide curve during surface creation 
Create a guide curve using one of the following methods: 

 Using Create a Guide button: 
1 Click the Create A Guide button. The button changes to Finish 

The Guide.  

 Click in the graphics area with the right mouse button to 
activate Create A Guide. 

1 Click the positions on the wireframe to create the new guide 
curve. Guide-curves can only snap the the primary creation 
curves of the wireframe. 

2 Select Finish The Guide to complete the new guide curve 
creation. 

 Guide-Curve creation can be halted manually by clicking 
the Finish The Guide button.  

Guide-Curve creation also halts automatically when the 
number of separate selected curves is reached. 

 Using the keyboard: 

1 Press  on the keyboard. 

2 Click the positions on the wireframe to create the new guide 
curve. 

3 Press  again to exit guide curve creation. 

The new guide curves are added to the selection automatically, but 
can be deselected if required. 
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Creating a surface from a network of wireframe 
You can construct laterals and longitudinals of the new surface from 
a network of wireframe objects. 

 
The surface is created within the outer boundary formed by the 
wireframe objects. PowerSHAPE sorts the wireframe into laterals 
and longitudinals, reversing or renumbering them as required. 

 
1 Select the wireframe. 

2 Start the Smart Surfacer (see page 55) to create your surface.  

3 Ensure that the required creation method is displayed in the 
drop-down list. 

4 Select Advanced on the Smart Surfacer dialog to change the 
surface creation options.  

5 Use the Network of wireframe options dialog (see page 62) to 
change the surface options and click OK. 

6 Click OK on the Smart Surfacer dialog to create the surface. 
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Network of Wireframe Options dialog 
This dialog is used to change the advanced surface creation options. 

 
Selection mode — This allows you to select objects to define your 
surface. Since objects can be used for different reasons, different 
options are provided to reflect this. You can specify whether the 
objects selected are to be wireframe, corners or guide curves. 

 Wireframe — You can select the wireframe to create the surface 
before displaying this dialog, however this option allows you to 
select extra wireframe or change the selected wireframe objects. 

 Corners — This allows you to enter graphically the corners of the 
surface. To do this, switch on the option. Click a position on the 
wireframe where you want a corner. A small circle with a cross in 
it marks the position. If no corners are defined, then 
PowerSHAPE decides where the corners of the surface are 
depending on the discontinuities in the wireframe selected. 

 Guide-Curves(s)... — Sometimes none of the edge-matching 
options give you the shape you require because the wrong points 
on successive curves are joined. You can define which points 
should be linked by defining a wireframe object between them. 
In the new surface, these points will be joined by a smooth 
curve, which does not necessarily follow the shape of the 
wireframe object. 

To use this option, select the option and then select wireframe 
objects. To use an existing curve as a guide-curve, select this 
option and select the curve. 

 A wireframe object which links points on laterals must cross 
all laterals. The wireframe must already exist in your model 
before using this surface creation command. 

 Create a guide — Use this button to create guide-curves 
dynamically (see page 60) during Automatic surfacing.  
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 A wireframe object that links points on laterals must cross all 
laterals; a wireframe object that links points on longitudinals 
must cross all longitudinals. The wireframe must already exist 
in your model before using this surface creation command. 

Tangent to surfaces — This option is available when a composite 
curve lying on a surface is one of the selected wireframe objects. If 
this option is selected, the new surface is made tangent-continuous 
with the underlying surfaces of the selected composite curves only 
along its outer edges. 

Use NURBS — If selected, this option creates a NURB surface 
instead of a power surface. 

 This option is only available with the Tangential option from 
the Interior Interpolation option menu. If the Linear option 
from the Interior Interpolation option menu is already 
selected when you select this option, it changes to Tangential 
and you are warned. Similarly, if Tangent to surfaces is 
selected when you select the Linear option from the Interior 
Interpolation option menu, Tangent to surfaces is turned off 
and you are warned. 

Edge matching — Edge matching options (see page 64) determine 
how surface curves are fitted to your new surface. Choose an option 
from the following: 

 Arc length (see page 69) 

 Tangent direction (see page 66) 

 Width of curve (see page 66) 

 None (see page 66) 

 Repoint (see page 70) 

 To control exactly where the points lie on the surface, design 
each curve with the same number of points. Use the Edge 
Matching option None. The surface will then be created with 
points on each lateral only at the points you supply. 

Interior interpolation — This determines the curvature of new laterals 
and longitudinals added to the network.  

 Tangential preserves tangent directions as much as possible 
across spans. If tangents at start and end of spans are parallel, 
then intermediate tangents are parallel too. If they lie in the 
same plane, then the intermediate tangents are in the same 
plane too. This option is automatically used when Tangent to 
surface is ON, and is recommended for most other cases. 
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 Linear links the opposite edges of patches by lines which are 
similar in shape to the existing curves on the sides of the patch. 
This option is recommended for twisted surfaces with straight 
edges. 

For example, consider the following wireframe. 

 
The following surfaces are created with Tangential and Linear 
options. 

 
Corner tolerance — Enter a value that is used to decide whether a 
point, where two wireframe objects meet, is a corner point of a 
surface curve. For further details, see Corner tolerance (see page 
72). 

Preview — Display the surface created using the current settings in 
the dialog. You may continue to change the settings in the dialog 
until you are satisfied with the previewed surface. 

Apply — Save the surface. The dialog remains open for you to select 
more wireframe objects and continue creating surfaces. 

OK — Save the surface created and close the dialog. 

Cancel — Close the dialog and do not create a surface from the 
selected wireframe. 

 

Edge matching options 
Edge matching options determine how surface curves are fitted to 
your surface from your selected wireframe. 
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PowerSHAPE creates an initial network of laterals and longitudinals 
based on the selected wireframe. 

Consider the following wireframe. 

 
The initial network for this wireframe is given below. 

 
PowerSHAPE then checks that each point lies at the junction of a 
lateral and longitudinal. 

PowerSHAPE adds extra surface points and curves to the initial 
network so that each point lies at the junction of a lateral and a 
longitudinal. How PowerSHAPE does this depends on the edge 
matching option you select. 

You can choose from the following options: 

 None (see page 66) 

 Tangent direction (see page 66) 

 Width of curve (see page 66) 

 Arc length (see page 69) (default) 

 Repoint (see page 70) 

If the spans have different numbers of guide curves, the surface is 
created as if you had selected the default Arc Length option. 
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Edge Matching > None 
This matches points if corresponding spans have the same number 
of points. 

If the spans have the same number of points, then the new curves 
pass through the corresponding points. No new points are added to 
the surface. 

 

Edge Matching > Tangent direction 
New surface curves are added by matching points (which do not lie 
at the junction of a lateral and longitudinal) with the same tangent 
directions. 

PowerSHAPE checks points similar to the arc length option (see 
page 69), except the tangent directions at the points are compared.  

The effect is that new curves follow features such as corners, rather 
than simply being regularly spaced between the given wireframe. 

In the figure below, you can see the original wireframe  and then 
the surfaces created using the tangent direction  and arc length 
options . With the tangent direction option, the points are 
matched where the tangent directions are equal. 

 
 

 

Edge Matching > Width of curve 
This option is similar to the arc length option. The arc length 
compared points along the spans. This option projects the spans 
and points onto a straight line from the start to the end of each 
curve, and then compares the points along the lines instead of the 
span. 
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Consider the spans  in the following network of wireframe. 

 

The spans are projected onto lines in the same plane . 

 

Each point is projected onto the line . 
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PowerSHAPE checks to see if points exist at approximately the same 
percentage along the line of a corresponding span . 

 
If a point exists at approximately the same percentage along the 
line of a corresponding span, then no point is added, otherwise a 
new point  is projected from the line and added to the span. 

 
Surface curves are added to the matching points. 
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The complete surface generated from the network of wireframe is 
shown below. 

 
You can compare the above surface with the surface (shown below) 
created using the arc length option. 

 
 

Edge Matching > Arc length 
New surface curves are added by matching points (which do not lie 
at the junction of a lateral and longitudinal) along the length of the 
span. 

If a point lies at x percent along a span, then PowerSHAPE checks if 
points lie at approximately x percent along the corresponding 
spans. 

Consider the point on the surface below. 
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Then, the corresponding spans shown below are checked. 

 
If a point exists at approximately x percent along a corresponding 
span , then no point is added, otherwise a point is added . 

 
All the points at approximately x percent join together to define a 
new surface curve . 

 
PowerSHAPE continues adding curves to the surface until each point 
is at the junction of a lateral and a longitudinal. 

 
 

Edge Matching > Repoint 
Sometimes the default option results in a surface that has too many 
internal surface curves close together, so that the surface is rippled. 
This is a problem often occurs when the surface is created from 
many curves, each with a different distribution of points. 

When you select Repoint: 
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 The points within each span are redistributed so that the spans 
are approximately the same shape. 

 The number of points on each curve is increased so that each 
curve has the same number of points as the curve with the most 
points.  

The effect of using Repoint can be seen using the following example: 

 

 Using Arc Length (default) option. 

 Using Repoint option. 

 

 

 Although the resulting surface will generally be smoother, 
with fewer internal surface curves, repointing can alter the 
shape of the curve so that the surface may deviate from the 
original geometry. 
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Corner tolerance 
Corner tolerance is a value defined by you. It is used to decide 
whether a point where two wireframe objects meet is a corner point 
of a surface curve. To explain this graphically, suppose we have two 
curves A and B as shown below: 

 
Point P is where they meet. Corner tolerance is used to decide 
whether: 

 Point P is a corner point of a surface curve where curve A defines 
one surface curve and curve B another. 

 Point P joins curves A and B to define the same surface curve. 

Corner tolerance is compared with an angle between the two 
curves. This angle, which we will call C, is defined as follows. 

Two tangent vectors are defined at point P: one for curve A  and 
the other for curve B . 
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Angle C is the angle between these two vectors. 

 
If the corner tolerance is greater than angle C, then point P is 
classed as a corner point. This implies that curve A defines one 
surface curve, and curve B another. 

If the corner tolerance is less than or equal to angle C, then curves 
A and B are taken to be a composite curve which passes through 
point P. 

 

Creating a surface from separate wireframe curves 
You can create a surface from a set of separate curves. 

 
The curves become laterals on the new surface. Longitudinals are 
added to join up the laterals. 
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This method also creates B-spline surfaces from B-spline curves by 
default. 

1 Use the Separate wireframe selection dialog to select the 
wireframe or change default creation options. 

2 Select the wireframe. 

3 Start the Smart Surfacer (see page 55) to create your surface.  

4 Ensure that the required creation method is displayed in the 
drop-down list. 

5 Select Advanced on the Smart Surfacer dialog to change the 
surface creation options.  

6 Use the Separate wireframe options dialog (see page 74) to 
change the surface options and click OK. 

7 Click OK on the Smart Surfacer dialog to create the surface. 
 

Separate Wireframe Options dialog 
This dialog is used to change the surface creation options. 

 
Selection mode - This allows you to select objects to define your 
surface. Since objects can be used for different reasons, different 
options are provided to reflect this. You can specify whether the 
objects selected are to be wireframe or a guide curve. 

 Wireframe - A tick is displayed if wireframe objects are selected, 
otherwise a cross is displayed. Select the wireframe objects, if 
none are already selected. You can also change the selection. 

 Guide-Curve(s) ... - Sometimes none of the edge-matching options 
gives you the shape you require, because the wrong points on 
successive curves are joined. You can define which points should 
be linked by defining a wireframe object between them. In the 
new surface, these points will be joined by a smooth curve, 
which does not necessarily follow the shape of the wireframe 
object. 
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To use an existing curve as a guide-curve, select this option and 
select the curve. 

  The wireframe object which links points on laterals must 
cross all laterals. Also, the wireframe must already exist in 
your model before using this surface creation method. 

 Create a guide - Use this option to create guide-curves 
dynamically during Automatic-Surfacing. For further details see 
Creating Guide Curves dynamically (see page 60). 

Tangent to surface - This option is available when a composite curve 
lying on a surface is one of the selected wireframe objects. If this 
option is selected, the new surface is made tangent-continuous with 
the underlying surfaces of the selected composite curves only along 
its outer edges. 

Automatic point and/or guide-curve insertion - Attempt to insert 
guide-curves automatically. This option may help untwist the 
surface as in the case below. 

 
If this option is ON, any previously selected guide-curve will be 
deselected. If the option is ON and you manually select a guide-
curve, the option will be turned off. 

Use NURBS - If ON, this option creates a NURB surface instead of a 
power surface. 

Close curves longitudinally - This creates a closed surface from 
wireframe. For example, consider the following wireframe. 
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With this option turned OFF, the surface on the left  is created 
from the wireframe. With the option ON, the surface on the right  
is created. 

 
Edge matching - Edge matching options determine how surface 
curves are fitted to your new surface. Choose an option from the 
following: 

 Arc length (see page 69) 

 Tangent direction (see page 66) 

 Width of curve (see page 66) 

 None (see page 66) 

 Repoint (see page 70) 

 B-Spline (only available when B-spline curves are selected) 

If you are not sure which option to use, try each one to find which 
one gives you the most suitable surface. 

The B-spline option creates a B-spline surface from the selected B-
spline curves. All B-spline curves must have the same number of 
points. 

 To control exactly where the points lie on surface, design each 
curve with the same number of points. Use the Edge Matching 
option None. The surface will then be created with points on 
each lateral only at the points you supply. 

Preview - Displays the surface created using the current settings in 
the dialog. You may continue to change the settings in the dialog 
until you are satisfied with the previewed surface. 

Apply - Saves the surface. The dialog remains on the screen for you 
to select more wireframe objects and continue creating surfaces. 

OK - Saves the surface created and removes the dialog from the 
screen. 

Cancel - Removes the dialog from the screen and does not create a 
surface from the selected wireframe. 
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Creating a fill-in surface 
You can create a surface to fill selected wireframe. 

An example is shown below. 

 
The surface fills the area enclosed by the wireframe. 

 
You can also make the surface pass through point objects. 

 
If only point objects are selected, the surface fits the points. 
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An example is shown below. 

 
The surface fits the points. 

 
Unlike most surface creation options, this command creates a 
trimmed surface when wireframe objects are selected. In other 
words, the command generates a larger surface and then creates 
trim boundaries to trim this surface back to the required region. 
This makes this method of surface creation very suitable for filling 
complex shaped boundaries such as those with many sides or even 
spikes. Conventional untrimmed surfaces cannot be easily created 
for such boundaries. 

 This can also be used to fill holes. To fill a hole, create a 
composite curve of the hole. Create a surface to fill the hole. 

1 Select the wireframe. 

2 Start the Smart Surfacer (see page 55) to create your surface.  

3 Ensure that the required creation method is displayed in the 
drop-down list. 

4 Select Advanced on the Smart Surfacer dialog to change the 
surface creation options.  
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5 Use the Fill-in surface options dialog (see page 79) to change the 
surface options and click OK. 

6 Click OK on the Smart Surfacer dialog to create the surface. 
 

Fill-in Surface Options dialog 
This dialog is used to change the surface creation options. 

 
Selection mode - This allows you to select objects to define your 
surface. 

 Wireframe/Point(s) - A tick is displayed if wireframe or point 
objects are selected, otherwise a cross is displayed. Select 
wireframe or point objects, if none are already selected. You can 
also change the selection. 

Tangent to surfaces - This option is available when one of the 
selected wireframe objects is a composite curve with dependencies 
on an underlying surface. 

For a non-planar composite curve with dependencies, the fill-in 
surface will be tangent continuous by default. 
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Turn off the Tangent to surfaces option on the Fill-in Surface 
options dialog to produce a fill-in surface that is non-tangent 
continuous. 

 
For a planar composite curve with dependencies, the fill-in 
surface will be non-tangent continuous by default. 

 
Turn on the Tangent to surfaces option on the Fill-in Surface 
options dialog to produce a fill-in surface that is tangent 
continuous. 

 
The area is filled with multiple surfaces if a single surface would be 
naturally creased. 

In the example below, we will add a fill in surface. 
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The result is shown below. 

 
The command creates the following surfaces. 

 
This only works if the area to be filled can be divided into a central 
continuous region  with neighbouring continuous regions . 

 
It includes the case where the central region has only one 
neighbouring region. 
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Multi-patch / Single patch - This creates either a single or multiple 
patch surface. A single patch surface  is made of only two laterals 
and two longitudinals, whereas a multiple patch surface  can have 
many laterals and longitudinals. 

 

 The Single patch option is generally better for internal 
smoothness and the Multi-patch option for tangent continuous 
fill-ins. The Multi-patch option is usually quicker and fits the 
wireframe more accurately than the Single patch option. 

Degree of surface for the fitting - You can change the degree of the 
new surface. The value you choose will depend on your selected 
objects and what you want the resulting surface to look like. For 
high values, the surface: 

 is flexible; 

 fits the selected objects more accurately; 

 may have ripples. 

For low values, the surface: 

 is more rigid; 

 flatter; 

 may not fit the selected objects accurately. 

Insert extra curves into a single patch - If the surface is either a 
trimmed plane or a single patch, you can insert a lateral and a 
longitudinal at the mid-points of the bounding curves using this 
option. You will only see the extra curves when you click Apply or 
OK. 

 You must turn on the Draw continuous interior laterals on 
NURBS option on the Surface page of the Options dialog to see 
the interior laterals and longitudinals on a NURB surface. 

Preview - Displays the surface created using the current settings in 
the dialog. You may continue to change the settings in the dialog 
until you are satisfied with the previewed surface. 
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Apply - Saves the surface. The dialog remains on the screen for you 
to select more objects and continue creating surfaces. 

OK - Saves the surface created and removes the dialog from the 
screen. 

Cancel - Removes the dialog from the screen and does not create a 
surface from the selected objects. 

 

Creating a plane of best fit 
You can create a plane of best fit through selected wireframe and 
points. 

 
1 Select the wireframe. 

2 Start the Smart Surfacer (see page 55) to create your surface.  

3 Ensure that the required creation method is displayed in the 
drop-down list. 

4 Select Advanced on the Smart Surfacer dialog to change the 
surface creation options.  

5 Use the Plane of best fit selection dialog (see page 83) to change 
the surface options and click OK. 

6 Click OK on the Smart Surfacer dialog to create the surface. 
 

Plane of Best Fit Selection dialog 
This dialog is used to select wireframe or point objects and creates 
the plane. 

 
Wireframe/Point(s) — A tick is displayed if wireframe or point objects 
are selected, otherwise a cross is displayed. Select wireframe or 
point objects, if none are already selected. You can also change the 
selection. 
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Preview — Displays the plane created using the current selection. 
You may change your selection until you are satisfied with the 
previewed plane. 

OK — Saves the primitive plane created and removes the dialog 
from the screen. 

Cancel — Removes the dialog from the screen and does not create a 
plane from the selected objects. 

 

Creating a surface from a drive curve 
You may want your longitudinals to follow a particular path. 
PowerSHAPE allows you to specify a curve to define this path. This 
curve is known as the drive curve. You can select a line, arc, curve 
or composite curve from your model to define the drive curve. 

An example of a drive curve is shown below . 

 
The surface is created along the drive curve. 

 
The drive curve can be open or closed. You can use a single lateral 
or any number of laterals. If the drive curve is longer than where 
the laterals lie, extra laterals are created at the end of the drive 
curve. 
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 If you want the same shape for the laterals along the whole 
surface, use a single lateral. 

1 Select the wireframe. 

2 Start the Smart Surfacer (see page 55) to create your surface.  

3 Ensure that the required creation method is displayed in the 
drop-down list. 

4 Select Advanced on the Smart Surfacer dialog to change the 
surface creation options.  

5 Use the Drive curve surface options dialog (see page 85) to 
change the surface options and click OK. 

6 Click OK on the Smart Surfacer dialog to create the surface. 
 

Drive-Curve Surface Options dialog 
This dialog is used to change the default options and create the 
surface. 

 
Selection mode — This allows you to select objects to define your 
surface. You can specify whether the objects selected are to be 
wireframe or a drive curve. 

 Wireframe — A tick is displayed if wireframe objects are selected, 
otherwise a cross is displayed. Select the wireframe objects, if 
none are already selected. You can also change the selection. 

 Drive-curve — Switch on and select a drive curve. You can select 
a line, arc, curve or composite curve from your model to define 
the drive curve. 
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 Guide-curves(s)... — Sometimes the wrong shape is created, 
because the wrong points on successive curves are joined. You 
can define which points should be linked by defining a wireframe 
object between them. In the new surface, these points will be 
joined by a smooth curve, which does not necessarily follow the 
shape of the wireframe object. 

 The wireframe object which links points on laterals must 
cross all laterals. Also, the wireframe must already exist in 
your model before using this surface creation command. 

To use an existing curve as a guide-curve, select this option and 
select the curve. 

 Create a guide — Use this to create guide-curves dynamically 
during Automatic-Surfacing. For further details see Creating 
Guide Curves dynamically (see page 60). 

Tangent to surface — This option is available when a composite 
curve lying on a surface is one of the selected wireframe objects. If 
this option is selected, the new surface is made tangent-continuous 
with the underlying surfaces of the selected composite curves only 
along its outer edges. 

Automatic point and/or guide-curve insertion — Attempt to insert 
guide-curves automatically. This option is available for use with 
separate closed curve surfaces and drive-curve surfaces with closed 
sections. This is ON by default. 

If ON, 

 any previously selected guide-curve will be deselected. 

 the option will be turned off if you manually select a guide-curve. 

 This option and the manual Guide-Curve creation option are 
mutually exclusive. 
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Parallel to drive-curve — This option is available when a drive curve 
is selected. When on, longitudinals leave and enter laterals with the 
same tangent direction as the drive curve. For example, consider 
the following wireframe. 

 
The following surfaces are created with Parallel to drive-curve off  
and on . 

 
Keep width constant - If ON, the thickness of the surface shape is 
kept throughout, by adding in extra points for the complex region of 
the drive curve. 
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Drive-curve discontinuity smoothing — If the angle of discontinuity is 
less than the value given here, all tangent discontinuities are 
smoothed when generating the drivecurve surface. The model below 
shows the result if the discontinuity of the drive curve is greater 
than the Drive curve discontinuity smoothing angle. 

 
If you increase the Drive-curve discontinuity smoothing angle, the 
tangent discontinuities are smoothed. 

 
Drive curve interpolation — This controls how laterals are orientated 
relative to the drive curve. 

Reference direction — Laterals are orientated relative to a 
reference direction, which is set to be approximately at right 
angles to the whole drive curve. Portions of each lateral, which 
are at right angles to the drive curve, are made to correspond, 
by linking them with longitudinals. New laterals are aligned to 
match the orientation. This option is best for a planar or only 
slightly 3D drive curve. 

Curvature — Successive laterals are orientated so that they twist 
as little as possible as we move along the drive curve. This 
option is best for a drive curve that is straight or lies entirely in 
one plane. 

Manual reference direction — The reference direction is aligned 
with the Z axis of the active workplane without reference to the 
drive curve. This option is recommended for advanced users 
only. 

Helical — Use this option to create helical sweep surfaces.  
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For example, consider the following wireframe. 

 
The surface below is created with Helical Interpolation. 

 
Manual alignment direction — Aligns to, and rotates around Z-axis 
of active workplane. 

 
Minimal lateral variation — Minimises the changes of alignment 
from one lateral to the next 

 
Edge matching — Select an appropriate option from the drop-down 
list (see page 64). 
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Preview — Display the surface created using the current settings in 
the dialog. You may continue to change the settings in the dialog 
until you are satisfied with the previewed surface. 

Apply — Save the surface. The dialog remains on the screen for you 
to select more wireframe objects and continue creating surfaces. 

OK — Save the surface created and close the dialog. 

Cancel — Close the dialog and do not create a surface from the 
selected wireframe. 

 

Creating a surface from triangles 

 
To create a surface from triangles: 

1 Select a model that includes a mesh and wireframe. 

2 Click  (Surface toolbar) to start Smart Surfacer. 
3 Select one of the following methods from the drop-down list: 

From triangles 
Network over triangles 

4 Click Advanced to display the options page for the method you 
have chosen: 

Surface from triangles dialog (see page 91) 

Network of wireframe over triangles dialog (see page 95) 
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Surface from triangles options 
This option uses selected wireframe and mesh points to create a 
surface. 

 
1 Using the example below as a guide, select the following on your 

model: 

 Wireframe boundary 

 Wireframe islands 

 Mesh 
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Once the mesh is selected, the Comparison analysis colour map 
and deviations are displayed by default on the preview of the 
surface: 

 
2 Select the following options as appropriate: 

 Tangent to the surrounding surfaces to create the surface 
tangent to the surrounding surfaces on which the selected 
curves are dependent. 

 Tangent to mesh to create the surface tangent to the mesh. 

 Limit mesh to curves before surface fitting to create a surface 
from a mesh that has been limited. This is the default setting 
and will create a surface that ignores any triangles that are 
outside the limiting curve. If this option is deselected, the 
surface that is created is fitted to the whole mesh. 

3 Enter the Surface fitting tolerance to indicate the allowable 
discrepancy between the mesh and the created surface. A large 
tolerance will produce a surface that does not closely match the 
underlying mesh. 

4 Move the slider to change the Points proportion.This sets the 
percentage of points inside the boundaries that are used to fit 
the surface. 
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5 Move the slider to change the Orientation angle that defines the 
direction of the surface laterals and longitudinals. In the 
following example, shade deviations and the colour map have 
been deselected so that the surface laterals and longitudinals are 
visible. 

 
The default angle is 0.0; changing the angle may produce a 
surface that is a better fit for the triangles. In the example 
below, the Orientation angle has been changed to 45 . 

 
6 Move the Number of patches slider to adjust the number of 

patches. Increasing the number of patches will improve the fit of 
the surface to the triangles. 



 

94 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

7 Click Hide deviations to display the model without the colour map. 

 
If the colour map is not displayed, click Display deviations to 
show the deviations and the colour map. 

8 Shade deviations automatically is deselected by default. Select this 
option to change the default setting when the dialog is next 
displayed. 

9 Click Preview to see the results. If necessary, make changes and 
click Preview. 

10 Click Apply to create the surface. The dialog continues to be 
displayed. Create additional surfaces as required. 

11 When all the surfaces have been created, click OK. To cancel the 
surface creation, click Cancel. 

 Cancel will cancel all the surfaces that you have created 
whilst the dialog has been displayed.  
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Network of wireframe over triangles 

 
1 Select the following on your model: 

 Wireframe 

 Mesh 

 Corners (optional) 

 Guide curves (optional) 

Use Corners and Guide curves to help define the shape of the 
surface. 

2 Select the following options as appropriate: 

 Tangent to surface to create the surface tangent to the 
surrounding surfaces on which the selected curves are 
dependent. 

 Tangent to mesh to create the surface tangent to the mesh. 
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 Fit surface to triangles by projecting it. Use this option to 
project the surface to the curve as shown in the following 
example:  

 
Selecting this option is useful when a mesh contains a 
damaged edge. It uses a curve that bridges the gap in the 
damaged mesh, where there are missing triangles. When the 
surface is created, this option causes the surface to be 
projected to the curve that was created. 

 
If the option is deselected (default), the edge of the surface is 
matched to the damaged edge of the mesh, as shown above. 

 Use NURBs to create a NURB surface instead of a power 
surface. 

3 Enter Repoint tolerance. 

4 Deselect Repoint curves to produce a surface that closely 
matches the triangles, including any triangles that might contain 
errors. In the example below, this produces an unsmooth surface 
that is almost identical to the mesh. 

 
Selecting Repoint curves is recommended if the curves have a lot 
of randomly distributed points. Repointing the curves will 
produce a smoother surface, as shown below: 
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The following diagram shows the surface construction that result 
from the two options: 

 With Repoint curves deselected, all the internal surface curves 
are displayed. 

 With Repoint curves selected, the surface curves are evenly 
distributed as the result of repointing. 

 

 Repointing can alter the shape of the curve so that the 
surface may deviate from the original geometry. 

5 Click Hide deviations to display the model without the colour map. 

 
If the colour map is not displayed, click Display deviations to 
show the deviations and the colour map. 

6 Shade deviations automatically is deselected by default. Select this 
option to change the default setting when the dialog is next 
displayed. 

7 Click Preview to see the results. If necessary, make changes and 
click Preview. 

8 Click Apply to create the surface. The dialog continues to be 
displayed. Create additional surfaces as required. 

9 When all the surfaces have been created, click OK. To cancel the 
surface creation, click Cancel. 

 Cancel will cancel all the surfaces that you have created 
whilst the dialog has been displayed.  
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Creating a surface from two rails 
You can create a surface from a section curve  and two rail curves 

. 

 
Copies of the section are positioned at adjacent points along the two 
rails. These copies are scaled and rotated versions of the original 
one. The surface is created from the net. 

 
To create a surface using this method, the section and rails must 
satisfy the following: 

 The section must be a single, open wireframe object. 

 Each rail must be a single wireframe object. 

 The two rails must have the same number of points and both be 
either closed or open. 
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 The ends of the section must touch the ends of the rails . 

 
To create a surface from a section and two rails: 

1 Select the wireframe. 

2 Start the Smart Surfacer (see page 55) to create your surface.  

3 Ensure that the required creation method is displayed in the 
drop-down list. 

4 Select Advanced on the Smart Surfacer dialog to change the 
surface creation options.  

5 Use the Options for surface from section and two rails dialog (see 
page 99) to change the surface options and click OK. 

6 Click OK on the Smart Surfacer dialog to create the surface. 
 

Options for surface from section and two rails dialog 
Use this dialog to set the options that will be used to produce the 
surface. 
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Selection Mode 
Section -  is displayed if there is no wireframe selected. Select a 
wireframe object for the section.  changes to  when a wireframe 
object is selected . You can also change the wireframe selection. 

Drive-rails -  is displayed if there is no section selected. Select the 
option, then select two wireframe objects for the rails.  changes to 

 when two rails are selected . 

Orient Options 
Select one of the following options: 
 Planar 
 Biplanar 
 Axial 
In most cases, the default option should give you the correct result. 
If you click Preview and the resulting surface is not what you 
expect, use one of the other options. 
Example 1 

 
The example above produces the following surfaces: 

 Planar option 

 Biplanar option 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 101  

 Axial option 

 
The results for Axial and Biplanar look the same. 

Example 2 

 
The example above produces the following surfaces: 

 
The three options produce three different results. 

Section Options 
These options let you apply different criteria to the section that is 
used to generate the surface. 

The example below shows that if both options are unchecked, the 
height of the profile will increase along the length of the drive rails. 
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Maintain depth - The height of the profile will be maintained for the 
length of the drive rails. In the image below,  shows the depth: 

 
The example below illustrates the surface that will be produced if 
Maintain depth is used. 

  
Maintain end tangent direction - The angle of the tangent of the drive 
rail and the surface is maintained for the length of the drive rails. To 
use this option there needs to be at least one point on the profile. 
In the image below:  

 Tangent angle at the intersection of the profile and drive curve. 

 Drive curve. 

 Tangent angle at the intersection of the surface and drive curve.  

 
The example below illustrates the surface that will be produced if 
Maintain end tangent direction is used. 

  



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 103  

You can select Maintain depth and Maintain end tangent direction 
together. The example below illustrates the surface that will be 
produced if both options are chosen. 

  
 

Creating a bead surface 
You can create a surface that bulges using any wireframe. 

1 Select the wireframe. 

2 Click  (Surface toolbar). 

3 Use the Bead surface dialog (see page 103) to create a bulge. 
 

Bead surface dialog 
This dialog creates a bead surface from the selected wireframe. 

 
Points — The number of points in this list corresponds to the points 
on your wireframe. At each point you can specify the chord length 
of the arc and the bulge distance. You can select more than one 
point and specify the parameters for the selection. 

 Length — Enter length of the chord for selected point(s). 
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 Bulge — Enter bulge distance for selected point(s). 

 
Insert — Insert a point between two existing points. The Points 
list and the labels on the curve are renumbered accordingly. This 
means that you can specify more precisely the shape of the bead 
surface between two points. 

In the example, there are four points. Values have been entered to 
define points 1, 2 and 4. The position of point 3 has been obtained 
by interpolation. 

 
Entering a value of 1.5 into Insert, will create another point between 
point 1 and point 2. The points are then relabelled, so that the 
inserted point is point 2. You can modify the Length and Bulge 
parameters for the new point to define the shape of the surface 
more precisely. 

 
Lock points — This option is OFF by default until you enter a Length 
or Bulge value. If OFF the Length and Bulge at this point will be 
obtained by interpolating the values of the locked points. The end 
points of open curves are locked by default. 

Label curve points — If ON, the original curve is displayed, with 
point numbers by each point marker. If OFF, point numbers are not 
displayed. The default setting is ON. 
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Use as centreline — Select this option to create a bead surface either 
side of the centreline along the curve. 

 
Close longitudinally — Select this option to create a closed bead 
surface in the longitudinal direction. 

 
Direction — Select an option from this list to specify the direction of 
the surface creation. 

Normal — Align surface to underlying wireframe normals. 

Best fit normal — Select this option to create a bead surface from 
a non—planar curve that is the best fit for the normal of the 
curve. 

The example below shows the bead surface with the option not 
selected (OFF). 
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This example shows the difference when the option is selected 
(ON). 

 
Radially — Set direction radially outwards from wireframe. 

Align to axes — Set direction to axis in principal plane. 

Preview — This displays the surface using the given parameters. If 
the resulting surface is not correct, change the parameters and click 
Preview again. The instrumentation at point 1 can be used to 
reverse the direction of the bulge. 

 
OK — Click this button to create the surface. 

Cancel — Click this button to quit the command without creating the 
surface and remove the dialog from the screen. 

 

Creating a surface from patches 
You can generate a surface from patches. The surface will be 
created from a series of patches and you enter the points at the 
intersection of the lateral and longitudinal. 

1 Click  on the Surface toolbar. 

2 Complete the Surface Creation From Patches dialog. (see page 
106) 

3 Create the points on the first lateral. 

4 Create the points on the second lateral. The surface will be 
automatically generated. 

You can create as many laterals as you like, varying the number 
of points in every lateral if required. 

 

Surface Creation From Patches dialog 
This dialog is used to create a surface from points on laterals. 
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Points along the lateral - Enter the number of points on the lateral. 

 — Undo the last entered point. 

Points still required - The number of points that still need to be 
entered to complete the current curve. The number of points still 
required is reduced each time you enter a point. This option 
becomes active when you click the ARM button. 

  — Use these buttons to turn the sound prompting on and off.  
 — Open a window showing number of points that are still 

required to complete the current lateral. 

Keep wireframe - If ON, the wireframe is retained when OK is 
selected. If OFF, only the surface is displayed. 

Create NURBS surface - If ON, this option creates a NURB surface 
instead of a power surface. 

Close longitudinally - Closes the curves longitudinally when 
generating the surface. 

Close laterally - Closes the curves laterally when generating the 
surface. 

Preview - Displays a preview of the surface that has been created. 

Apply - Click to save and apply the created surface so that another 
surface can be created without exiting the dialog. Multiple surfaces 
can be created as required.  

OK - Save the surface that has been created and exit Surface 
Creation From Patches.  

 

Creating a surface from a mesh 
Use the Mesh Surfacing toolbar to generate a surface from a mesh. 
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1 Click  to display the Surface toolbar. 

 

2 Click  to display the Mesh surfacing toolbar (see page 109). 

 
3 Use the buttons on the toolbar to select the options to be used 

when creating the surface from a mesh. 

4 Sketch a curve on the mesh using the following mouse controls: 

 
Add the first and intermediate points 
to a surface edge. This option is also 
used to finish a surface contour, when 

the  is used to indicate the start 
point of the contour. 

 
Insert discontinuity to a surface edge. 

 
Finish a surface edge. 

5 Use  to undo points when creating the curve. Once the 

surface has been created,  cancels the whole surface 
creation. 

Changing the surfacing algorithm 
In PowerSHAPE <NEW>, a new surfacing algorithm was introduced 
to improve performance and fix occasional problems will inverted 
tangency. The new algorithm, CUBIC_PLUS, is used by default. 

If you get poor tangent matching between the surface and the 
mesh, you can switch to the older surfacing algorithm. With the 
Surface from mesh toolbar displayed, enter a command 
ALGORITHM CUBIC. The change to the algorithm is maintained for 
the duration of the session, but it reverts to CUBIC_PLUS when you 
restart PowerSHAPE.  
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Use the command ALGORITHM CUBIC_PLUS to revert to the new 
alogoritm within a PowerSHAPE session. 

Use the command ALGORITHM SHOW to see which surfacing 
algorithm is in use. 

 

Mesh surfacing toolbar 

 
Use the buttons on the toolbar to select the options to be used 
when creating the surface from a mesh: 

 
Click to produce a trimmed (NURB) or 
untrimmed surface. 

 

 Enter the contour sketching tolerance to 
define the quality of fit between the 
contour and the mesh. 

  
Click to create a surface with a pre-
defined number of laterals and 
longitudinals (see page 111). 
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Click to create a surface tangent to 
existing surfaces (deselected by 
default). The surface will match the 
existing surface, without reference to 
the underlying triangles. This option can 
be applied separately to each contour 
segment. 

 

 
Click to turn a point of a mesh into a 

corner. Use  to create a point when 
picking the point. 

 
Click to view the deviation of the 
created surface from the underlying 
mesh. Create the surface by picking 
contour points on the mesh. The 
following shows the deviations on a 
surface created tangent to the 
underlying mesh: 

 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 111  

 
Click to toggle whether the triangles 
covered by the new surface are shown 
or hidden. 

 
 

Pre-defined number of laterals and longitudinals 

1 Click  to create a surface with a pre-defined number of 
laterals and longitudinals. The U and V options are activated. 

 
2 Enter the number of laterals (U). 

3 Enter the number of longitudinals (V). 

The surface will be automatically generated with the required 
number of laterals and longitudinals. 

 Enter a value of 0 for U and V to choose to insert zero laterals 
and longitudinals. 
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Editing Power surfaces 
A Power Surface is a surface created from wireframe items. Editing 
curves and points within a surface uses the same methods as 
editing wireframe curves. 

You can edit a Power Surface in the following ways: 

 Double-click the surface to display the Surface/Curve Edit (see 
page 112) toolbar. 

 Use the options available from the Edit menu (see page 150). 

 Use the graphical surface editing features (see page 163). 

 Right-click the surface to open the Power Surface context menu 
(see page 178). The top of the context menu displays the type of 
the surface, its name, and the level on which it lies. 

You can also find details on fixing surfaces (see page 179) and 
inspecting surfaces (see page 182) in this section. 

 

Editing a Power Surface using the toolbar 
When you create or select a Power Surface, the Surface/Curve Edit 
toolbar is displayed, and the options that are appropriate for your 
surface are made available. 

 
Use the following table to identify the buttons on the toolbar: 
 Name Edit menu Function 

 
Select 
Curves 

Surface and Curve Edits > Surface 
Edits > Select Curves/Points > 
Select Curves... 

Select curves on a 
surface (see page 
114) 

 
Select 
Curves 
in Active 
Direction 

Surface and Curve Edits > Surface 
Edits > Select Curves/Points > 
Select Curves in Active Direction 

Select all curves in 
current direction (see 
page 115) 

 
Select 
All 
Curves 

Surface and Curve Edits > Surface 
Edits > Select Curves/Points > 
Select All Curves 

Add all curves to 
selection (see page 
116) 
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Select 
Points 

Surface and Curve Edits > Surface 
Edits > Select Curves/Points > 
Select Points... 

Select pattern of 
points (see page 
116) 

 
Add 
Curve 

Surface and Curve Edits > Surface 
Edits > Add Curves > Add Curve... 

Add curve (see page 
118) 

 
Add 
Curve 
from 
Wirefram
e 

Surface and Curve Edits > Surface 
Edits > Add Curves > Add Curve 
from Wireframe 

Insert curve from 
wireframe (see page 
124) 

 
Add 
Spine 

Surface and Curve Edits > Surface 
Edits > Add Curves > Add Spine 

Create spine (see 
page 126) 

 
Delete 
Curve 

Surface and Curve Edits > Surface 
Edits > Delete Curve 

Delete the curve (see 
page 128) 

 
Stitch Surface and Curve Edits > Surface 

Edits > Edit Curves > Stitch 
Stitch the surface 
(see page 129) 

 
Match 
Lateral 

Surface and Curve Edits > Surface 
Edits > Edit Curves > Match Lateral 

Match lateral to 
curve projection (see 
page 137) 

 
Break 
Surface 

Surface and Curve Edits > Surface 
Edits > Break Surface 

Break surface (see 
page 140) 

 

Trimmin
g 

Surface and Curve Edits > Surface 
edits / Show Trimmed Surface 

Trimming — click to 
toggle ON/OFF (see 
page 142) 

 
Reverse Surface and Curve Edits > Common 

Edits > Reverse 
Reverse the surface 
(see page 143) 

 

Close/Op
en 

Surface and Curve Edits > Common 
Edits > Close 

Open (see page 
144)/close (see page 
145) surface — click 
to toggle ON/OFF 

 
Renumb
er 

Surface and Curve Edits > Common 
Edits > Renumber 

Renumber surface 
points (see page 
146) 

 
Spline Surface and Curve Edits > Common 

edits > Spline 
Spline surface (see 
page 146) 

 
Append Surface and Curve Edits > Common 

edits > Append 
Join two surfaces 
(see page 148) 

 
Select 
Points 

Surface and Curve Edits > Curve 
Edits > Select Points... 

Select points on a 
curve 
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Show 
Labels 

Surface and Curve Edits > Curve 
Edits > Show Labels 

Turn point labels 
ON/OFF 

 
Show 
Curvatur
e Combs 

Surface and Curve Edits > Curve 
Edits > Show Curvature Combs 

Turn curvature 
combs ON/OFF 

 
Edit 
Tangent 

Surface and Curve Edits > Curve 
Edits > Curve Point Adjustment > 
Edit Tangent Angles... 

Edit tangent angles 

 
Fine 
Tune 

Surface and Curve Edits > Curve 
Edits > Curve Point Adjustment > 
Fine Tune Points 

Fine tune points 

 
G2 edit Surface and Curve Edits > Curve 

Edits > Curve Point Adjustment > G2 
Edit Fairing 

G2 edit 

 
Repoint 
Curve 

Surface and Curve Edits > Curve 
Edits > Curve Point Reordering > 
Repoint Curve 

Repoint curve 

 
Edit as 
Bézier 

Surface and Curve Edits > Curve 
Edits > Curve Type > Edit as Bezier 
Curve 

Edit as a bezier curve 

 
Edit as 
G2 

Surface and Curve Edits > Curve 
Edits > Curve Type > Edit as G2 
Curve 

Edit as a G2 curve 

 
Edit as 
B-spline 

Surface and Curve Edits > Curve 
Edits > Curve Type > Edit as Bspline 
Curve 

Edit as a B-spline 
curve 

 

Smoothi
ng 

Surface and Curve Edits > Curve 
Edits > Apply Smoothing to Point 
Edits 

Apply smoothing to 
point edits — click to 
toggle ON/OFF 

 
 

Selecting curves on surfaces 
1 Select all the surfaces from which you want to select curves.  

2 Click the Select Curves  button on the Surface Edit toolbar. 

3 Use the Select Curves dialog (see page 115) to select the curves 
on the surfaces. 

 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 115  

Select Curves dialog 
Use this dialog to select curves on surfaces. 

 
Surface - the name of the surface whose curves are displayed in the 
Laterals and Longitudinals lists. You can select another surface and 
its curves are displayed in the two lists of curves. 

Whilst the dialog is displayed, you can change the surfaces selected 
on the screen. This also automatically updates the surfaces in the 
Surface selector. 

Laterals and Longitudinals - these lists are the curves on the surface 
named in the Surface selector. You can select curves from the two 
lists by clicking to select single curves, Shift-click to add a curve to 
the selection and Ctrl-click to toggle a curve from the selection. As 
you select the curves, they are highlighted on the screen. 

When you choose another surface from the selector, PowerSHAPE 
remembers the selected curves of the previously selected surfaces. 

Select Spine - selects the spine on the surface. This option is only 
available when a surface with a spine is selected. 

OK - closes the dialog. You can keep the dialog displayed while you 
edit the surface curves. 

 

Selecting all the curves in the current direction 
You can select all the curves in the current direction on a surface. 

1 Use the Direction arrow on the surface to select the curve 
direction. 
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In the following example, the lateral direction is selected. 

 

2 Click Select all curves in the current direction  (Surface Edit 
toolbar). 

All the laterals on the surface are now selected . 

 
 

Selecting all the curves on a surface 
You can select all the curves on a surface. 

1 Click Add all curves to selection  (Surface Edit toolbar). 

All the curves on the surface are now selected. 
 

Selecting a pattern of points 
You can select points on a surface using simple pattern sequences. 

1 Select the direction arrow on the surface to select the direction 
for the pattern of points. 

2 Click  (Surface Edit toolbar). 

3 Use the Pattern Selector dialog (see page 287) to select points. 
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Pattern Selector dialog 
Use this dialog to select surface points using simple pattern 
sequences. 

 
Select every n point - selects every nth point starting at the first 
point in the range, where n is the number you input. If you enter 3, 
then the first point in the range is selected followed by every 3rd 
point. 

in range a to b - the range of the points to select from. 

On every m curve - selects points from every mth curve starting at 
the first curve in the range, where m is the number you input. If 
you enter 3, then points are selected on the first curve in the range 
followed by every 3rd curve. 

in range x to y - the range of the curves from which the points 
are selected. 

Add to selection - if selected, you can add the selection to the 
existing selection of points. Deselect this option to make a fresh 
seection. 

OK - accepts the changes and closes the dialog. 

Cancel - discards the changes and closes the dialog. 
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Creating a curve on a surface 
Use the Add surface curves dialog to add laterals and longitudinals 
to the surface. 

 
The dialog contains four different methods for adding surface 
curves. Select a tab to display the relevant page. 

 Parameter value (see page 118) 

 Through nearest point (see page 120) 

 Distance from curve (see page 121) 

 Workplane intersection (see page 122) 
 

Add surface curves - Parameter Value 
Use this page of the Add surface curves dialog to create a curve at a 
specified parameter value.  

 
Insert — select the surface direction for the new curve from the 
following: 

 Lateral 

 Longitudinal 

Enter value between 1 and 2 — enter the parametric value of where 
you want to position the new curve. 

Apply — inserts the new curve. This also renumbers the other 
curves to reflect the change. 

Cancel — Saves the surface and closes the dialog. 
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To add a new lateral half way between laterals 1  and 2 : 

 

1 Click Add Curve  (Surface Edit toolbar) 

2 Select the Parameter Value tab. 

3 Select lateral from the Insert drop-down list. 

4 Enter a Value of 1.5. This is the parametric value half way 
between laterals 1 and 2. 

A new lateral  is added half way between laterals 1 and 2. This 
lateral is numbered 2 and lateral 2 has become lateral 3. The 
new lateral becomes the current lateral. 

 
If you now want to add another lateral equidistant between 2 
and 3, you need to enter 2.5. To put one between 1 and 2 you 
would enter 1.5. 

 Each time you add a lateral or longitudinal curve to a surface, 
the parametric value changes for a particular position on the 
surface. 
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Add surface curves - Through nearest point 
Use this page of the Add surface curves dialog to add a curve at a 
point on the surface nearest a specified point. You may choose an 
axis along which the specified point is projected on to the surface. 

 
Insert — select the surface direction for the new curve from the 
following: 

 Lateral 

 Longitudinal 

Project along — choose the axis of projection from the following: 

 Don't project 

 X 

 Y 

 Z 

Enter the X Y Z coordinates or click the Position  button to open 
the Position dialog where you can use position entry tools. 

Apply — inserts the new curve. This also renumbers the other 
curves to reflect the change. 

Cancel — saves the surface and removes the dialog from the 
screen. 
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Add surface curves - Distance from curve 
Use this page of the Add surface curves dialog to add a curve at a 
specified distance from the current curve. If there is no curve 
selected, then curve 1 is used by default. 

 
Insert — select the surface direction for the new curve from the 
following: 

 Lateral 

 Longitudinal 

Distance from current curve — enter the distance from the current 
curve where you want to position the new curve. 

Apply — inserts the new curve. This also renumbers the other 
curves to reflect the change. 

Cancel — saves the surface and closes the dialog. 

To add a new lateral 10 units from lateral 1 : 

 

1 Click Add Curve  (Surface Edit toolbar) 

2 Select the Distance from curve tab. 

3 Select lateral from the Insert drop-down list. 

4 Enter a Distance of 10. 
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A new lateral  is added to the surface. This lateral is numbered 
2 and lateral 2 has become lateral 3. The new lateral becomes 
the current lateral. 

 
 

Add surface curves - Workplane intersection 
Use this page of the Add surface curves dialog to add a curve where 
the principal plane of an active workplane intersects a surface. 

 
Insert — select the surface direction for the new curve from the 
following: 

 Lateral 

 Longitudinal 

Offset from curent workplane — enter a value from the workplane to 
postion the new curve. The plane graphic updates to show the new 
value. 

Apply — inserts the new curve. This also renumbers the other 
curves to reflect the change. 

Cancel — saves the surface and closes the dialog. 
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To add new lateral at the postion of the active workplane : 

 

1 Click Add Curve  (Surface Edit toolbar). 

2 Select the Workplane intersection tab. 

3 Select lateral from the Insert drop-down list. 

4 Enter an Offset of 0. 

A new lateral  is added where the XY plane of the active 
workplane intersects the surface. 

 
The new lateral is numbered 2 and lateral 2 has become lateral 
3. 
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Inserting a surface curve from wireframe 
Use the Insert surface curve from wireframe (see page 124) dialog to 
create laterals or longitudinals on a surface by inserting wireframe 
curves.  

 
The wireframe curve must have the same number of points and be 
in the same open/closed state as the laterals/longitudinals on the 
surface. The surface cannot contain a spine. 

 
 

Insert surface curve from wireframe dialog 
Use this dialog to insert curves from wireframe into the surface. 
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Selection 
Wireframe - when you select a valid wireframe curve, the The 
cross  icon changes to a tick  icon.. 

Reverse - reverses the direction wireframe curve. 

Direction - select whether to insert the wireframe as a lateral or 
longitudinal. 

Insert - indicates where to position the wireframe on the surface. 
You can insert the wireframe Before, After or As the curve given in 
Curve. The As option replaces the existing curve with the wireframe. 

 
Curve - enter the number of the curve used by Insert. 
Preview - displays the new curve in the surface from the selected 
wireframe object. You may change your wireframe object or 
settings on the dialog until you are satisfied with the previewed 
surface. 

Apply - saves the surface. The dialog remains open for you to insert 
more wireframe objects into the surface. 

OK - saves the surface and closes the dialog. 

Cancel - closes the dialog and dismisses any changes that have not 
been applied. 

To insert a new curve in a surface: 

1 Click Insert curve from wireframe  (Surface Edit toolbar). 

2 Select the wireframe. 

 
3 Select Lateral from the Direction drop-down list. 

4 Select After from the Insert drop-down list. 
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5 Click Preview to view the new curve in the surface. 

 
 

Why doesn't my surface look as I expected? 
If your surface looks different from the one you expected, it could 
be that it changed when you inserted a lateral. If this is the case, 
the following may help you understand why. 

In a Power surface, the interior of a patch is mathematically more 
complex (6th order) than the laterals and longitudinals. The laterals 
and longitudinals are composite cubic curves (3rd order). In general 
cases, it is impossible to represent a general parameter curve 
across the surface with these cubic curves. They can only be an 
approximation to the original surface.  

The tolerance is not relevant in this case. Any freedom is used to try 
to match positions at midpoints in the span. In other parts of the 
curve it may be well out of tolerance. 

 

Adding a spine 
A spine is a reference line on which laterals hang. You can edit the 
spine to change the shape of the surface. 

1 Click  (Surface Edit toolbar). 
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A spine is added to the surface in the current direction. This is 
not always a longitudinal direction. If the current direction is 
lateral, the laterals and longitudinals will be swapped. This also 
results in the surface being reversed.  

 
 

What is a spine? 
The spine is a reference curve that may be used to define the 
overall shape of a surface. It was widely used in DUCT, but 
PowerSHAPE users need not normally be concerned with it. 

The spine  is the reference line that determines where the data 
sections (laterals) are positioned in space. The spine is defined in 
terms of points. Every spine point must have an associated section 

 and every section must have the same number of points. The 
section is orientated to lie in a plane at right angles to the tangent 
to the spine. Corresponding points on successive sections are linked 
by longitudinal lines  to make up a network of curves. If you add 
a spine point, a new section is automatically created for it.  
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Similarly, when you delete a spine point, the associated section is 
deleted too. More usefully, if the data at one or more spine points is 
modified, the orientation of the section relative to the spine is 
preserved. 

 
While the spine is naturally the centre-line, it may be any 
convenient line inside, on or outside the surface. The shape of the 
surface is easier to control if the spine is straight or two-
dimensional, but this is not necessary. The sections and the spine 
may be open or closed, so that the surface may form an open 
region, a tube or a ring. The spine data should be chosen carefully 
to avoid unnecessary inflexions or concentrations of curvature. 

In PowerSHAPE a spine is generated automatically for the centre-
line of a fillet surface, but otherwise is rarely used. 

 

Deleting a curve on a surface 
To delete one of the longitudinals on the following surface: 

 
1 Select the longitudinal you want to delete. 
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2 Click  (Surface Edit toolbar) to remove the curve. 

 

 A surface must have at least 2 laterals and 2 longitudinals. 
You cannot delete any curves that would reduce the number 
of curves in that direction to be less than 2. 

 

Stitching surfaces 
Stitching is a method of closing small gaps between surfaces and 
curves. It moves the points on a selected surface curve onto 
another surface or curve. 

You stitch the surface curve onto surfaces and curves known as 
targets using the Stitch dialog. (see page 131) Targets for stitching 
are one of the following types: 

 surfaces 

 surface curves 

 wireframe curves (including composite curves) 

You cannot use targets that contain a mixture of surfaces and 
curves, as each uses different stitch options. 

When stitching onto a surface, you can edit the tangent angles 
along the curve of the surface you are stitching to smoothly match 
those of the surface you are stitching onto. 
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Suppose we have the following surfaces. We want to stitch the 
lower curve on the planar surface  onto the cylindrical (target) 
surface . 

 

1 Select the curve on the surface to be stitched . 

We selected the surface curve shown below: 

 

 If you only want certain points on the curve to be stitched, 
select those points. 

 If no points are selected, then all points on the curve are 
stitched. 

1 Click Model Fixing  on the General edits  flyout. 
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2 Click  (Model fixing toolbar) to display the Stitch dialog. 

 
3 Change the values and options to achieve the required stitched 

surface. 
 

Stitch dialog 
This dialog is used to define the stitching. 

 
Selection Mode - This allows you to choose the type of the target 
from one of the following: 

 wireframe curves (including composite curves) 

 surfaces 

 surface curves 

Toggle the option of the target type you want to choose, then select 
the target. The cross changes to a tick if you select the correct 
target. 

 A mixture of surfaces and curves is not allowed. 
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In this example, the Surfaces option is toggled and the cylindrical 
surface is selected. 

 
Each stitch point is moved onto the nearest position on the target 
surface or curve. The points on the curve are only stitched if they 
are within the distance specified in Max gap to stitch of the target 
surface. 

Maximum gap to stitch - This value is the size of the largest gap to 
stitch. If the stitch point has to move a distance greater than this 
value, then this point is not moved onto the target. 

 Target surface. 

 Maximum gap to stitch. 

 Stitch surface. 

 Stitch point does not move because its projected distance is 
greater than the Maximum gap to stitch. 

 
Snap to key points within - This value determines whether a stitch 
point snaps onto a key point of the target. 
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Once a stitch point moves onto a target, PowerSHAPE looks for any 
key points on the target within the radius defined by Snap to key 
points within of the stitch point. If a key point is found, the stitch 
point snaps onto it. 

 Target surface. 

 Stitch point. 

 Area around stitch point. 

 Stitch point snaps on this key point on the surface. 

 

 If the target is a curve, nothing happens. (In future releases 
of PowerSHAPE, the stitch point will snap to a key point within 
the given radius.) 

 Target curve. 

 Stitch point. 

 Area around stitch point. 

 Stitch point does not snap to this point on the curve. 

 
If the target is a surface curve, the stitch point may snap to a key 
point that does not necessarily lie on the target surface curve. 
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 Target surface curve. 

 Stitch point. 

 Area around stitch point. 

 Stitch point snaps to this key point even though the point does 
not lie on the target surface curve. 

 

Smoothness 
Smoothness - When the target is a surface or a curve on a surface, 
you can join the stitch surface smoothly onto the target surface 
using Match across seam and Match along seam. The seam is where 
the selected curve of stitch surface meets the target. 

Match along seam smoothes the selected curve onto the target. 
Match across seam smoothes the curves in the opposite direction to 
the selected curve onto the target. 

In this example, the curves across  and along  the stitch 
surface are shown below. 
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If Match across seam and Match along seam are both on, the 
following result is given when the surfaces are stitched together. 

 
If Match along seam is OFF and Match across seam is ON, the curves 
across the surface join the cylindical surface smoothly , but the 
curve along the surface does not join smoothly . 
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If Match along seam is ON and Match across seam is OFF, the curves 
across the surface do not join the cylindrical surface smoothly , 
but the curve along the surface does join smoothly . 

 
If both Match along seam and Match across seam are OFF, none of 
the curves on the planar surface join smoothly onto the cylindrical 
surface: 

 
Preview - Displays the stitched surface as defined by the settings on 
the dialog. Continue to change the settings until you are satisfied 
with the previewed stitched surface. 

OK - Saves the surface and removes the dialog from the screen. 

Cancel - This removes the dialog from the screen without making 
any changes. 
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Matching a lateral to a curve 
Use the Match Lateral (see page 137) dialog to match the shape of a 
lateral or longitudinal to a projected wireframe curve.  

 
The curve is projected along the axis normal to the principal plane. 

 
 

Match Lateral dialog 
Use this dialog to match a lateral to the shape of a projected curve. 
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Curve to match - when a valid wireframe curve is selected, The cross 
 icon changes to a tick  icon.. 

 
Extend Outside Surface - when the projection of the curve lies 
outside the surface: 

 if the Extend Outside Surface option is deselected, only part of the 
lateral matches the curve. 
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 if the Extend Outside Surface option is selected, the points on the 
lateral are extended to match the nearest points on the curve. 

 
Preview - displays the new shape of the lateral in the surface. The 
projected curve is along the axis normal to the principal plane. 

OK - saves the surface and closes the dialog. 

Cancel - closes the dialog and dismisses any changes. 

To match a lateral to a curve: 

1 Click Match lateral to curve projection  (Surface Edit toolbar) 

2 Select the curve. 
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3 Click Preview. 

 
If you view the surface from the top, you can see that the lateral 
matches the shape of the curve. 

 
You can change your wireframe object, settings on the dialog, or 
principal plane until you are satisfied with the previewed surface. 

 

Breaking a surface 
A surface can be broken into smaller pieces at selected curves. 

1 Select the curves where you would like to break the surface. 
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2 Consider the following surface. 

 
The curves are selected as shown below. 

 
You can select a mixture of lateral and longitudinal curves. 

3 Click  (Surface Edit toolbar). 

The surface breaks into smaller pieces at the selected curves. 
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 If you select a curve (other than curve number 1) on a 
surface that is closed in the other direction, then two 
surfaces are created. One surface is from curve 1 to the 
selected curve and the other is from the selected curve to 
the original closure. In the following example, we break the 
surface at curve 3  to give two surfaces . 

 
When a trimmed surface is broken at selected curves, the trim 
data is mapped onto the new surfaces thus preserving the 
original trim result. If you break a trimmed surface that is 
displayed as trimmed, any resulting surfaces that fall entirely 
within the trimmed away region are discarded. To keep these 
discarded surfaces, you can turn the local or global trim off 

before breaking. (Use the Trim ON/OFF buttons   on the 
Surface Edit toolbar to turn local trim OFF, and the Trimming 
option on the Surface page of the Options dialog to turn global 
trim OFF). 

 

Toggling the trimming drawing 
You can change the trim settings of a single surface to display or 
not display its trimmed area. 

Two trim flags are provided: 

 The global flag affects all surfaces. 

 The local flag affects only the surface for which it is set. 

If the global trim flag is OFF, then all surfaces regardless of 
whether their local flag is set ON/OFF, their trimmed boundaries 
are ignored and their whole shape is displayed. If the global flag 
is ON, then the whole shape of a surface is only displayed when 
its local flag is OFF. 

The global trim flag is set on the Surface page of the Options 
dialog. 
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We recommend that you normally work with the global trim flag 
ON, because untrimmed surface shapes can be confusing. You 
can always set the trimming ON or OFF locally. 

 If the whole shape of a surface is displayed, then any 
operation on the surface ignores its trim boundaries. 

To display or not display the trimmed area of a surface: 

1 Click  (Surface Edit toolbar) to turn trimming OFF. 

2 Click  (Surface Edit toolbar) to turn trimming ON. 
 

Reversing the surface 
To reverse a surface: 

 Click the direction arrow on the surface.  

1 Click the large arrow handle to choose between lateral  or 
longitudinal . 

 
2 Click the small arrow handle to reverse the surface. 
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 Select a lateral or longitudinal and click  (Surface Edit 
toolbar). 

 
 

Opening a surface 
1 Use the direction arrow on the surface to select the direction you 

wish to open the surface. 

In this case, the lateral direction is selected: 

 

2 Click  (Surface Edit toolbar). 
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The surface opens between the first and the last point on each 
lateral. 

 
 

Closing a surface 
1 Use the direction arrow on the surface to select the direction you 

wish to close the surface.  

In this case, the lateral direction is selected. 

2  

3 Click  (Surface Edit toolbar). 

This closes the surface between the first and last points on each 
lateral. 

4  
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Renumbering curves 
Curves may be renumbered. One reason for this may be to open a 
surface at a different location. 

You can only renumber the curves if the surface is closed in that 
direction. 

1 Select the curve you wish to number as 1. 

In this case, longitudinal 3 is selected. 

 

2 Click  (Surface Edit toolbar). 

The longitudinals have been renumbered. 

 
 

Splining surfaces 
This smoothes surfaces to give tangency continuity on selected 
points. The positions of the selected points are changed during this 
operation. 

 Tangent continuity is a smooth change in tangent direction as 
you move across the surface. 

1 Select specific points on the surface. 
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 Selected curves are ignored. 

The following surface willl be used as an example. 

 
The selected points are marked as circles. 

 
Points along the edges of surfaces cannot be splined. 

2 Click  (Surface Edit toolbar). 
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Selected points are splined in both the lateral and longitudinal 
directions, giving a smooth surface at these locations. 

 

Appending surfaces 
You can join two power surfaces together to produce a single 
continuous surface. It is necessary for both surfaces to be either 
open or closed in the direction perpendicular to the connection. 
Additionally, the curves along the joining edges of the surfaces must 
have the same number of spans. 

Appending two surfaces — example 
1 Select an edge curve on the power surface you want to append 

from . 

 

2 Click  (Surface Edit toolbar) to display the Append dialog (see 
page 149). 

 
3 Select the power surface you want to append to . 

 
4 Click OK to accept the append and close the dialog. 
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Append dialog 
Use this dialog to select and append secondary surfaces to a 
primary selected surface. 

 
When you select the secondary surface: 

  changes to . 

 The selected curve of the primary surface connects to the closest 
matching edge curve of the secondary surface, by adding a row 
of patches between the two surfaces. 

 

 Click a different secondary surface to undo the append and 
select a new surface. An appended surface using the new 
secondary surface is shown. 

 Click the arrow normal to the surface to reverse the direction 
of the newly appended surface. 

To deselect the secondary surface, select any surface curve on 
either of the surfaces. changes back to . 

Dialog options 
After you have selected the surfaces to be appended, use the 
following options on the Append dialog: 

 
 Next — Click to cycle through the solutions for appending the two 

surfaces. For each solution, PowerSHAPE selects a different 
matching edge curve on the second surface. 

 Apply — Click to append the surfaces and automatically select 
the next open edge curve, in preparation for further appending, 
without closing the dialog. If the automatically selected edge 
curve is not correct, select a new edge curve. 
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 Right click the model to perform the same action as 
selecting Apply. 

 OK — Click to save the appended surface and exit the dialog. The 
first surface becomes the appended surface and the second 
surface is deleted. Spines and trim boundaries (and their 
pcurves) on either surface are deleted. 

 Cancel — Click to exit the dialog and undo any editing, including 
the reversal of surfaces and the removal of any spines or trim 
boundaries. 

 

Editing a Power Surface using the Edit menu 
When you have a Power Surface selected, you can edit it using the 
options available from Edit > Surface and Curve edits. Most of these 
options are also available from the Surface/Curve Edit toolbar. 
For details on editing Power Surfaces using the Edit menu, see: 

 Surface Edits (see page 150) 

 Common Edits (see page 162) 

 Curve Edits (see page 163) 
 

Surface Edits submenu 
Select Edit > Surface and Curve Edits > Surface Edits to access the 
surface edit options. 

 
For details on the options that appear on the Surface/Curve Edit 
toolbar, see Editing a Power Surface using the toolbar (see page 
112). 

The following options do not appear on the Surface/Curve Edit 
toolbar:  
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 Rename (see page 151) 

 Swap Curves (see page 152) 

 Define Morph (see page 237) 

 Edit Morph (see page 266) 

 Fit to Wireframe Constraints (see page 153) 

 Active Direction (see page 160) 

 NURB Edit (see page 162) 
 

Renaming a surface 
PowerSHAPE by default gives each surface a unique number. You 
can change this to a name of your choice in the same way as you 
can for other objects. 

1 Right-click on a power surface. 
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2 Select Rename from the context menu. 

 
The Surface Name dialog is displayed. 

 
3 In the Name text box, type the new name for the surface. 

4 Click OK. 
 

Swapping curves 
You can swap which curves are laterals and longitudinals. 
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Select Edit > Surface and Curve Edits > Surface Edits > Swap Curves 
and the laterals  and longitudinals  swap round. 

 
 

Fitting a surface to wireframe and point objects 
You can edit a surface such that it passes through existing 
wireframe and point objects. (This is also known as deformation 
modelling.) 

This command treats the original surface as if it is a sheet of elastic 
rubber that can be deformed to pass through any wireframe and 
point objects you supply. A 'thin' sheet of elastic rubber can be 
easily stretched to form a complex shape, but may 'pucker' in areas 
where the surface changes direction rapidly. A 'thick' sheet of 
rubber may not be able to be deformed to a complex shape, but will 
resist 'puckering' and will be generally smooth (curvature 
continuous). The rubber may be very elastic (trying to minimise its 
surface area), or less elastic. As with the 'thickness' of the rubber, 
strong elasticity will tend to make the surface smoother but less 
able to deform to complex, rapidly changing shapes. 

This command allows you to convert a surface to a 'rubber' surface 
and to specify the elasticity and smoothness ('thickness') of the 
'rubber'. It then allows you to specify wireframe and point objects 
that act as constraints ('magnets' pulling the surface towards the 
wireframe and point objects). With low strength elasticity and low 
smoothness the surface should match the constraining 
curves/points fairly well. With higher elasticity and smoothness, the 
surface will be smoother but may not pass through the constraining 
curves/points at all. 

 This type of deformation is only possible on NURBS surfaces. 
PowerSHAPE will automatically convert power surfaces to 
NURBS surfaces as part of the operation, but will not 
automatically convert them back again at the end. In general, 
it is better to leave surfaces modelled in this way as NURBS 
surfaces as conversion back to a power surface may result in 
a surface with a large number of lateral and longitudinal 
curves. 
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Consider the following wireframe and surface. 

 
The detail lines of the surface become bold to help show the 
preview of the fitted surface clearly. 

 
You can control the number of detail lines displayed using the 
Surfaces page of the Options dialog.  

1 Select the surface. 
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2 Select Fit to wireframe constraints from the Surface and Curve 
Edits submenu from the Edit menu. 

 
3 Use the Fit Surface dialog (see page 156) to fit the surface to the 

wireframe. 
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Fit Surface dialog 
Use this dialog to fit a surface to wireframe and point objects. 

 
1 When you select the wireframe and point objects you want to fit 

the selected surface to, the  changes to next to the 
Wireframe/Point(s) selected option. 

 

 If a composite curve is selected and is created from an 
underlying surface, then the composite curve contains 
information on the tangent data of the surface. This 
tangent data is automatically used as an additional 
constraint. 

When illustrating a setting, we have not used the default values of 
the other settings to help you to see clearly the results of changing 
the setting being discussed. 
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Elasticity - This determines the elasticity of the material. If set to 
zero, the surface is not elastic and fits the constraints without 
stretching. When set at 10, the surface is stretched through its 
constraints and its area is minimised. 

In our example, the fitted surface with an elasticity of zero is shown 
below. 

 
If we increase the elasticity of the surface, its body shrinks to show 
it has become elastic and its area decreases. 

 
If we increase the elasticity further, the surface becomes tenser. 
Notice that the outer edges of the surface are shrinking. 

 
Smoothness - This slider is used to determine how smooth the 
edited surface is. 

If we have a setting of zero, PowerSHAPE makes no attempt to 
smooth the surface. 
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As we increase the smoothness, ripples on the fitted surface are 
made smoother. 

 
Increasing the smoothness further, makes the fitted surface 
smoother. 

 
Flexibility of initial surface - This slider determines how flexible the 
initial surface is. 

If the flexibility is set to 100%, the surface is totally flexible. In our 
example, we have the following fitted surface. 

 
If the flexibility is reduced, the surface is reluctant to change its 
original shape. 
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If flexibility is set to zero, the body of the surface is rigid and 
remains fixed in its original position. 

 
Boundary conditions on initial surface - You can constrain the fitted 
surface to data from the boundary of the initial surface using 
Preserve position and Preserve tangency. 

Preserve position - If on, the boundary positions of the initial surface 
are also boundary positions of the fitted surface. 

Preserve tangency - If on, tangencies at the boundary of the initial 
surface are also tangencies at the boundary of the fitted surface. 
When Preserve tangency is ON, Preserve position is also ON. 

If both Preserve position and Preserve tangency are turned off, the 
fitted surface makes no attempt to preserve the boundary of the 
initial surface. 

 
If Preserve position is on and Preserve tangency off, the fitted 
surface preserves the boundary of the initial surface and makes no 
attempt to preserve the tangents at its boundary. 
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If both Preserve position and Preserve tangency are on, the fitted 
surface preserves both the tangency and boundary of the initial 
surface. 

 
Accuracy - This displays the maximum distance of the fitted surface 
from the wireframe and point objects. 

You can improve the accuracy by saving the surface when it is close 
to the correct shape (by clicking the Apply button) and refitting. 

Reset to initial surface - This resets the surface to its original shape. 
This is the shape of the surface when you first display the dialog. 

Preview - Once wireframe and point objects are selected, clicking 
Preview displays the fitted surface as defined by the settings on the 
dialog. As you change any of the settings, the previewed surface 
automatically updates. To change the selection of wireframe and 
point objects, select the objects and click Preview to update the 
preview surface. 

Apply - Saves the edited surface. You can fit the new surface to 
wireframe and point objects, again. You can improve the accuracy 
by fitting the surface to the same wireframe and point objects 
again. 

OK - Saves the edited surface and removes the dialog from the 
screen. 

Cancel - Does not edit the surface and removes the dialog from the 
screen. 

 

Selecting the direction 
You can choose the lateral or longitudinal direction using the 
direction arrow on the surface. 
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In the diagram below, the direction arrow shows that the direction 
is longitudinal. 

 
Click the arrow to change the direction. The selected direction 
becomes lateral. 

 
Some edits, such as opening a surface, require only the direction of 
the curves. Other edits, such as renumbering the curves, require a 
current curve to be defined too. 
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NURB editing mode 
From the Edit menu, select NURB Edit to enter NURB editing mode. 

 
 

 

Common Edits 
Select Edit > Surface and Curve Edits > Common Edits to access the 
common edit options for surfaces and curves. 

 
The common edits options are available from the Surface/Curve Edit 
(see page 112) toolbar. 
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Curve Edits 
Select Edit > Surface and Curve Edits > Curve Edits to access the 
curve edit options. The Curve Edits options are only available if you 
have a curve selected. 

 
For details on the options that appear on the Surface/Curve Edit 
toolbar, see Editing a Power Surface using the toolbar (see page 
112). 

 

Graphically editing power surfaces 
The following sections contain information on graphically editing 
power surfaces: 

Graphically inserting a curve on a surface (see page 163). 

Graphically moving a point along a surface curve (see page 164). 

Graphically editing curves and points using handles (see page 
166). 

Graphically selecting multiple curves on a surface (see page 
174). 

Graphically selecting multiple curves on multiple surfaces (see 
page 175). 

 

Graphically inserting a curve on a surface 
1 Select the surface. 
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2 Select any point on the surface. The handles of the point will be 
displayed . 

 
3 Hold down Ctrl, click on the instrumented point and drag the 

cursor to the position where you want to add the new curve. 

4 Release Ctrl and the mouse button to input the curve. This also 
renumbers the other curves to reflect the change . 

 

 If you release the mouse over a lateral, only a longitudinal is 
inserted. If you release over a longitudinal, only a lateral is 
inserted. If you release the mouse at a position not on the 
surface, then no curve is inserted. 

 

Graphically moving a point along a surface curve 
You can adjust the position of a point along its adjacent curves. 

1 Select the surface. 
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2 Select any point on the surface. The handles of the point will be 
displayed. 

 
3 Hold down the Shift key and drag the instrumented point along 

its adjacent surface curves. 

 
4 Release the Shift key and the mouse button to move the point. 
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The shape of the surface does not change. 

 
You can drag the point along a curve up to the next point on the 
surface. If you drag the point to any other position, the point is 
moved but the shape of the surface changes. 

 

Graphically editing curves and points using handles 
You can modify a surface by using graphical handles to edit: 

 Surface curves (see page 166). 

 Surface curve points (see page 173). 
 

Graphically editing surface curves using handles 
With a single curve or multiple curves selected, you can select the 
different curve handles from the following menus: 
 Edit > Surface and Curve Edits > Surface Edits > Selected Curves 

Graphical Handles. 

 Surface curve context menu. 
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Graphically editing multiple surface curves - Example 
1 Press and hold the Shift key, and click multiple curves on the 

surface to select them. 

 
2 Right click a curve and select a graphic handle from the Selected 

Curves Graphical Handles flyout of the Power Surface context 
menu. 

3 Drag the handle to move the curves. 

 

 If you are using Workplane graphic handles or Offset graphic 
handles, a movement confirmation field is displayed. Enter 
the exact value of the movement into the field, and press 
the Enter key to confirm. 
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The following handles are available: 
 Workplane graphic handles 
 Offset graphic handles 

 

Tangent and magnitude graphic handles 
1 Select a point on the surface curve. 

2 To display the context menu  the point. 

3 Select Tangent and magnitude graphic handles from the context 
menu. 

 

4 To edit the surface curve  the various handles: 

 Use the arced handle  to modify the tangent angle of the 
curve, without changing the magnitude. 

 

 A circle is drawn in a fixed plane relative to its starting 
position 
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 Use the spherical handles  to freely modify the magnitude 
of the curve in any direction. 

 
 Use the arrow tip handles  to modify the magnitude of the 

curve along the fixed tangent. 

 
 Use the centre handle  to move the curve point freely. 

 

 Moving the cursor over a handle highlights the handle, 
indicating that you can move it. 

 

Tangent and normal graphic handles 
1 Select a point on the surface curve. 

2 To display the context menu  the point. 
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3 Select Tangent and normal graphic handles from the context 
menu. 

 

4 To edit the surface curve  the various handles: 

 Use the arrow handles tangent to the surface curve  to 
move the point, in a fixed direction, along the tangent. 

 
 Use the arrow handles normal to the surface curve  to move 

the point, in a fixed direction, along the normal. 
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 Use the planar handles  to move the point across a 2D 
plane. 

 
 Use the centre handle  to move the point freely. 

 

 Moving the cursor over a handle highlights the handle, 
indicating that you can move it. 

 

Workplane graphic handles 
1 Select a point on the surface curve. 

2 To display the context menu  the point. 

3 Select Tangent and normal graphic handles from the context 
menu. 
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4 To edit the surface curve  the various handles: 

 Use the workplane arrow handles  to move the point along 
a fixed axis. 

 
 Use the workplane centre handle  to move the point freely. 

 

 Moving the cursor over a handle highlights the handle, 
indicating that you can move it. 

 

Offset graphic handle 
Use the Offset graphic handle option to graphically modify surface 
curve points. 

1 Select a point on the surface curve. 
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2 Right-click the point and select Offset graphic handle from the 
Power Surface context menu. 

 
3 Click and drag the handle to edit the surface curve: 

Before 

 

 

After 

 

The point is offset a set distance away from its original position. 

 Moving the cursor over a handle highlights the handle, 
indicating that you can move it. 

 

Graphically editing surface curve points using handles 
You can use graphic handles to edit a single curve point, or multiple 
curve points at the same time. 

Single points 
With a single surface curve point selected, you can select the 
different curve point handles from the following menus: 
 Edit > Surface and Curve Edits > Common Edits > Selected Point 

Graphical Handles. 

 Surface curve point context menu. 

The following handles are available: 

 Tangent and magnitude graphic handles (see page 168). 

 Tangent and normal graphic handles (see page 169). 

 Workplane graphic handles (see page 171). 

 Offset graphic handle (see page 172). 
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Multiple points 
With multiple surface curve points selected, you can select the 
different curve point handles from the following menus: 
 Edit > Surface and Curve Edits > Common Edits > Multiple Selected 

Point Graphical Handles. 

 Surface curve point context menu. 

The following handles are available: 

 Simple graphical marks. 

 Workplane graphic handles (see page 171). 

 Offset graphic handle (see page 172). 
 

Graphically selecting multiple curves on a surface 
Clicking a surface curve selects it. Any other selected object 
becomes deselected. 

Click a lateral to select it. It changes colour to show it is selected. 

 
Shift-click adds a surface curve to the current selection of surface 
curves. If you Shift-click any other object, the curves are no longer 
selected. The object and the surface become the current selection. 

If we now Shift-select longitudinal 2, it is added to the current 
selection and changes colour to show it is selected. 
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Ctrl-click adds a surface curve to the current selection of surface 
curves or removes the curve from the current selection if it is 
already selected. 

If we Ctrl-click lateral 1, it is added to the selection. 

 
If we Ctrl-click lateral 3, it is removed from the selection. 

 
Ctrl-Shift-click removes surface curves from the current selection. 

If we Ctrl-Shift-click longitudinal 2, it is removed from the selection. 

 
The Shift key with box selection adds points to the current selection. 

 

Graphically selecting multiple curves on multiple surfaces 
Select all the surfaces from which you want to select curves. 
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Use Shift-click to add a surface curve to the selection containing 
sub-components. 

Use Ctrl-Shift-click to remove a surface curve from the selection 
containing sub-components. 

Use Shift with box selection to add surface curves to the selection 
containing sub-components. 

Use Ctrl-Shift with box selection to remove surface curves from the 
selection containing sub-components. 

You can edit the selected curves using the Edit sub-component tool 
on the Edit toolbar. 

 

Graphically reversing a surface 
Turn a surface inside out by changing the direction of the surface 
normal. This reverses the points of the laterals in the surface. 

1 Double-click the surface to display the surface normal arrow . 
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2 Click the arrow to change the direction of the surface normal. 
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Editing curves on a power surface 
Right-click on a Power Surface to open the context menu. The top of 
the context menu displays the type of the surface, its name, and 
the level on which it lies. 

 
You must have curves selected for the following option to be 
available: 

Convert to wireframe — A composite curve is created from the 
selected curve.  

You must have curves or points selected for the following options to 
be available: 
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Edit Tangent Angles — This displays the Tangent Editor dialog, 
which allows you to edit the tangent directions and magnitudes 
of curves. 

Free Magnitudes — This is the same as clicking  on the 
Tangent Editor dialog. Tangent magnitudes are freed through 
selected points along the selected surface curve. If no points are 
selected, the whole curve is freed. 

Free Tangent and Magnitudes — This the same as clicking  
on the Tangent Editor dialog. The tangent directions and 
magnitudes are freed through selected points along the selected 
curve. If no points are selected, the whole curve is freed. 

 

Converting between surface types 
A power surface has a variety of editing functionality that is not 
available for BCPs or NURBS. In order to access this functionality, 
the BCP or NURB needs to be converted. 

You can also convert primitive surfaces to power surfaces. 

To convert your surface: 
1 Select the surface. 

2 Right-click the selected surface. From the context menu, select 
Convert. 

 This is the same as selecting Edit > Convert > Surface. 
 

Fixing surfaces 
The following section contains information on fixing surfaces using 
options that are available from the Model Fixing toolbar. 

Orient surface normals (see page 179). 

Approximating a surface to tolerance (see page 180). 

Simplifying outside trim (see page 181). 
 

Orient surface normals 
You can orient the normals of multiple surfaces such that the 
outside of two adjacent surfaces match. 

A quick way of checking if surface normals are oriented is by 
shading the model. By default, the outside of a surface is shaded 
blue and the inside red (using the default colour scheme). 



 

180 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

 Two surfaces are adjacent if their edges match within general 
tolerance. Otherwise, they are treated as disconnected. 

1 Select a group of surfaces. 

 

 When you select multiple surfaces, by default,their surface 
normals are not displayed. You can display the surface 
normals by turning on Display normals for multiple surfaces 
on the Surfaces page of the Options dialog. 

2 Click Model Fixing  on the General edits  flyout. 

3 Click  (Model Fixing toolbar). 

The surface normals all point such that the outside of two 
adjacent surfaces match. 

 
As a general rule, you should always keep the surface normals 
pointing out from the material. 

 

Approximating a surface to tolerance 
This removes laterals and longitudinals that do not support the 
surface structure within tolerance. 

1 Click Model Fixing  on the General edits  flyout. 
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2 Select a surface. 

 

3 Click  (Model fixing toolbar). 

In this case, a lateral  and longitudinal  are removed. 

 
 

Simplifying outside trim 
This removes laterals and longitudinal made entirely invisible by 
being outside the trim boundaries. 

1 Click Model Fixing  on the General edits  flyout. 

2 Click  (Model fixing toolbar). 

Let us use the following surface as an example. 

 Trim boundary. 



 

182 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

 Curves outside the trim boundary. 

 
In this case, a lateral and longitudinal are removed. 

 
 

Inspecting surfaces 
You can inspect a solid, surface or component and display the 
following inspection data: 

 coordinates 

 surface normal 

 draft angle (see page 184) 

 wall thickness (see page 184) 

 curvature (see page 184). 

Surface inspection data can also be captured and sent to the 
clipboard to be pasted into any text editor. For details see Capturing 
surface inspection data (see page 185). 
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Displaying surface inspection data 

Select Model Analysis  on the General edits  flyout. 

1 Select a solid, surface or component. For example: 

 

 You can select more than one item. 

2 Click  (Model analysis toolbar). 

3 Left-click on a position on the selected surface. You can click 
anywhere on the surface, not just on a curve. By default, the 
surface normal arrow, draft angle and curvature of the position is 
displayed.  

 
4 If you want to change the data displayed, select Tools > Options > 

Tools > Analysis > Surface Analysis to display the Surface Analysis 
options page. 
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5 Drag the cursor across the surface to display data at different 
positions. 

If multiple items are selected, you can drag the cursor from one 
item to another. If the first item is no longer under the cursor, 
data from the second item is displayed. 

6 Click  to turn inspection mode OFF. 
 

Inspecting surfaces - Draft angle 
The draft angle is measured from the principle plane to the normal 
of the point on the surface under the cursor. 

 

Inspecting surfaces - Wall thickness 
Wall thickness is determined by measuring the distance between 
the cursor's position on a face, and the closest point to this on the 
back face. You must select all the faces to be considered before 

clicking the Surface inspection button . The positions are 
displayed graphically by a circle on the back surface joined by a line 
to the cursor position. 

 
 

Inspecting surfaces - Curvature 
You can display the curvature as either: 

 maximum and minimum values 

or 

 values along the T or U parametric directions 

by selecting the Curvature type on the Surface Analysis page of the 
Options dialog. You can also display the curvature as either radius 
or curvature values by selecting the relevant Display As option also 
on the Surface Analysis page. 
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Capturing surface inspection data 
1 Select the required solid, surface or component. More than one 

object can be selected. If nothing is selected at this stage, the 
tool will not return any values. 

2 Click Surface Inspection  (Model analysis toolbar). 

3 Click in the graphics window and drag the mouse over the 
surface, solid or component to be analysed. Values will be 
displayed below the cursor. 

 
4 Click a position on the selected surface, solid or component. 

5 Hold down the left mouse button and press Enter. Repeat to 
capture data for multiple positions. 

6 Click  (Model analysis toolbar) to turn inspection mode OFF. 

7 Select the Paste option in any text editor to paste the captured 
data. 

 Data cannot be pasted until Inspection mode is turned OFF. 
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Filleting and blending 
The following sections contain information on filleting and blending 
surfaces. 

What is a fillet surface? (see page 188) 

Creating a fillet surface (see page 190). 

How do I edit a fillet surface? (see page 211) 

How do I edit a corner fillet? (see page 211) 

Creating a blend surface (see page 214). 
 

What is filleting? 
Filleting is used mainly to create a smooth join between two or 
more surfaces. 

Filleting allows you to take a selection of surfaces and create fillets 
between them. 
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In your model, you may see two distinct sets of surfaces where you 
wish to create a fillet. PowerSHAPE allows you to create a fillet 
between these two lists. 

 
This method of filleting works faster than the more general case. 

You can also create a fillet between a single wireframe object  
and a set of surfaces . This is illustrated below. 

 
The fillet, created between the surface and the curve, is shown 
below: 
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What is a fillet surface? 
If you think of the indented shape which would result from rolling a 
ball around the intersection between two surfaces (that is, a circular 
arc of the same radius as the ball), you get a good idea of what a 
fillet looks like. PowerSHAPE can produce a constant-radius fillet 
surface between any pair of surfaces which intersect. 

 
A typical fillet surface between two intersecting surfaces. 

 A constant-radius fillet can therefore be machined in a single 
pass using a ball-nosed cutter of the same radius as itself. 

 A fillet surface will follow both surfaces exactly (within 
tolerance), even if each is doubly curved (see figure below). 

 
You can even produce a fillet when two surfaces do not nominally 
intersect - the only condition is that, if offset by the fillet radius, 
they would intersect (see figure below). 
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In the case of two surfaces which are divergent, the fillet will be 
produced between the portions of the two surfaces which do 
intersect when offset by the fillet radius (see figure below). 

 
Other fillets of this type are shown below. 

 
If the intersection line between two surfaces contains discontinuities 
(for example, as a result of sharp corners, or because some of the 
inside radii are smaller than the fillet's radius), PowerSHAPE will 
construct a fillet from each unbroken portion of line. In other words, 
it will produce a series of fillets. For example, the fillet illustrated 
below incorporates six separate fillet surfaces, one for each corner 
and one for each side to create a single fillet surface. 
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Variable radius fillets 
A variable radius fillet may be created with different radius values at 
specified points. 

 
As you can see the variable fillet is used to good effect here. A 
constant fillet would only have allowed the smallest radius to be 
used along the whole length of the fillet, but here we specified a 
larger radius on one side to improve strength and avoid run-out of 
the fillet on the narrower side. 

 

Creating a fillet surface 
You can create fillet surfaces between a set of surfaces as follows: 

 Along creases of surfaces. For further details see Creating a fillet 
along creases of surfaces (see page 204). 

 Between two lists of surfaces. For further details see Creating a 
fillet between two list of surfaces (see page 205). 

 Between surfaces and a 3D curve. For further details see 
Creating a fillet between surfaces and a 3D curve (see page 
207). 

 A variable fillet between curves surfaces. For further details see 
Creating a variable fillet between surfaces and a curve. (see page 
209) 
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The following surfaces are used to illustrate filleting. 

 

1 Click  (Surface toolbar). 

2 Select at least two surfaces in your model. 

The surface normal arrows of the selected surfaces are 
displayed. Also,  next to the Primary Surfaces changes to in 
the Selection part of the dialog. 

In the example shown below, all the surfaces are selected. 

 
3 Use the Fillet surface dialog (see page 191) to provide initial data 

to create a fillet surface. 
 

Fillet Surface dialog 
Use this dialog to provide initial data to create a fillet surface. 
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Fillet radius — This is the nominal radius of the fillet. Generally, set 
the radius to the smallest radius on the fillet. If the fillet runs 
around a corner, try a radius approximately equal to the fillet radius 
in the corner. 

Concave/Convex — Determines how the fillet is created between the 
two surfaces. 

A fillet produced between two surfaces depends on: 

 whether Concave or Convex is selected 

 the direction of the surface normals on both surfaces 

The example below shows a fillet solution between two surfaces 
using the Concave option. The arrows pointing out from the 
surfaces indicate the surface normals. 

 
The example below shows a fillet solution between two surfaces 
using the Convex option.The arrows pointing out from the 
surfaces indicate the surface normals.  
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To obtain fillets in the bottom left and top right, one of the 
surfaces must be reversed, as shown in the example below. If 
you wish to change the direction of the surface normal of a 
surface, click the surface normal arrow. 

 

 You should always keep the surface normal pointing out 
from the material. This ensures surfaces are correctly 
combined into solids. 

Therefore, for any two surfaces, four possible fillet solutions can 
be obtained. 

Trim — Select this option to trim surfaces to the fillet surface when 
the fillet is generated. If deselected, you can still generate the 
pcurves and not the trim boundaries by turning on the Keep pcurves 
generated by filleting option on the Surfaces page of the Options 
dialog (this dialog is displayed by selecting Options from the Tools 
menu). 

For further details on pcurves and trim boundaries, see Trimming 
surfaces (see page 272). 

Fillet along creases — If selected, you can fillet along creases in the 
selected surfaces. For further details, see Creating a fillet along 
creases of surfaces (see page 204) . 
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Fillet all routes — If selected, fillets are created along all the fillet 
routes between the selected surfaces. 

 
Corner Type — You can select the corners on the fillet as one of the 
following options: 

Roll — Creates a round corner. 

 
Mitre — Creates a sharp corner. 

 
Round — This uses the Fullness value to make rounder corner 
fillets with branches.  
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When you click OK or Cancel on the Select Fillet Route dialog 
(see page 197), PowerSHAPE searches for any corner fillets as 
shown below. 

 
It makes them rounder using the Fullness value. 

 
Selection — You can add objects to either the primary or secondary 
selections. The primary selection can only contain surfaces, whereas 
the secondary selection can contain either a set of surfaces or a 
single wireframe object. 

 
Objects in 
Primary 
selection 

Objects in 
Secondar
y 
selection 

What PowerSHAPE does with the 
selection 

At least 
two 
surfaces 

Empty  Fillet route is calculated between all 
surfaces. 
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Empty At least 
two 
surfaces 

Fillet route is calculated between all 
surfaces. 

At least 
one surface 

Empty Fillet route is calculated between all 
surfaces and along the creases of the 
selected surfaces, providing Fillet along 
creases is ON. For further details, see 
Creating a fillet along creases of 
surfaces (see page 204). 

Empty At least 
one 
surface 

Fillet route is calculated between all 
surfaces and along the creases of the 
selected surfaces, providing Fillet along 
creases is ON. For further details, see 
Creating a fillet along creases of 
surfaces (see page 204). 

Surfaces Surfaces  Fillet route is calculated between the 
two lists of surfaces. For further details, 
see Creating a fillet between two list of 
surfaces (see page 205). 

Surfaces A single 
wireframe 
object  

Fillet is created between the surfaces 
and the wireframe object. For further 
details, see Creating a fillet between 
surfaces and a 3D curve (see page 
207). 

To add objects to a particular selection, select the appropriate 
selection toggle (Primary or Secondary) and select the objects. You 
can add more objects to a selection by pressing the Control key and 
selecting the objects. Surfaces in the primary selection are coloured 
differently to those in the secondary. 

 You can select objects before displaying this dialog. If you 
select a set of surfaces and then display the dialog, the 
Selection toggle changes to Secondary and waits for you to 
add the secondary list of objects if any. If you select a 
wireframe before displaying the dialog, you are expected to 
enter the primary selection of surfaces. 

Preview — Displays the calculated fillet routes using the current 
settings in the dialog. You can continue to change the settings in 
the dialog until you are satisfied with the previewed fillet routes. 
Note: When creating a fillet between a set of surfaces and a 
wireframe, the fillet surface is displayed. 

Apply — Creates the selected fillets. 
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OK — If the Fillet all routes option is on, this creates fillets along all 
the fillet routes. If the option is off, this calculates the fillet routes, 
removes the Fillet dialog and displays the Select Fillet Route dialog. 
For further details on how to use this dialog and continue creating 
the fillet, see Select Fillet Route dialog (see page 197). 

 When creating a fillet between a set of surfaces and a 
wireframe, the fillet surface is created and the Select Fillet 
Route dialog is not displayed. 

Cancel — Removes the dialog from the screen and does not 
continue creating the fillet. 

 

Select Fillet Route dialog 
Use this dialog to: 

 select the fillet routes. 

 control the shape of the fillet. 

 
When this dialog is displayed, candidate lines display to help you 
determine the fillet route. 

 

 The candidate lines are the spines of the possible fillets. 
These lines are selected to create fillets to your requirements. 
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Selecting the fillet routes 
To start creating a fillet, select a candidate line as the start line . 

 
Once a start line is selected, PowerSHAPE tracks the next line which 
joins the end of the start line. Once this line is found, it continues to 
track the joining lines until the end of the current route or a branch 
is reached. 

If a single route is possible, it is automatically detected. 

If a branch is reached, the Select Fillet Route dialog highlights this: 

 
You now have two choices: 

 To stop selecting candidate lines, click Complete on the dialog. 

 To continue selecting candidate lines, click one of the branches 
highlighted. 

In the example below, two branch candidate lines  are displayed. 
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We have selected the branch candidate line on the left. This leads 
the route to reach another branch line as shown below. 

 
To complete the first route, the vertical branch is selected. 

 
You can now control the shape of the fillet (see page 199).  

 

Controlling the shape of the fillet 
Once a route is complete, the Select Fillet Route dialog highlights the 
fillet arc editing features. 

 
On the ends of the fillet route, arcs appear which represent the 
radius values at those points. These values are the nominal radius 
as set in the Fillet dialog. 

 For a closed route, no arcs are displayed. 

Current Arc — This has two drop-down lists and a text box. 

The first drop-down list displays the selected fillet arc. You can use 
this drop-down list to select existing fillet arcs. To find the number 
of an existing arc, simply select the arc in graphics window. Its 
number is displayed in this drop-down list. 
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Use the second drop-down list and text box to enter new fillet arcs 
as follows: 

1 Select one of the following options from the second drop-down 
list to determine where to input the new fillet arc: 

ABS - A new arc is inserted along the fillet at a distance from the 
first fillet arc. 

REL - A fillet arc is inserted along the fillet at a distance from the 
selected fillet arc in the first drop-down list. 

PAR - A new arc is input at a parametric distance between two 
existing arcs. For example, a parametric distance of 3.5 inserts 
an arc half way between arcs 3 and 4. 

2 Input a distance in the text box and press Enter to input a new 
fillet arc. 

The fillet arcs are also relabelled. 

You can also click a position on the fillet route to enter a new arc. 

If you hover the intelligent cursor over the fillet route, a distance is 
displayed. The option selected in the second drop-down list will 
determine what the value means. For example if ABS is selected, 
the value is the absolute distance along the fillet route. 

The word KEY is displayed where the fillet crosses a curve on one of 
the selected surfaces. 

Delete — This deletes the selected arc. 

 End arcs cannot be deleted. 

Arc Radius — This displays the radius of the selected arc. You can 
change its value by 

 entering a new value. 

 dragging the arc on the screen to the required value. 

Law — This displays the variation of the radius at the current arc 
position. Use the Law option to indicate how you want to vary the 
fillet radius at the selected arc. 

Three variations exist: 

 Free 

 Horizontal 

 Sharp. 
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To explain what each of these variations mean, suppose we have 
the arcs as in the following diagram. 

 
We will look at how the radius changes from arc 3 to arc 4 with 
respect to the three variations: 

Free - the radius varies freely from arc 3 and then takes on the 
conditions dictated by arc 4 

 
Horizontal - the radius remains constant for a short distance 
away from arc 3 and then takes on the conditions dictated by arc 
4 

 
Sharp - the radius changes size quickly as soon as it leaves arc 3 
and then takes on the conditions dictated by arc 4 
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The Law option has nine selections: 

 - Free Free 

 - Free Horizontal 

 - Free Sharp 

 - Horizontal Horizontal 

 - Horizontal Free 

 - Horizontal Sharp 

 - Sharp Sharp 

 - Sharp Free 

 - Sharp Horizontal 

The first word dictates how the radius varies as it enters an arc 
and the second how it leaves an arc. 

Corner Radius Type the required value in the Corner Radius text box. 

 The corner radius must not be greater than the nominal 
radius. 

You can use the corner radius to fit a fillet into a corner. In the 
following figure, the fillet does not fit into the corner; its corner 
radius is too large. 

 
By entering a corner radius equal to the corner, the fillet fits the 
corner. 
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Here are some more tips on what Corner Radius values to use and 
when: 

 If you create several fillets, all with the same radius, which meet 
in one or more concave corners, set the corner radius equal to 
the fillet radius. Spherical corner pieces will then be created in 
the corners. 

 If you create several fillets, with two different radii, which meet 
in one or more concave corners, create the fillet with the larger 
radius first and set its corner radius equal to the smaller radius. 
Then when you create further fillets with the smaller radius, they 
will match the first fillet exactly in the corners. 

 If you create a single fillet with longitudinal edges that follow the 
main surfaces closely and go into corners which are either sharp 
or have a smaller radius than the fillet, set the corner radius to 
zero. 

 Once you create a corner, you can edit it to make it rounder. For 
further details, see How do I edit a corner fillet? (see page 211) 

Chamfer — When selected, this creates straight fillets. 

 
Extend — If Extend is deselected, the fillet stops when it reaches a 
boundary or an open edge on one of the surfaces. When selected, 
the fillet extends to the edge of the longer surface. 

 
 — This locks the nominal radius. By clicking this Lock button to 

open , you can change the radius in the Reset text box. Once the 
lock is open, clicking Apply will cancel any fillets created and takes 
you back to the stage where you begin to select candidate lines. 

Reset — This displays the nominal radius. It can only be changed by 
opening the Lock button. 
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Preview — Click this button to see the fillet path.  

Apply — Once you edit the fillet to your requirements, click Apply on 
the dialog to create the fillet. Continue creating more fillet surface, 
if necessary, by selecting a start candidate line. 

OK — Creates the required fillets and closes the dialog. 

Cancel - Removes all the fillets created whilst the Select Fillet Route 
dialog was displayed and closes the dialog. 

 

Creating a fillet along creases of surfaces 
You can create fillets along creases of a surface without having to 
break the surface first. 

We will use the following surface to show how to create a fillet along 
creases of a surface. 

 

1 Click  (Surface toolbar). 

 
2 Fill in this dialog as described in Fillet surface dialog (see page 

191). 
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3 Select the surfaces. 

4 Select the Fillet along creases option. 

5 Make sure the surface normals are pointing in the correct 
directions. For further details on surface normals, see Fillet 
surface dialog (see page 191). 

6 The single surface is treated as two surfaces at the crease. 

7 Click OK to calculate the fillet routes, remove the Fillet dialog and 
display the Select Fillet Route dialog. (see page 197) 

The fillet routes lie along the creases of the surface . 

The example shown below shows four fillet routes. 

 
8 Use the Select Fillet Route dialog (see page 197) to continue 

creating the fillets. 

 

 When you create the fillets along the creases of a surface, the 
surface breaks at the corresponding fillet route, even if you 
don't select the route for the fillet to lie. 

 

Creating a fillet between two lists of surfaces 
Because you provide more information about the fillet required, 
PowerSHAPE creates the fillet much more quickly. As this method is 
very similar to creating a fillet discussed above, we only show you 
how to select the two lists. 
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The example surfaces shown below illustrate creating a fillet 
between two lists of surfaces. All the cylindrical surfaces will be in 
one list and the planar surface in the another. 

 

1 Click  (Surface toolbar). 

 
2 Fill in this dialog as described in Fillet surface dialog (see page 

191). 

Select the surfaces for one of the lists. 

3 In our example, all the cylindrical surfaces are selected. 

4 In the Selection part of the dialog, The cross  icon changes to a 
tick  icon.next to Primary Surfaces. 

5 Click the Secondary toggle in the Selection part of the dialog. 

6 Select the second set of surfaces. 

In our case, we select the plane. Therefore, one list contains the 
plane and the other list all the cylindrical surfaces. 

When a surface is selected, The cross  icon changes to a tick  
icon. next to Secondary Surface. 
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If you have selected the wrong surface, simply deselect using 
Ctrl-click. 

If you have no surfaces selected, then the selection is taken as a 
single list. 

7 Click OK to calculate the fillet routes, remove the Fillet dialog and 
display the Select Fillet Route dialog. 

Notice how the fillet routes separate the two lists of surfaces. 

 
8 Use the Select Fillet Route dialog (see page 197) to continue 

creating the fillets. 

 
 

Creating a fillet between surfaces and a 3D curve 
You can create a fillet between a set of surfaces and a 3D curve. 
The 3D curve can be any single wireframe object, for example, a 
line or a composite curve. 
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1 Click  (surface creation menu). 

 
2 Fill in this dialog as described in Fillet surface dialog (see page 

191). 

3 Select the surfaces. 

The  next to the Primary Surfaces changes to  in the Selection 
part of the dialog. 

4 Click the Secondary toggle in the Selection part of the dialog. 

5 Select the curve. 

When the curve is selected, The cross  icon changes to a tick  
icon. next to Secondary Wireframe. 

6 You will see an arrow on the curve. This determines which side of 
the curve the fillet is created. We advise you to see the fillet by 
clicking the Preview button. If the fillet is on the wrong side of 
the curve, click the arrow on the curve and preview the fillet 
again. 

7 Click OK to create the required fillet. 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 209  

Notice how the fillet smoothly meets the surface. 

 
 

Creating a variable fillet between surfaces and a curve 

1 Click Fillet Surface  (surface creation menu). 

 
2 Fill in this dialog as described in Fillet surface dialog (see page 

191). 

3 Select the surface. 
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4 In the Selection part of the dialog, click the Secondary option 

5 Select the curve. 

 
6 Click OK. 

7 The Variable Fillet dialog (see page 210) is displayed, where you 
specify the details for the variable fillet. For further details, see 
Variable Fillet dialog (see page 210). 

 

Variable Fillet dialog 
Use this dialog to specify the variable fillet between a surface and a 
curve. 

 
Current arc - Click on the curve where you want to create a variable 
fillet. A small arc is displayed on the curve, as shown in the example 
below. The corresponding number for the arc is added and 
displayed in the Current arc drop-down list. 

 
 - Select one of the following options to specify the distance to 

be calculated for the variable fillet at the selected arc: 

 ABS - Absolute distance 

 REL - Relative distance 
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 PAR - Parametric distance. 

 - Enter the distance for the selected arc. 

Preview — Click to display a preview of the variable fillet. 

Arc radius - Enter a radius for the selected arc. 

Delete - Delete the selected arc. 

OK - Click to create the variable fillet. 

 
 

Editing a fillet surface 
You edit a fillet surface in the same way as a Power Surface. For 
further details, see Editing Power Surfaces (see page 112).  

 A fillet surface is made of laterals and longitudinals, where 
laterals run across the fillet spine and longitudinals along it. 

 

Editing a corner fillet 
You can edit a single fillet containing a corner into a mitre or make 
it rounder in the corner. 

For a region where many fillets meet, you can create a mitre or a 
smooth n-sided corner surface. 

1 From the Edit menu, select Fillet Corner to display the Edit Fillet 
Corner dialog. (see page 211) 

2 Use the Edit Fillet Corner dialog. (see page 211) to edit the 
corner of the fillet. 

 

Edit Fillet Corner dialog 
Use this dialog to edit the corner of the fillet. 
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Corner type — This gives the operations you can perform on corner 
fillets. Select from the following options: 

Mitre — This creates mitred corners on the selected fillet. 

We will edit the corners on the following fillet. 

 
The result is shown in the example below. 

 
Round — This makes the corner fillet rounder in the corner. 
Select the fillets containing corners and those which branch onto 
the corner fillets. 

 
You can select multiple surfaces containing fillets with corners. 

Enter a number in the Fullness box, if required. 
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N-sided corner — In a region where many fillets meet, this option 
trims the fillets back to each other (forming an n-sided hole) and 
automatically fills the hole with a smooth surface. 

We will edit the corners on the following fillet. 

 
The result is given below. 

 
Preview — Displays the edited corner fillets using the current 
settings in the dialog. You can change the settings in the dialog and 
the selected surfaces until you are satisfied with the previewed 
results. 

Apply — The corners are edited. 

OK — The corners are edited and the dialog is removed from the 
screen. 

Cancel — Closes the dialog without applying the corner edits. 
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How do I create a blend surface? 
A blend surface creates a smooth joint from one surface onto a 
group of surfaces. It tangentially leaves the one surface and joins 
the group of surfaces to ensure a smooth transition between the 
surfaces. 

 

1 Click  (Surface toolbar) to display the Blend Surface dialog 
(see page 214). 

2 Use the Blend Surface dialog (see page 214) to create the blend 
surface. 

 

Blend Surface dialog 
Use this dialog to create a blend surface from one surface onto a 
group of surfaces. 
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Consider the following surfaces. 

 

Selection 
Select the surfaces to blend. 

Primary - This is used to select the surface to blend from and one of 
its curves from where the blend surface starts. Select the surface 
you want to blend from  and a curve . 

 

 The curve can be any curve on the surface, not necessarily 
the end curve. 



 

216 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

Secondary - This is used to select the group of surfaces to blend 
onto. Select this option, select one or more surfaces and The cross 

 icon changes to a tick  icon.. 

 
Extra points per span - The blend curve defines one of the end 
curves on the blend surface. You can add extra points on each span 
of this end curve. 

In the example below, no extra points per span are added to the 
blend. 
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In the next example, three extra points per span are added to the 
blend. 

 

 With no extra points per span, the blend surface is created to 
tolerance and extra points may be added. If you specify a 
value other than zero, you restrict the number of points per 
span to that value and the blend surface may not be to 
tolerance. 

The number of points chosen should reflect the complexity of the 
surfaces being blended on to. If the surfaces are smooth, you'll get 
a good match with relatively few points. On the other hand, if the 
surfaces are convoluted, corrugated, or lumpy, you'll need a 
correspondingly greater number of points to achieve an adequate 
surface match. 

Preview/Next - This displays the blend surface as defined on the 
dialog. If you change the selection of objects or the number of Extra 
points per span and click this button, the preview of the blend 
surface is updated. If you click this button without making any 
changes, the next solution of blend surface is displayed. This blend 
surface tangentially leaves the blend curve in the opposite direction 
to the first solution. 

OK - This creates the blend surface and closes the dialog. 

Cancel - Closes the dialog without applying the blend. 
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Wrapping 
The following sections provide information on wrapping. 

What is wrapping? (see page 218) 

Using the Wrap Wizard (see page 219). 
 

What is wrapping? 
Wrapping allows you to add extra detail, complex 3D logos and 
artwork onto surface or solid models by wrapping the detail onto or 
around the shape of the model. For example, adding artwork to 
standard jewellery molds, adding grip texture to plastic moldings or 
adding detail and logos to shoe soles. For areas where an electrode 
will be used for manufacture, the wrap detail can be applied either 
to the actual part or directly onto a previously extracted electrode 
body. 

The type of wrapping strategy you use depends on the shape of the 
base model and how you want the relief to appear. 

The following menu options start the Wrap Wizard: 

  Curve Unwrapping (Curve toolbar) unwraps curves from 
surfaces and solids.  

  Curve Wrapping (Curve toolbar) wraps wireframe objects 
onto surfaces and solids.  

  Wrap Triangles, Surfaces or a Solid (Surfaces toolbar) wraps 
onto a triangle, surface or solid (see page 219) creating a wrap 
with no dependencies. 

  Create a Solid Wrap Feature (Solid toolbar) wraps onto a solid 
creating a solid feature in the solid feature tree. This feature can 
be modified as required. 

The Wrap Wizard changes automatically into the Rewrap Wizard 
depending on the stage of the wrapping process you have reached. 

1 For best results begin by unwrapping from a surface or solid. You 
may have a model that already contains detail that can be 
unwrapped, or you may need to create the geometry first by 
sketching curves onto the solid or surface. 

Unwrapping gives you back the wireframe edge curves so that 
when you rewrap the object, the wrap is a perfect match and 
positioned precisely. 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 219  

2 When the curves are unwrapped from the object you can add 
more detail using PowerSHAPE or ArtCAM. 

Designing with PowerSHAPE - If necessary, use the tools on the 
Mesh Editing toolbar to fix the mesh.  

You can smooth triangle symbols in PowerSHAPE to improve the 
appearance of the faceted triangle mesh.   

Designing with ArtCAM - export the unwrapped wireframe as a 
.PIC file into ArtCAM. Export the completed design back into 
PowerSHAPE as a DMT file ready for wrapping. 

 For best results, the triangle mesh of an imported DMT file 
needs to be a watertight C (boat - open topped) rather than 
a O (submarine - closed shape). If it is a O (closed shape) 
the target surface will not be trimmed correctly. 

3 When the wrap design is completed, you Rewrap onto the target 
object. 

 

Using the Wrap Wizard 

1 Select Wrap Triangles  (surface toolbar) to start the Wrap 
Wizard.  

If the model has been previously unwrapped, the wrap wizard 
detects this and turns into the Rewrap Wizard.  

2 Use the Target Selection page of the Wrap Wizard to select the 
target surfaces and/or solids for wrap. 

 
3 Use the Test Wrap option to create a test wrap for the selected 

wireframe and target object to let you see the viability of the 
results before proceeding through the Wrap Wizard. 
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4 Work through the steps of the Wrap Wizard by using Next to 
move to subsequent pages of the wizard. 

 

Wrap Wizard - Target Selection 
Use this page of the Wrap Wizard to select the target surfaces 
and/or solids for the wrap. 

 If you intend to select the Chord wrapping method on the 
Wrap method (see page 223) page of the Wrap wizard, the 
target selected must be a single surface or a watertight solid. 

 
Targets selected - When the target for the wrap is selected, The 
cross  icon changes to a tick  icon.. 

Set target type to curve for extrusion - This option is used for 
wrapping curves more easily in shoe design where you have a curve 
representing a cross section of the shoe sole instead of an existing 
sole surface. Any type of curve can be used as long as it is a single, 
planar curve. 

Select this option on the dialog then select the cross section curve 
as the target. An extruded surface is created automatically from the 
cross section curve which is then used as the target for wrapping. 

If you wish to wrap curves directly onto an existing shoe sole 
surface, leave this option blank and select the shoe sole surface as 
the target. For further details, see How do I create a shoe sole 
wrap? in the Wireframe modelling manual. 

Test Wrap - Select to create a test wrap for the selected wireframe 
and target object to see the viability of the results before 
proceeding through the Wrap Wizard. This option becomes available 
when the target is selected. 
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Wrap Wizard - Wrapper Selection 
Use this page of the Wrap Wizard to select one or more surfaces, a 
solid, or a symbol to be wrapped onto an object. 

 
Wrapper Items 

 Selected objects — Select this option and click on the required 
items displayed in the graphics window.  

The wrappers must be: 

 one solid 

 all surfaces 

 all symbols 

 all wireframe. 

The selection will be displayed in the preview window of the 
Wrapper Selection page of the Wrap Wizard.  

 DMT/STL File — Select this option to load a DMT (.dmt) file or a 
STL (.stl) file for wrapping. The Load DMT File dialog is displayed. 
where you select the file you wish to load. The image of the 
contents of the DMT or STL file or symbol is displayed in the 
preview window on the Wrapper Selection page. 

 For best results, the selection should be an open shape, with 
its outline lying  
in a plane.  

Load — Select this option to load another DMT file when a DMT file 
has already been loaded. The Load DMT File dialog is displayed. 

Use settings from previous unwrap — This option becomes available 
and is selected if the selected surface or solid has been previously 

unwrapped using Curve Unwrapping . 
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Wrappers selected — The cross  icon changes to a tick  icon. 
when the wrapper is selected. 

Next — Different pages of the wizard are displayed depending on 
which method is selected: 

Selected Objects — the Reference Plane page is displayed. 

DMT/STL File — the Wrap Method page is displayed. 
 

Load DMT File dialog 
Locate and select a DMT or STL file for wrapping onto a target 
object. 

 
Files of type - Select either a DMT (.dmt) or STL (.stl) file type from 
the drop down list. 

 You can smooth triangle symbols in PowerSHAPE to improve 
the appearance of the faceted triangle mesh.  

Open - Displays the selected DMT file. The image of the contents of 
the DMT file or symbol is displayed in the preview window of the 
Wrapper Selection page of the Wrap Wizard. 
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Wrap Wizard - Datum Workplane 
Select the workplane you want to use for the wrapper. 

 
Reference — This is a reference workplane that is created 
automatically at the centre of the wrapper at Z0. The wrapper will 
be wrapped onto the target solid or surface in a position relative to 
this reference workplane. 

If this reference plane is not in the right place, you may need to 
define one explicitly with its XY plane aligned with the open face of 
the wrappers. 

World — Refers to the world workplane. The wrapper will be 
wrapped onto the target object in a position relative to the world 
workplane. 

Reset — Click to reset the reference workplane to align with the 
workplane of the selection. 

Next — Displays the Wrap Method page of the Wrap Wizard. 
 

Wrap Wizard - Wrap Method 
Use this page of the Wrap Wizard to select the method for applying 
wrappers to target objects. 
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 A wrapper is the item selected for wrapping onto a target 
object. 

 
Wrap Method: Choose one of the following methods: 

Chord — This method wraps wireframe triangles onto the target 
object, minimising distortion. 

You define how the Chord wrapper is applied to the target object on 
the Chord Length Wrap Map Creation page of the Wrap Wizard. 

Plane — This projects the wrapper from a plane onto the target 
object. You can modify the plane in the graphics window. A 
chequerboard visual effect is displayed on the target object to show 
the effect of the wrap method. 
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Cylinder — This projects the wrapper from a cylinder onto the target 
object. You can modify the cylinder in the graphics window. A 
chequerboard visual effect is displayed on the target object to show 
the effect of the wrap method. 

 
UV — Uses the U, V (or T, U) parametric spacing of the surface or 
solid. A chequerboard visual effect of the result is displayed on the 
target object. 

Reset — This reverts the settings back to the default values. 

Next — Different pages of the wizard are displayed depending on 
which method is selected: 

 Plane, Cylinder or UV — the Wrapper Layout page of the Wrap 
Wizard is displayed. 

 Chord — the Chord Length Wrap Map Creation page of the Wrap 
Wizard is displayed. 

 Cone — This option is selected when creating a 360 degree 
conical wrap and is greyed out when other wrap methods are 
in progress. For further details, see How do I create a 360 
degree conical wrap? (Wireframe modelling). 

 

Wrap Wizard - Chord Length Wrap Map Creation 
Use this page of the Wrap Wizard to define how the Chord wrapper is 
applied to the target object. 
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 The wrap map is a 2D coordinate system for a triangulated 
surface. It is displayed as a black and white chequerboard 
effect on the target object. 

 
Minimize Distortion — Allows you to select where to minimize the 
distortion caused by the wrapping process. Select one of the 
following: 

Radially — This option works most successfully with square-
shaped target objects. 
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Along workplane X axis — This is the default option. This provides 
straighter lines and more even spacing along the X axis of the 
target object. 

 
Along workplane Y axis — This provides straighter lines and more 
even spacing along the Y axis of the target object. 

 
Globally (recommended) — minimises the distortion equally over 
the whole surface, preserving the shape of the wrapper as well 
as possible. When this option is selected, Wrap Precision is 
unavailable. 

 This method is only suitable for open targets; the target 
cannot be closed or tubular. The target may contain holes. 

Wrap Precision — Move the slider to adjust the precision of the wrap 
map to reduce distortion if necessary. Higher gives the best wrap 
quality but the wrap map takes longer to create. The default 
position is Normal. 
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Wrap Stiffness — Move the slider to adjust the preservation of large 
triangle areas, by changing their wrapping angle. Maximum stiffness 
reduces wrapping angles and preserves large triangle areas. 
Minimum stiffness increases wrapping angles of triangles for greater 
curvature. This is useful to prevent the flipping of triangles during 
the wrapping process. The default position is Normal. 

Preview — This creates the wrap map and displays it as a 
chequerboard effect on the target object. 

Next — The Wrapper Layout page (see page 228) of the Wrap Wizard 
is displayed. 

 

Wrap Wizard - Wrapper Layout 
Use this page to manipulate the position of the wrapper on the 
target object. 

 
True size — If ON, this preserves the aspect ratio and size of the 
triangles in the DMT file. If OFF, the triangles in the DMT file will be 
scaled to fill the target object. 

Mirror width — Mirrors the wrapper along its x axis. 

Mirror height — Mirrors the wrapper along its y axis. 

Use the following sliders to position and orientate the wrapper 
precisely on the target object: 
 Width offset  
 Size 
 Height offset 
 Aspect 
 Rotation — You can also enter the angle of rotation required. 
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 To finely adjust the sliders, use the arrow keys on the 
keyboard or the mouse wheel. 

Next — The Wrap Selection page of the Wrap Wizard is displayed. 
 

Wrap Wizard - Wrap Triangles 
Use this page to wrap the relief onto the surfaces and solids. 

 
If the selected wrapper is a solid or one or more surfaces, then the 
result of wrapping the selection onto the target is also a solid or one 
or more surfaces.  

 If the target is not smooth, the result may not match 
accurately or become folded. 

Trim — If on, the objects are trimmed to the outer boundary of the 
relief. 
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Male — If on, the offset is along the normal or workplane vectors 
and creates a male wrap. If off, the offset is in the opposite 
direction and creates a female wrap. 

 
Inwards — This option is most likely needed when using cylindrical 
projections. If it is on, the relief is projected from outside the 
model, inwards towards the centre of the cylinder. 

 
A relief node is placed on the first surface it encounters. 

 
If off, the relief is projected outwards from the centre of the 
cylinder. 
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The relief is placed inside the ring. 

 
Tile Settings — This creates a tiling pattern on the target using the 
selected wrapper. For further details, see Wrap Wizard Tiling (see 
page 233). Select this option to activate the Tile Settings button. 
Click the Tile Settings button to display the Tile dialog (see page 
235). 

Height — This controls the height of the wrap. There are three 
options: 

 Relative — You need to enter a value in the text box. A 
"natural" height for the relief is multiplied by the number in 
the text box. 

 Preserve — The height of each node is as given in the dmt file. 

 Maximum — You need to enter a maximum value. The height 
of the highest node is set to this value. The heights of all the 
other nodes are set proportionally to preserve the appearance 
of the relief. 

Offset along — This controls the offset direction of the wrap. There 
are two options: 

 Surface normal — Select this option to offset each node of the 
wrapper triangles in the direction of the surface normal by the 
height specified in the Height box. 

 Fixed direction — Select this option to offset each node of the 
wrapper triangles in the fixed direction, entered in the X, Y, Z 
boxes, to the height specified in the Height box. 

 
Preview — This previews the wrapping of the triangles from 
the dmt file onto the objects. 

Holes — This displays the Hole Filling dialog (see page 232) dialog, 
which sets options for filling holes caused by gaps in the model.  
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 This option is not available when: 

 creating solid wrap features 

 if Globally is selected as the method to minimise distortion. 
The resulting wrap goes round the holes without distortion 
and the holes remain unfilled. 

Defaults — This changes the settings on the dialog back to their 
default values. 

Cancel — No wrap is created. 

Finish — This wraps the surfaces, solids or triangles from the dmt 
file onto the objects and the Wrap Wizard completes. 

If you create a wrap using the Wrap Triangles option on the Surfaces 
menu, the wrapper will have no dependencies on the target surface 
and the two objects will be unconnected. 

If you create a wrap using the Create a Solid Wrap feature option on 
the Solids menu, dependencies will be created between the wrapper 
and the target object and a wrap feature  will be created in the 
solid feature tree. This allows the wrap feature to be modified. For 
further details, see What is the Solid Feature Tree? (Solid 
modelling).. 

 

Hole Filling dialog 
This dialog sets options for filling holes caused by gaps in the 
model. 

 
During wrapping, nodes in the relief can miss the target surfaces if 
there are gaps in the model or the relief falls off the edges of the 
surfaces. Such nodes are removed from the relief and their edges 
trimmed back. This can create holes and open edges in the wrap. 

Maximum number of edges which define a hole - This defines a hole in 
the relief. The edges are those of the triangles in the relief. 

Fill holes - Fills a hole with triangles if it has fewer edges than the 
maximum number. 
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PowerSHAPE uses a simple method for filling holes. For minor 
problems, it should do the job. In some cases, it may not give the 
required result. In these cases, you can do one of the following: 

 Correct the surfaces underneath the wrap and create the wrap 
again 

 Switch off the Fill holes option to create the wrap. Use Mesh 
Editing toolbar to fix the triangle and  improve the results. 

Close remaining open edges - Open edges are gaps between the 
model and the boundary of the relief. These are usually caused by 
the relief spilling off the edge of the surface. This option closes any 
open edges. 

 
OK - Changes the options to the new settings and removes the 
dialog from the screen. 

Cancel - The options are not changed and the dialog is removed 
from the screen. 

 

Wrap Wizard tiling 
You can create a tiling pattern from a surface, DMT file or symbol on 
your target object. Tiling creates copies of the original tile in rows 
and columns. The rows are separated by vertical spacing and the 
columns by horizontal spacing.  

To create a tiling pattern: 
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1 Specify the start position for the first tile in the tiling pattern on 
the target object using the layout controls on the Wrapper Layout 
page of the Wrap Wizard. 

 
2 Select the option next to Tile Setting to activate the tiling 

functionality.  

3 Click on the Tile Setting button. 

 
The Tile dialog is displayed, containing the tiling controls for creating 
a tiling pattern.  
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Tile dialog 
The Tile dialog contains four tiling controls for creating a tiling 
pattern using the wrapper in the Wrap Wizard.  

 
You can use a combination of the four tiling controls to create the 
desired tiling effect, or leave the values at zero to create tiling with 
the default values. You can enter the values directly or use the 
sliders to set the values. 

 - Tile with offset. Enter a percentage of the corresponding 
dimension of a tile to offset each row to the right. This results in a 
stretcher-like pattern similar to that of a brick wall.  

 - Tile with vertical spacing. Use the slider to increase or decrease 
the vertical spacing between the tiles, or enter a value to specify 
the percentage of the total spacing in the vertical direction.  

 - Tile with horizontal spacing. Use the slider to increase or 
decrease the horizontal spacing between the tiles, or enter a value 
to specify the percentage of the total spacing in the horizontal 
direction. 

Flip  - If ON, the alternate tiles are flipped. Flip is not available when 
wrapping a surface. 

OK - Click to create a tile using the values displayed on the dialog or 
accept the default zero values. Tiling is created when you select 
Finish on the Wrap Selection page of the Wrap Wizard. 

 Only click OK if you are sure you want to create a tile pattern. 

Cancel - Click to exit Tile Settings and return to the Wrap Wizard. 
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Surface morphing 
Morphing allows you to deform a group of surfaces into a different 
shape. 

 
All the detail on the surfaces, such as fillets and trimming remain 
intact, even though the shape may be totally changed. 

Morphing can be used for a number of applications: 

 Adding draft to a model. 

 Compensating for distortion that occurs during the 
manufacturing process, for example, sag and spring-back. 

 Adding design features. 

 Local modification such as closing a gap. 

 Shoe design, wrapping a sole onto a new size. 

 Making artistic and aesthetic changes to a model to allow you to 
improve and rejuvenate existing models. 

It can be controlled by using points, curves or surfaces around the 
model. For best results, use morphing to make fairly minor 
modifications rather than substantial changes to the shape. 

 The point, curve and surface morphing functionality is subject 
to a patent application. Patent pending: GB2401213 Altering a 
CAD model. 

 

Creating a surface morph 
1 Select the surfaces you want to morph. 

2 Select  (General edits toolbar) This is the same as selecting 
Edit > General Edits > Morph Objects.  

 You can also select the surface with the right mouse button 
and choose Define Morph. 

3 Use the Surface morphing dialog to define the morph. 
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Surface morphing dialog 
The Surface Morphing dialog has four tabs. Select one of the 
following for further information: 

 Surface Morphing dialog - Single Point (see page 237) 

 Surface Morphing dialog - Point/Plane (see page 240) 

 Surface Morphing dialog - Two Curves (see page 243) 

 Surface Morphing dialog - Two Surfaces (see page 249) 
 

Surface Morphing dialog - Single Point 
Use this morphing method to make local changes to a shape, while 
keeping it smooth. 

 
This morphing method uses two points: 

 Origin. This usually lies on the surface.  

 Distortion point. This can lie anywhere in space.  

The origin point moves to distortion point.  
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When this page on the dialog is displayed, a point is marked on the 
objects to show where the origin and distortion points lie. Both 
points initially lie in the same position  until one of them is 
redefined. 

 
1 Enter a Radius. Two spheres are drawn around the origin point. 

 The outer sphere shows the bounded region affected by the 
morph.  

 The inner sphere reflects the Decay Scale. 

 
Points within the sphere move in the direction defined by the 
origin and the distortion point. The amount they move depends 
on the distance from the origin and the decay scale. Points at or 
beyond the sphere remain unchanged. 

To avoid introducing folds in the surface, the radius should 
generally be at least twice the distance from the origin to the 
distortion point. 
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2 Use the slider to set the Decay Scale. This controls how rapidly 
the shape changes as you move away from the origin point. If 
you change the value of the Decay Scale, the inner sphere 
changes size. The limit of this sphere is where the distortion will 
have been reduced by half. So, the smaller the inner sphere is in 
comparison to the outer sphere, the more rapid the shape 
change. 

 
You can set a value between 0.05 (rapid change) and 0.5 (slow 
change). The diagram below shows the changes to the shape as 
the decay value decreases. The decay defines the fraction of the 
radius at which the distortion is halved. 

 
3 Click Origin to display the Position dialog. Use this to enter a new 

origin by selecting a point on the surface or solid. When you 
enter a new origin, the mark moves to the new position . You 
can also drag the origin point to move it. 

4 Click Distortion Point to display the Position dialog. Use this to 
enter the new position of the origin point. A point is drawn to 
mark where the distortion point lies  and a line is drawn from 
the point to the origin. You can also drag the distortion point to 
move it. The distortion point can lie on either side of the surface. 
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5 Click OK to create the morph. 

 
 

Surface Morphing dialog - Point/Plane 

 
This morphing method is ideal for altering the toe-spring of a shoe, 
and similar applications where you want to bend a portion of a 
model.This morphing method uses two points: 

 Origin. This usually lies on the surface.  

 Distortion point. This can lie anywhere in space.  

The origin point moves to distortion point.  
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When this page on the dialog is displayed, a point is marked on the 
objects to show where the origin and distortion points lie. Both 
points initially lie in the same position  until one of them is 
redefined. 

 
1 Click Origin to display the Position dialog. Use this to enter a new 

origin by selecting a point on the surface or solid. When you 
enter a new origin, the mark moves to the new position . You 
can also drag the origin point to move it. 

 
2 Click Distortion Point to display the Position dialog. Use this to 

enter the new position of the origin point. A point is drawn to 
mark where the distortion point lies  and a line is drawn from 
the point to the origin. You can also drag the distortion point to 
move it 
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3 Create and select a workplane on the surface. The cross  icon 
changes to a tick  icon.. This selection determines the region of 
the objects to alter. If a region of the object lies on the same 
side of the plane as the origin point, its points are moved . 
Otherwise the region remains unchanged . If no workplanes 
exist in the model, the world workspace is automatically used. 

 
Points are moved in the same direction by an amount depending 
on their distance from the plane, in order to keep a smooth 
shape. All points that are the same distance from the plane are 
moved by the same amount.  

 The principal plane is selected by choosing one of the 

buttons  from the Status bar. For example, if you 
want to select the YZ principal plane, select the button with 
X on it. 

4 Click OK to create the morph. 
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Surface Morphing dialog - Two Curves 
Define the morph using a control and reference curve. 

 
The two curve method provides more control over the shape of the 
result than the single point methods. 

When morphing with curves: 

 Both the reference and control curve must have the same 
number of points. 

 Both the reference and control curve must be open or both 
closed. 

 Keep the reference and control curves simple. 

 Limit curves or surfaces should not cross the reference curve. 

 Keep the limit curve or surface simple. 

 If the curves are open, the start and end points of the curves 
must coincide. 
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 If open curves are also tangential at the start and end, you will 
get smoother results in cases where the model to be morphed 
extends beyond the ends of the curve. 

 
 Avoid discontinuities and sharply curved corners in the reference 

and control curves and surfaces, as they may introduce kinks or 
ripples into the morphed model. 

 As you move over the model, it is important that there is always 
a unique closest point on the curve, and that the closest point 
does not jump from one place to another. Otherwise the 
morphed model may contain kinks. 

 The model being morphed may be as complicated as you like. 

Two curves dialog 
1 Select Reference Selection and select the reference curve on the 

screen. 

2 Select Control Selection and select the control curve on the 
screen. 

3 By default, the reference and control curves are deleted from the 
model after you have used them for morphing. If you want to 
keep them, select Keep Selections. 

4  Select a Method suitable for the shape of your reference and 
control curves. 
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 - Select this method if your curves are open and have only a 
small turning. 

 

 - Select this method if your curves are open and have a large 
turning. 

 

 - Select this method if your curves are closed. 
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If your curves are open and you are not sure which method to 
use, try methods  and  and select the one that gives the 
best results. 

In Projection - This option projects certain objects onto the 
principal plane so that PowerSHAPE can calculate how to morph 
the surfaces. 

To fully understand this option, you need to know how objects 
are morphed.  

The principal plane is selected by choosing one of the buttons 

 from the Status bar. For example, if you want to select 
the YZ principal plane, select the button with X on it. If no 
workplanes exist in the model, the world workspace is 
automatically used. 

Use Reference - (Only available if you use the closed curves 
method  and the In Projection option is on.) This allows you to 
select the reference axis that is used to calculate the 
corresponding points on the reference curve. When using closed 
curve morphing, it is recommended that you use a reference axis 
if the object to be morphed lies mainly inside the curve. Click the 

 button to display the Direction dialog. Use this dialog to select 
the axis. 

Moving points using the two curves morphing method (see page 
251) gives details on how objects are morphed. 

5 Select the Decay option. This decides how much the points on 
the selected surfaces move as you move away from the 
reference curve. If the points to be morphed lie on the reference 
curve, they are moved onto the corresponding point on the 
control curve regardless of the decay option. Points that are not 
on a reference curve are moved according to the selected Decay 
option.  

The following options are available: 

None - Points are moved by the distance between the 
corresponding points on the two curves. 
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Distance - Points are moved depending on the distance from their 
corresponding point on the reference curve .  

If the distance is less than the value given in the Limit box, a 
point moves by the distance defined by its corresponding points 
on the two curves and the Decay scale. The closer the distance is 
to the value given in the Limit box, the less the point moves. 

If the distance is equal to or more than the value given in the 
Limit box, the points are not moved. 

 
Curve or Surface - Points are moved depending on the distance 
from their corresponding point on the reference curve and 
distance from the closest point on the selected limit curve or 
surface. 

The closer the distance is to the limit curve or surface, the less 
the point moves. Beyond the selected curve or surface, the 
points are not moved. The curve or surface should not cross the 
reference curve. 

 
The Curve and Surface options take longer to process, and should 
only be used when other options  fail to produce the required 
solution.. 

6 Select a Blend from the drop-down list. For all types of decay 
other than None, you can define how the shape of the morphed 
region blends into its surroundings using the following options: 
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Quartic - This is the default option It provides a smooth blend 
and join to the surroundings and a smooth shape as it crosses 
the reference curve. This option should give the correct result in 
most cases. 

   
Cubic - It provides an S-shaped blend, with a smooth join to the 
surroundings, and a smooth shape as it crosses the reference 
curve. 

   
The Quartic and Cubic options give very similar results. so it is 
best to try each option in turn and use the option that produces 
the best solution for your model. 

Parabolic - This varies smoothly with the surroundings, but 
comes to a sharp peak at the reference curve. 

   
It is suitable when the reference curve lies on an open edge of 
the model, else a sharp edge will be introduced along the curve. 

Linear - This varies in a straight line from the maximum on the 
reference curve to zero at the limit. Therefore the morph does 
not blend smoothly with its surroundings. 
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It is suitable if the entire surface is being morphed, or if there is 
a limit curve defined along a discontinuity on the model. 

7 Select Decay Selection if you selected Curve or Surface as the 
Decay option. Select the required object. 

8 Enter the Limit. This is the distance used by the Distance option 
in the Decay menu. 

9 Select the Decay scale if you selected the Distance as the Decay 
option. This controls how rapidly the shape changes as you move 
away from the reference curve. You can set a value between 
0.05 (rapid change) and 0.5 (slow change). 

The decay defines the fraction of the limit distance at which the 
distortion is halved. 

 

Surface Morphing dialog - Two Surfaces 
This uses a control and reference surface to define the morph. 

 
The two surface method provides more control over the shape of 
the result than the single point methods. It can be used to make 
substantial changes to a model, for example to stretch or bend in a 
controlled manner, or to project one shape onto another. 

You should bear the following important points in mind when 
working with surfaces. 

 Both the reference and control surface must have the same 
number of laterals and longitudinals. 



 

250 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

 The laterals on both surfaces must be open or both closed. 

 The longitudinals on both surfaces must be open or both closed. 

 Keep the reference and control surface simple. 

 Keep the limit curve or surface simple. 

 Limit curves or surfaces should not cut the reference surface. 

 Avoid discontinuities and sharply curved corners in the reference 
and control surfaces, as they may introduce kinks or ripples into 
the morphed model. 

 As you move over the model, it is important that there is always 
a unique closest point on the reference surface, and that the 
closest point does not jump from one place to another. Otherwise 
the morphed model may contain kinks. 

 The model being morphed may be as complicated as you like. 

Two surfaces dialog 
1 Ensure that Reference Selection is selected and choose the 

reference surface on the model. Use Reverse surface  and 

Swap laterals and longitudinals  as required. 

2 Select Control Selection and choose the control surface on the 
model. 

3 If you want to keep the reference and control surfaces after you 
have used them for morphing, select Keep Selections. 

4 Select Normal Offsetting so the surfaces to be morphed are bent 
to follow the control surface. If you want to know precisely how 
the selected objects are morphed using Normal Offsetting, see 
Moving points using the two surface morphing method (see page 
251). 

If Normal Offsetting is deselected, you can specify the Decay 
Definition options. The options that are used to define the decay 
are described in Surface Morphing dialog - Two curves (see page 
243)  
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Moving points using the two curves morphing method 
The reference and control curve define the morph. For each point on 
the reference curve, there is a corresponding point with the same 
number on the control curve.  

 
The distance and direction between two corresponding points on the 
two curves defines the morph. If the points on the selected objects 
lie on the reference curve, they are moved to the corresponding 
point on the control curve. 

 

 1. The position of corresponding points on the curves is 
important. In the example above, the keypoints correspond, 
producing the expected morph. If the keypoints do not 
correspond, the resulting morph may have an unexpected 
twist. 

2. If the points on the selected objects don't lie on the 
reference curve, the Method option determines how the points 
will move.  

 

Moving points using the two surface morphing method 
The following example shows how selected objects are morphed 
using the two surface morphing method. 

The morph is defined by: 
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 Control surface 

 Reference surface 

 
The extruded H surface is morphed by the difference between the 
flat reference surface and the cylindrical control surface. For each 
point on the reference surface, there is a corresponding point with 
the same 2D parametric coordinates on the control surface. This is 
used to define how to reshape the H.  

 2D parametric coordinates are measured using the laterals 
and longitudinals. 
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If the points on the selected objects lie on the reference surface, 
they are moved to the corresponding point on the control surface. 

 
If the points on the selected objects don't lie on the reference 
surface, the Normal Offsetting option determines where the points 
will move. 

The morphing method finds the closest point on the reference 
surface for each point on the selected objects and the offset 
between the two points. 

 The positions of corresponding points on the surfaces are 
important. If the key points do not correspond, the resulting 
morph may have an unexpected twist. 

 Closest point on the reference surface. 

 Point to be morphed. 
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 Offset. 

 
The point on the reference surface has a corresponding point with 
the same number on the control surface. 

 
If the Normal Offsetting option is deselected, the point is moved so 
that it is offset by the same amount from the point on the control 
surface, reduced by any decay that you may have defined.  
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 Offset on reference surface. 

 Position of point if there is no decay. 

 
In this case, the model appears as follows: 
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If the Normal Offsetting option is on, points are offset along the 
surface normal on the control surface by their distance from the 
reference surface, so that the model appears to be bent to follow 
the control surface .  

 
In this case,the surface appears as follows: 
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 The positions of corresponding points on the surfaces are 
important. If the keypoints do not correspond, the resulting 
morph may have an unexpected twist. 

 

Small turning method 
This section shows how points on the selected objects that don't lie 
on the reference curve are morphed using the small turning 
method. 

In the example below, the point  does not lie on the reference 
curve. We will find its corresponding point on the reference curve. 

 

The reference axis  is along that line which joins the two ends of 
the reference curve. 

 
If a point to be morphed does not lie on the reference axis, a plane 
is defined through the point, normal to the reference axis . A 
corresponding point is defined on the reference curve where the 
reference curve intersects this plane . 
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The curve must not be so highly curved that it crosses the plane 
more than once, or the morph will fail. 

A distance and direction is defined from the point on the reference 
curve to the point with the same number on the control curve . 

 
The point on the surfaces to be morphed is moved by this distance 
and direction, reduced by any decay that you may have defined . 
On the example, the point will move to  if there is no decay. 

 
If In projection option is selected, the reference axis is projected 
onto the principal plane before the plane is defined to identify points 
on the reference curve. 

 

Large turning method 
Points on the selected objects that do not lie on the reference curve 
are morphed using the large turning method .  
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In the example, the point  does not lie on the reference curve and 
the reference curve has a large turning angle 

 
The reference axis  is defined at right angles to the line that joins 
the two ends of the reference curve. It lies in the plane of the curve 
if it is planar, else approximately so. 

 
For each point to be morphed: 

 a plane is defined through the point, normal to the reference axis 
.  
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 two points on the reference curve are defined where it intersects 
this plane . 

 
The curve must not be so highly curved that it crosses the plane 
more than twice, or the morph will fail. 

For each of the two points on the reference curve, a distance and 
direction is defined from it to the point with the same number on 
the control curve . 
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If the point to be morphed lies between the two points on the 
reference curve, it is moved by a combination of their distances and 
directions . 

 
Many points to be morphed can be identified with the same two 
points on the reference curve. They are not all moved by the same 
amount. The closer they are to one of the two points, the more 
influence its distance and direction has on their movement. 

 
If the point to be morphed lies outside the two points on the 
reference curve, the closest point on the reference curve is found 
instead, in projection if a projection axis is defined. The point is 
moved by the distance and direction from the closest point to the 
corresponding point on the control curve, reduced by any decay. 

 

Closed curve method 
Points on the selected objects that don't lie on the reference curve 
are morphed using the closed curve method. 
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For each point to be morphed, the corresponding point on the 
reference curve is identified by one of three methods. Each method 
is selected by using a combination of the In Projection and Use 
Reference options: 

 Closed curve method - In Projection deselected (see page 262) 

 Closed curve method - In Projection selected, Use Reference 
deselected (see page 264) 

 Closed curve method - In Projection selected, Use Reference 
selected (see page 264) 

 

Closed curve method - In Projection deselected 
This morphing method works best for surfaces that lie entirely 
outside or on the reference curve. 

 
1 For each point on the selected curve, the closest point on the 

reference curve is identified . 
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2 A distance and direction is defined from the point on the 
reference curve to the point with the same number on the 
control curve . 

 
3 The point on the surfaces to be morphed is moved by this 

distance and direction, reduced by any decay that you may have 
defined . 

 
4 Click on OK to produce the result below. 
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 If a point lies inside and close to the centre of the reference 
curve, the closest point may lie on either the upper or lower 
side of the reference curve, leading to a gap in the morphed 
surface. 

 
 

Closed curve method - In Projection selected, Use 
Reference deselected 

When In Projection is selected and Use Reference is deselected, the 
closest point on the reference curve is identified by first projecting 
the point and reference curve onto the principal plane. Apart from 
this, the method works in the same way as Closed curve method - 
In Projection selected (see page 262). 

 

Closed curve method - In Projection selected, Use 
Reference selected 

This method works in the same way as  on an open curve, but 
you must define a reference axis. Before the reference axis is used, 
it is projected onto the principal plane. 
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Define a suitable reference axis. In this example, the surfaces will 
fail to morph with a vertical axis. This is because when you define 
the plane that is normal to the reference axis, it goes through the 
reference curve more than twice for some points on the surfaces to 
be morphed. 

 
For this example, use a horizontal axis. No plane normal to this axis 
crosses the reference curve more than twice. 
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This example gives the following result. 

 

See Also: 
Surface Morphing dialog - Two curves (see page 243) 

 

Editing morph surfaces 
Edit an existing morph surface in one of the following ways: 

 Use the tools on the Surface editing toolbar but only some of the 
options are available for morphed surfaces. 

 Select the morph and select Edit > Surface and Curve Edits > 
Surface Edits > Edit Morph to displays the dialog for the particular 
type of morph.  

 Select the morph with the right mouse button and choose Edit 
Morph from the context menu. This displays the dialog for the 
particular type of morph.  

 Click the Morph  (General Edits toolbar) to display the dialog 
for the type of morph. 

 You cannot change the type of morph once the morph is 
defined. 
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Single point morph dialog 
Use this dialog to edit a single point morph. 

 
When this dialog is displayed, the following are shown: 

 Origin point  

 Distortion point  

 Two spheres around the origin point. The outer sphere shows the 
region enclosed by the radius and the inner sphere defines the 
Decay Scale. 

 
Use the options on the dialog as described in Surface Morphing 
dialog - Single Point (see page 237) 
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Point/Plane morph dialog 
Use this to edit a morph that was created using a point and a plane. 

 
When this dialog is displayed, the following are drawn: 

 the origin . 

 the distortion point .  

 the workplane. 

You edit the positions of the origin and distortion points, but not the 
workplane. 

 
Use the options on the dialog as described in Surface Morphing 
dialog - Point/Plane (see page 240). 
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Two curves morph dialog 
This lets you edit a two curves morph. 

 
The reference curve is drawn as a dotted line and the control curve 
as a solid line. 

 
If a decay curve or surface is used in the morph definition, it is also 
drawn as a dotted line. In shaded mode, the decay surfaces are 
shaded in a transparent material. 

  Click Edit Control to edit the control curve . 

 Click Edit Reference to edit the reference curve . 
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When you select Edit Control or Edit Reference, the relevant curve 
becomes selected and the Curve Edit toolbar is displayed. You 
can edit the curve graphically or using the toolbar. Some curve 
edits are not allowed as they destroy the morph definition. 

To exit curve editing mode, select another item on the dialog. 

 Decay Definition - You can only edit the decay if it was defined 
when you created the morph. The method cannot be changed. 

For Curve and Surface decays, you can only change the blend. 
The selected objects cannot be changed. 

For the Distance method, you can change the blend, limit and 
decay scale. 

The remaining options on this page appear on the Surface Morphing 
dialog - Two Curves (see page 243).  

 

Two surfaces morph dialog 
Use this dialog to edit a two surfaces morph. 

 
When the dialog is displayed, the following are shown: 

 Control surface. 
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 Reference surface. In wireframe mode, the reference surface is 
drawn using dotted lines. In shaded mode, it is drawn in a 
transparent material. 

 
If a decay curve or surface is used in the morph definition, it is also 
drawn as a dotted line. In shaded mode, the decay surfaces are 
shaded in a transparent material. 

The Decay Definition can only be edited if it was defined when you 
created the morph. The method cannot be changed. 

 For Curve and Surface decays, you can only change the blend. 
The selected objects cannot be changed. 

 For the Distance method, you can change the blend, limit and 
decay scale. 

The Decay options appear on the Surface Morphing dialog - Two 
Surfaces (see page 249) 
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Trimming surfaces 
Use the following sections to trim surfaces: 

How do I trim surfaces? (see page 272) 

What is a trim boundary? (see page 272) 

Creating a trim boundary (see page 273) 

Editing a trim boundary (see page 273) 

What is a pcurve? (see page 282) 

Creating a pcurve (see page 283) 

Editing a pcurve (see page 283) 

Creating wireframe curves from pcurves (see page 305) 
 

How do I trim surfaces? 
Many real objects consist of several surfaces, some of which are 
trimmed. It is convenient to describe such objects by regular 
surfaces, together with a set of trim boundaries for each surface, so 
that when the object is drawn, the trimming is performed 
automatically. 

You can trim surfaces using the following options on the Limiting 
flyout (General Edits toolbar): 

 Limit Selection 

 Limit Point 
 

What is a trim boundary? 
A trim boundary or a set of trim boundaries on a surface define the 
trim region of a surface. 
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On the surfaces shown, two trim boundaries exist: one on the 
cylinder  and the other on the plane . 

 
These surfaces can be trimmed back to give the following: 

 
A trim boundary consists of pcurves and surface edges joined 
together to form a closed region of a surface.For further details, see 
What is a pcurve? (see page 282). 

 

How do I create a trim boundary? 
Trim boundaries are created automatically when: 

 creating fillet surfaces. 

 creating draft surfaces. 

 limiting surfaces using Limit Selection and Limit Point. 
 

Editing a trim boundary 
A trim boundary must form an enclosed region on a surface, 
otherwise the trim region is not defined. 



 

274 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

When you generate a trim boundary, you may end up with one as 
shown below. 

 
From this boundary, it is difficult to define the trim region. Is the 
trim region the following? 

 
Or is it? 

 
PowerSHAPE provides tools to help you define your trim region 
accurately. Sometimes, the pcurves may cause spikes or even loops 
in the trim boundaries. These tools can also be used to remove 
spikes and loops. 

1 Select the surfaces on which the trim boundary lies. 

The Boundary editing toolbar (see page 274) is displayed. 

2 Use the Boundary Editing toolbar to edit the trim boundary. 
 

Boundary editing toolbar 
Each button on the boundary editing toolbar is described below. 

 Display the boundary editing toolbar 

 Display pcurve editing toolbar (see page 283) 

 Generates diagnostics on boundaries (see page 275) 
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 Selects all the boundaries (see page 279) on the selected 
surface. 

 Displays/removes the boundary selector (see page 278). 

 Removes one-point spikes (see page 279) from the selected 
boundary. 

 Removes loops (see page 279) from the selected boundary. 

 Closes a boundary (see page 280). 

 Recreates boundaries (see page 280). Deletes any selected 
boundary and enters boundary creation mode. 

 Automatically creates boundaries (see page 280) from the 
pcurves on the surface. Any existing boundaries are deleted. 

 Swaps the trim region (see page 281) defined by a set of 
trim boundaries (for example, it converts a "hole" into an 
"island"). 

 Deletes the selected boundary (see page 281) (without 
deleting its pcurves). 

 Most operations are available when multiple surfaces are 
selected. 

 

Generating diagnostics on boundaries 
Badly defined pcurves (that can lead to badly trimmed surfaces) can 
be identified using Identify badly trimmed surfaces on the Model 
Fixing toolbar. You can closely analyse boundary data to see where 
any problem areas exist and then manually correct them. 

1 Select the surfaces. 

2 Click  (boundary editing toolbar). This displays the 
Diagnostics dialog. 
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Diagnostics dialog 
This dialog displays details about trim boundaries (if in boundary 
editing) and pcurves (if in pcurve editing) on the selected surfaces. 

 
In the window, a warning is displayed if the boundaries cannot form 
a trim region. If a corrupt boundary is found, you are told to either 
delete and recreate it or use the File Doctor. 
This window also displays the following information about each 
boundary: 

 whether the boundary is open or closed; 

 whether the boundary has self intersections; 

 whether the boundary crosses any other boundaries; 

 whether the boundary has a region with zero area. 

Each of the above is discussed in more detail. 

Closed or open - An open boundary cannot define a trim region. You 
must edit the boundary to close it. 

 A closed boundary can be defined using the outer edges of its 
surface. 

 
 Open boundary. 

 Closed boundary (using surface edges to define a valid trim 
region). 

 Closed boundary. 
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Self intersections - If a boundary intersects itself, a loop exists (see 
figure below). The visible region of the surface lies on the left of the 
boundary. Arrows are drawn to show the left of the boundary. 

 
As you can see in the figure below, we have a region that is both 
invisible  and visible . Therefore, such a boundary cannot 
define a trim region. 

 
You must edit the boundary to remove the loop. 

Crossing other boundaries - If a boundary crosses another, the trim 
region cannot be defined. The reason is similar to the self 
intersecting boundary. You must edit the boundaries to stop them 
from crossing. 

Region with zero area - PowerSHAPE attempts to find regions where 
the area is zero. This is where the boundary goes back on itself. In 
such cases, the following warning may display 

A section of boundary 2 has zero area 

check pcurve 3 around point 12 

This is an approximate position of where the error is. The named 
point may not be the problem itself but the surrounding points will 
be. 

 Only the first error is reported. We recommend you fix the 
problem by editing the necessary points. Then click Update on 
the Diagnostic dialog to find any further problems. 

Similarly, you can analyse the pcurves on the surface. For further 
details, see Generating diagnostics on pcurves (see page 287). 
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Update - You can manually edit the boundary and then click Update. 
This updates the information to the new selection. If you change to 
pcurve editing and then click this button, information about the 
pcurves is displayed. For further details, see Generating diagnostics 
on pcurves (see page 287). 

OK - Removes the dialog from the screen. 
 

Selecting boundaries 
Use the boundary selector to select multiple boundaries on multiple 
surfaces. 

1 Select the surfaces. 

2 Click  (Boundary editing toolbar). 

 
3 Use the dialog to select boundaries. 

Select the boundaries from the list. A single click selects a single 
item. Pressing the Shift key when clicking a single item, selects 
all the items from the last selected item to the clicked item. 
Pressing the Control key when clicking a single item, 
adds/removes the clicked item from the current selection. 

You can also select boundaries by clicking them on the screen. 

Surface  - This contains the names of the selected surfaces. You 
can choose another surface from the drop down list and its 
boundaries are displayed in the list. 

 Any selected boundaries remain selected when you use the 
drop-down list to select another surface. 

4 Click OK to confirm the boundaries and remove the dialog from 
the screen. 
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Selecting all boundaries 
You can select all the boundaries on selected surfaces. 

1 Select the surfaces. 

2 Click  (Boundary editing toolbar). 
 

Removing spikes from a boundary 
This deletes points in the selected boundary where the angle 
between the line segments is less than angular tolerance. 

1 Select the boundary. 

2 Click  (Boundary editing toolbar). 

 
 Angle greater than angular tolerance. 

 Angle less than angular tolerance. 
To change the angular tolerance: 
1 From the Tools menu, select Options to display the Options 

dialog.  

2 Select Units and Tolerances options. 

3 Change the Angular tolerance to the required value. 

4 Click OK. 
 

Removing loops from a boundary 
This deletes points in the selected boundary which cause loops. 

1 Select the boundary. 

2 Click  (Boundary editing toolbar). 
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Closing a boundary 
This closes a boundary by adding a pcurve to link the end point of 
the last pcurve in the selected boundary to the start point of the 
first pcurve. 

 
1 Select a boundary. 

2 Click  (Boundary editing toolbar). 
 

Recreating a boundary 
You can recreate trim boundaries on surfaces using a direct method 
similar to composite curve creation. 

1 Select the boundary if you wish to delete it. 

2 Click  (Boundary editing toolbar). 

3 Use the Create Trim Boundary control panel to create and delete 
the boundary 

 
This control panel works in exactly the same way as the Create 
Composite Curve control panel. 

 

Automatically creating boundaries 
You can automatically create boundaries from the pcurves on a 
surface. Any existing boundaries are deleted before creating new 
ones. 

Ideally, the pcurves should lie in sensible positions to define unique 
boundaries, otherwise you'll have to use the boundary editing tools 
to change which pcurve belongs to which boundary. 

1 Select the surfaces. 

2 Click  (Boundary editing toolbar). 

If boundaries already exist, you are warned that they will be 
deleted. 
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Swapping the trim region 
This swaps the trim region by switching the visible and invisible 
regions of the surface. 

 
1 Select the boundary. 

2 Click  (Boundary editing toolbar). 
 

Deleting a boundary 
On the Boundary editing toolbar, two commands exist for deleting a 
boundary: one command deletes the boundary and takes you into 
boundary creation mode and the other command just deletes the 
boundary. These commands do not delete the pcurves. If you delete 
the boundary using the Main toolbar, then the boundary and its 
pcurves are deleted. 
Just deleting a boundary 

1 Select the boundary. 

2 Click  (Boundary editing toolbar). 

 If no boundaries are selected, but the surface has exactly 
one boundary then the boundary is exploded. 

Deleting a boundary and entering boundary creation 

1 Select the boundary. 

2 Click  (Boundary editing toolbar). 

The selected boundary is deleted. You can now create a new 
boundary using the Create Trim Boundary control panel. 

Deleting the boundary and its pcurves 

1 Select the boundary. 

2 Click the Delete button  on the main toolbar or press Delete. 
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Creating composite curves from boundaries 
While the Boundary editing toolbar is displayed, you can use Edit > 
Convert > to wireframe to create composite curves from selected 
boundaries. 

 

What is a pcurve? 
A pcurve is a parameter curve which is generated on a surface by 
certain operations. These operations include: 

 creating fillet surfaces 

 creating draft surfaces 

 limiting surfaces using the Limit Selection and Limit Point 
commands 

A pcurve is used to define the trim boundary of a surface and is 
made up of a series of line segments which match the surface to 
within tolerance. A pcurve is a parameter curve because the curve 
is defined in the 2D parameter space of a surface. A pcurve contains 
points which are called ppoints. Every surface is defined by 
parameters t and u which vary across the surface. 

 
The values of t and u uniquely define a point, p, on the surface. 
Thus point p can be defined by 3D world space coordinates (x, y, z) 
or by 2D parameter space coordinates (t, u). In the figure below, 
the 2D parameter space coordinates of p are (3.5, 2.75). 
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World coordinates are not guaranteed to lie on the surface, whereas 
parameter space coordinates must by definition lie on the surface 
(the third dimension is the surface). Curves used as part of trim 
boundaries of surfaces must lie exactly on the surface being 
trimmed, and so pcurves are defined within the 2D parameter space 
of a surface. They cannot therefore be operated on in quite the 
same way as other curves (for example, they cannot be dragged off 
a surface) and a special editor is provided to manipulate them. 

 

How do I create a pcurve? 
Pcurves are usually generated automatically when performing 
certain operations on surfaces and not created from scratch. These 
operations include: 

 creating fillet surfaces 

 creating draft surfaces 

 limiting surfaces using the Limit Selection and Limit Point 
commands. 

 

How do I edit a pcurve? 
Occasionally when you generate a pcurve, it may need adjusting 
slightly. Editing a pcurve also changes the boundary containing it. 

1 Select the surfaces on which the pcurve lies. The pcurve editing 
toolbar will be displayed. 

All pcurves on the selected surfaces are displayed. 

2 Select the appropriate button from the toolbar. 
 

Pcurve editing toolbar 
The pcurve editing toolbar consists of the following buttons: 

 Display the boundary editing toolbar (see page 274). 

 Display pcurve editing toolbar. 

 Generates diagnostics on pcurves (see page 287). 

 Selects all pcurves (see page 285) on the selected surface. 

 Selects all unused pcurves (see page 285) on the selected 
surface. 

 Displays/removes (see page 284) the pcurve selector. 
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 Removes one-point spikes (see page 288) from the selected 
pcurve. 

 Removes loops (see page 289) from the selected pcurve. 

 Removes surplus points (see page 289) to simplify the 
selected pcurve. 

 Labels the ppoints (see page 289) on pcurves. 

 Turn point labels off (see page 289). 

 Makes pcurves from wireframe (see page 290). 

 Copy pcurves (see page 293). 

 Extends the selected pcurve (see page 294). 

 Cuts the selected pcurve (see page 297) at the selected 
point into two pcurves. 

 Opens the pcurve (see page 297). 

 Closes the pcurve (see page 297). 

 Deletes the pcurve (see page 298). 

 Displays/removes the ppoint selector (see page 286). 

 Edits the parametric value (see page 298) at the selected 
ppoint. 

 Inserts ppoints into a pcurve (see page 298). 

 Deletes the selected ppoint (see page 305) on a pcurve. 

 Most operations are available when multiple surfaces are 
selected. 

 

Selecting pcurves 
You can use the pcurve selector to select multiple pcurves on 
multiple surfaces. 

1 Select the surfaces. 
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2 Click  (Pcurve editing toolbar). 

 
3 Use the dialog to select pcurves. 

List of pcurves - This is the list of pcurves on the surface 
displayed in the Surface drop down list. You can use this list to 
select the pcurves. A single click selects a single item. Pressing 
the Shift key when clicking a single item, selects all the items 
from the last selected item to the clicked item. Pressing the 
Control key when clicking a single item, adds/removes the 
clicked item from the current selection. 

You can also select pcurves by clicking them on the screen. 

Surface drop down list - This contains the names of the selected 
surfaces. You can choose another surface from the drop down list 
and its pcurves are displayed in the list. 

 Any selected pcurves remain selected when you use the 
drop down list to select another surface. 

4 Click OK to confirm the changes and remove the dialog from the 
screen. 

 

Selecting all pcurves 
You can select all the pcurves on selected surfaces. 

1 Select the surfaces. 

2 Click  (Pcurve editing toolbar). 
 

Selecting unused pcurves 
You can select all pcurves on surfaces which are not used to define 
a trim boundary. 



 

286 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

1 Select the surfaces. 

2 Click  (Pcurve editing toolbar). 

All unused pcurves are selected. 
 

Selecting points on pcurves 
You can use the ppoint selector to select multiple ppoints on 
surfaces. 

1 Select the surfaces. 

2 Click  (Pcurve editing toolbar). 

3 Use the Ppoints dialog (see page 286) to select ppoints. 
 

Ppoints dialog 
Use this dialog to select ppoints. 

 
A single click selects a single item. Press the Shift key when clicking 
a single item selects all the items from the last selected item to the 
clicked item. Pressing the Ctrl key when clicking a single item, adds 
or removes the clicked item from the current selection. 

PCurve — Select a different pcurve using the drop-down list. 

 Any selected ppoints remain selected when you use the 
PCurve drop down list to select another pcurve. 

Ppoint — Enter a ppoint number into the field and press the Enter 
key to select it. 

Pattern select - Click to display the Pattern selector dialog (see page 
287). 
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Pattern Selector dialog 
Use this dialog to select ppoints (on the pcurve currently in the 
curve drop down list on the Ppoints selector dialog (see page 286)) 
using simple pattern sequences. 

 
Select every n point - This selects every nth ppoint starting at the 
first point in the range, where n is the number you input. If you 
enter 3, then the first ppoint in the range is selected followed by 
every 3rd ppoint. 

In range a to b - This is range of the ppoints to select from. 

For example, to select all even ppoints between 1 and 50, you 
would enter 2 in the Select every Point text box, and values 2 and 50 
in the Range text boxes. 

Add to selection - You can add the selection to the existing selection 
of ppoints by turning this option on. To make a fresh selection, turn 
this option off. 

OK - Makes the selection. 

For further details, see Selecting pattern of points (see page 116). 

You can also select ppoints by clicking them on the screen. 
 

Generating diagnostics on pcurves 
Badly defined pcurves (that can lead to badly trimmed surfaces) can 
be identified using the Identify badly trimmed surfaces (model fixing 
toolbar). You can closely analyse pcurves to see where any problem 
areas exist. 

1 Select the surfaces. 

2 Click  (Pcurve editing toolbar). This displays the Diagnostics 
dialog. 
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Diagnostics dialog (pcurves) 
This dialog displays details about pcurves (if in pcurve editing) and 
trim boundaries (if in boundary editing) on the selected surface. 

 
In the main window, the following information is displayed about 
each pcurve: 

 whether the pcurve is open or closed; 

 whether the pcurve has self intersections; 

 whether the pcurve is used in any boundary. 

Each of the above is given for information purposes and does not 
necessarily indicate a problem. 

Closed or open - Open pcurves are not a problem, providing they 
link with other pcurves to create a closed boundary. 

Self intersections - If a pcurve self intersects, it contains a loop. 
This may be the cause of loops within a boundary. 

Used in any boundary - If a pcurve is not used in a boundary, you 
may delete it or use it to create a new boundary. 

Similarly, you can analyse the boundaries on the surface. For 
further details, see Generating diagnostics on boundaries (see page 
275). 

Update - Click to update the edited pcurves. This updates the 
information. If you change to boundary editing and click this option, 
information about the boundaries is displayed. For further details, 
see Generating diagnostics on boundaries (see page 275). 

Dismiss - Removes the dialog from the screen. 
 

Removing spikes from a pcurve 
This deletes points in the selected pcurve where the angle between 
the line segments is less than angular tolerance. 

1 Select the pcurve. 
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2 Click  (Pcurve editing toolbar). 

 
 Angle greater than angular tolerance. 

 Angle less than angular tolerance. 
To change the angular tolerance:  
1 From the Tools menu, select Options to display the Options 

dialog.  

2 Select the Units and Tolerances option. 

3 Change Angular tolerance to the required value. 

4 Click OK. 
 

Removing loops from a pcurve 
This deletes points in the selected pcurve which cause loops. 

1 Select the pcurve. 

2 Click  (Pcurve editing toolbar). 
 

Removing surplus points from a pcurve 
This deletes points in the selected pcurve which are coincident 
(within tolerance). 

1 Select the pcurve. 

2 Click  (Pcurve editing toolbar). 
 

Labelling points on a pcurve 
1 Select the pcurve. 

2 Click  (Pcurve editing toolbar). 
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Points on the pcurve are now labelled. 

 

 Only a subset of points are labelled. This helps you to see 
the labels, because typically points are very close together. 

 

Making pcurves from wireframe 
This allows you to make pcurves from wireframe lying on a surface, 
within tolerance, or by projecting wireframe onto a surface. 

1 Select the surface. 

2 Click  (Pcurve editing toolbar). 

3 Use the Make Pcurve dialog (see page 290) to create the 
pcurves. 

 

Make Pcurve dialog 
Use this dialog to create pcurves from wireframe. 

 
1 Select how you want to create the pcurves. 

2 Select the wireframe to create the pcurves from. 

3 Create pcurves. 

4 Use the Undo or Redo buttons on the Main toolbar. to undo or 
redo any pcurves you create. 

5 Click OK when you have finished creating pcurves. 

The pcurves are then created automatically. 

Exact — This allows you to make pcurves from wireframe lying on 
the surface. 
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After you have selected Exact, you need to select the wireframe 
. 

 
Only select wireframe which is lying on the surface as any 
wireframe lying above or below the surface cannot be used to 
make pcurves with this method. 

The pcurves created are only made with the wireframe touching 
the surface and any part of the wireframe which extends beyond 
the surface is ignored. This is shown below . 

 The wireframe has not been drawn to show the pcurves 
more clearly. 

 
Project along principal axis — Select this option to create pcurves on 
a surface by projecting the selected wireframe along the current 
principal axis, independent of view direction. This can be thought of 
as shining a light onto the wireframe down the principal axis and 
creating a pcurve from its shadow. 
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Once you have selected Project along principal axis, you need to 
select the wireframe to project onto the surface . You can 
select any wireframe, regardless of whether it lies on the surface. 

 
The pcurves are created by projecting the wireframe selection 
onto the surface, along the principal axis . In the example 
below the principal axis was set in the Z direction. 

 
Project along surface normals — Select this option to create pcurves 
on a surface by projecting the selected wireframe along the surface 
normal, independent of view direction. This can be thought of as 
shining a light onto the wireframe down the surface normal axis and 
creating a pcurve from its shadow. 

Once you have selected Project along surface normals, you need 
to select the wireframe to project onto the surface . You can 
select any wireframe, regardless of whether it lies on the surface. 

 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 293  

The pcurves are created by projecting the wireframe selection 
onto the surface, along the surface normal . 

 
Project along view normal — Select this option to create pcurves on a 
surface by projecting the selected wireframe along the view normal, 
independent of the principal axis. This can be thought of as shining 
a light onto the wireframe through the screen and creating a pcurve 
from its shadow. 

Once you have selected Project along view normal, you need to 
select the wireframe to project onto the surface . You can 
select any wireframe, regardless of whether it lies on the surface. 

 
The pcurves are created by projecting the wireframe selection 
onto the surface, along the view normal . In the example 
below the view direction is ISO 1. 

 
OK — Click this to close the dialog. 

 

Copy pcurves 
This allows you to copy pcurves across surfaces. 

1 Select the surface. 

2 Click  (Pcurve editing toolbar).  
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3 Use the Copy Pcurves dialog (see page 294) to copy the pcurves. 
 

Copy Pcurves dialog 
Use this dialog to copy pcurves across surfaces. 

 
To copy pcurves across surfaces: 

1 Select the pcurves you want to copy. You can select multiple 
pcurves. 

2 Select the surface you want to copy to. 

3 Click Apply. 

The pcurves are copied to the new surface. 
 

Extending a pcurve 
This extends the selected pcurve to another position on the surface. 

1 Select the pcurve. 

2 Click  (Pcurve editing toolbar). 

3 Use the dialog to extend the pcurve. 
 

Extend pcurve dialog 
This provides tools to extend the selected pcurve to another position 
on its surface. 

Point labels are automatically displayed when the Extend pcurve 
dialog is displayed. The button to toggle Turn point labels on and off 

is available on the toolbar; click  to hide the labels. 
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 The curve extension options cannot work if the selected 
pcurve is closed. Closed curves can be opened using the Cut 
the pcurve option. 

Select the pcurve to extend — Select this option then graphically 
select a pcurve on your surface, or select a pcurve from the drop-
down list to extend from. 

Extend at — This allows you to choose which end of the pcurve to 
extend. The point numbers shown on the selected pcurve allow you 
to see which are the start and end points. 

You can graphically set the Extend at option by clicking the graphic 
handles at the end of each pcurve. Click the handles to toggle 
extension of or off. 

  — This handle indicates that the Pcurve is extended from this 
end. 

  — This handle indicates that the Pcurve is not extended from 
this end. 

You can initialise the Extend at option by pre-selecting points on the 
pcurve before opening the dialog: 

 If the start point is pre-selected, the option is set to Start of 
pcurve. 

 If the end point is pre-selected, the option is set to End of pcurve. 

 If both the start and end points are pre-selected, the option is 
set to Both ends of pcurve. 

 If no points are selected, the option defaults to the last set value. 

Method — This allows you to choose how and where to extend the 
pcurve. The option menu contains the following options: 
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 Tangentially to nearest edge — Extends the pcurve along the 
tangent(s) at its chosen end point(s) to the nearest edge(s) of 
the surface . 

 

 The picture shows one end extended, but both ends can be 
extended if the Both ends option is selected from the Extend 
At menu. 

 By shortest route to nearest edge — Extends the pcurve along the 
shortest route to the nearest edge of the surface . 

 

 The picture shows one end extended, but both ends can be 
extended if the Both ends option is chosen from the Extend 
At menu. Each will take the shortest route, which may not 
be to the same edge of the surface. 
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 Tangentially to a pcurve — Extends the selected pcurve, along the 
tangent at its end point, to another pcurve within the same 
surface. If the surface contains more than two pcurves, the 
Extend to pcurve drop—down list becomes active, allowing you to 
choose. 

 By shortest route to a pcurve — Extends the selected pcurve by 
the shortest distance to another pcurve within the same surface. 
If the surface contains more than two pcurves, the Extend to 
pcurve drop—down list becomes active, allowing you to choose a 
pcurve. 

Select the pcurve to extend to — Select this option then graphically 
select a pcurve on your surface, or select a pcurve from the drop 
down list to extend your initially selected pcurve to. 

Apply — Extends the pcurve. 

OK— Extends the pcurve and closes the dialog. 

Cancel — Closes the dialog and does not extend the pcurve. 
 

Cutting a pcurve into two 
This cuts the selected pcurve into two at the selected point. 

1 Select a pcurve. 

2 Select a point on the pcurve. 

3 Click  (Pcurve editing toolbar). The names of the pcurves are 
defined as follows: 

If the name of the selected pcurve was 3, then one pcurve is 
3 and the other 3A. 

 

Opening a pcurve 
This removes the span which joins the first and last points of the 
pcurve. 

1 Select a pcurve. 

2 Click  (Pcurve editing toolbar). 
 

Closing a pcurve 
This adds a span to the first and last points of the pcurve. 

1 Select a pcurve. 

2 Click  (Pcurve editing toolbar). 
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Deleting a pcurve 
1 Select the pcurve. 

2 Click  (Pcurve editing toolbar). 

Any trim boundary defined by this pcurve is also deleted. 
 

Editing a point on a pcurve 
This allows you to edit the t and u parameters of a point on a 
pcurve. 

1 Select the pcurve. 

2 Select the point you want to edit. 

3 Click  (Pcurve editing toolbar). 

4 Use the dialog to edit the selected point. 
 

Edit ppoint position dialog 
This allows you to edit the position of a point. 

 
T — Enter a value to define the t parameter value for the selected 
point. 

U — Enter a value to define u parameter value for the selected 
point. 

A preview is displayed on the model when you edit a ppoint 
position. 

For further details, see What is a pcurve? (see page 282). 

 If you click any position on the surface, its t and u values are 
read into the dialog. 

OK — Click apply any changes and move the point to the new 
position. 

Cancel — Click to close dialog without making any changes. 
 

Inserting a point in a pcurve 
You can insert ppoints which either preserve or change the shape of 
the pcurve. 
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1 Select one pcurve. 

2 Click  (Pcurve editing toolbar). 

3 Use the Insert ppoint into pcurve dialog (see page 299) to insert 
ppoints. 

 

Insert ppoint into pcurve dialog 
Use this dialog to insert ppoints. 

 
There are two tabs: 

In PCurve — Inserts ppoints without changing the shape of the 
pcurve. See In PCurve tab (see page 300). 

Off PCurve — Inserts ppoints to change the shape of the pcurve. 
See Off PCurve tab (see page 302). 

Each of the above is discussed in a separate section below. 

Other buttons on the dialog are: 

Preview — Displays the new ppoint in the pcurve. You can change 
the settings on the dialog until you are satisfied with the previewed 
pcurve. 

Apply — Inserts a new ppoint into the pcurve. 

Dismiss — Removes the dialog from the screen. 
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In PCurve tab 
Use this page of the dialog to insert ppoints without changing the 
shape of the pcurve. 

 
There are two ways to insert ppoints using this page of the dialog: 

 By Value — This inserts a ppoint at a specific parameter value. 
Enter the parametric value of where you want the new ppoint to 
lie in the pcurve. 

If you enter 3.5, a new ppoint with label 4  is added to the 
pcurve and other ppoints are renumbered. 

 
 Nearest Point — This inserts a ppoint on the pcurve nearest a 

specified point. Enter the X Y Z coordinates or click the Position 
 button to open the Position dialog where you can use position 

entry tools. 
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1 Enter the X, Y, Z coordinates. In the following example, the 
coordinates match the indicated point . 

 
2 The position is found on the pcurve nearest to these 

coordinates . 
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3 A ppoint is inserted at that position. The new ppoint has label 
3 and other ppoints are renumbered . 

 

 You can also enter a position by clicking on the screen. 
 

Off PCurve tab 
Use this page of the dialog to insert ppoints by changing the shape 
of the pcurve. 
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The following example illustrates the options on this dialog. 

 
Position - This defines the position of the new ppoint in the pcurve. 
For example, if you enter 3, the new ppoint becomes 3 and all the 
original ppoints from 3 onwards are renumbered. 

There are two ways to insert ppoints using this page of the dialog: 

 Parametric - This inserts a ppoint into the pcurve at the T and U 
parameters on the surface. See What is a pcurve? (see page 
282) for further details about t and u parameters. 

In this example, you want to insert a new ppoint at T = 3 and U 
= 4 . 
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To make the new ppoint lie between ppoints 4 and 5, you need 
to enter 5 in the Position box. The result is shown in the image 
below: 

 
 Geometric - This enters a ppoint at the position on the surface 

nearest to the specified point. Enter the X Y Z coordinates or click 
the Position  button to open the Position dialog where you can 
use position entry tools. You can also enter a position by clicking 
on the screen. 

1 Enter the X, Y, Z coordinates. In the following example, the 
entered coordinates match the following position :  
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2 To make the new ppoint lie between ppoints 2 and 3, enter 3 
in the Position box. The result is shown in the image below:  

 
 

Deleting a point on a pcurve 
1 Select the pcurve. 

2 Select the point on the pcurve. 

3 Click  (Pcurve editing toolbar). 
 

Creating wireframe curves from pcurves 
With the pcurve editing toolbar displayed,  

1 From the Edit menu, select Convert. 
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2 From the Convert sub-menu, select To wireframe to create curves 
from selected pcurves. 
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Preparing for manufacture 
The following sections provide information on preparing for 
manufacture. 

Introduction to preparing for manufacture (see page 307). 

Creating a split surface (see page 309). 

Creating a draft surface (see page 324). 

Creating an extension of a surface (see page 332). 

Creating a fill edge surface (see page 340). 

Creating an addendum surface (see page 344). 

Creating a drawbead surface (see page 353). 

Untrimming a trimmed surface (see page 355). 
 

Introduction to preparing for manufacture 
Split and draft surfaces play an important role in designing 
components and tooling for material-forming applications. In most 
mold or die applications it is vital to establish the natural split line, 
and to design a split surface for machining. In most cases, you must 
use a draft angle in the surface of a mold or die to enable the 
product to be withdrawn. 

 
In PowerSHAPE, you can create split and draft surfaces. There is 
also a wizard to help you create a mold for a single, connected 
solid. 
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What is a split line? 
A surface's natural split line or occluding boundary is the line around 
a surface where the surface, when looked at along the draw axis 
(that is, the direction in which the mold or die is to open), just dips 
out of sight . 

 
PowerSHAPE can find the natural split line automatically and 
generate new curves to represent this line. For further details see 
Creating a draft curve in the Wireframe modelling Manual. 
Alternatively, you can specify a curve by creating a composite curve 
from existing geometry, for example, edges of surfaces. For further 
details see Creating a composite curve by tracing in the Wireframe 
modelling Manual. 

 

What is a split surface? 
A split surface is a surface created from the split line and is also 
known as a 'run-off' surface. 
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What is a draft surface? 
A draft surface is one which projects from a model onto a split 
surface at a small angle, as shown below. The draft angle ensures 
that the component will separate from the mold cavity. 

 
 

Creating a split surface 
You can create split surfaces using two methods: 

 offsetting a single split line 

 fitting an existing surface to split lines 
Creating a split surface by offsetting a single split line 

The split surface is created by selecting a composite curve as the 
split line. This split line is then offset by a specified distance and 
along a specified angle. One side of the split surface is the split line 
and the other the offset of the split line. 

1 Click  (Surface toolbar). 

2 Select the Composite curve option from the Split Surface dialog. 
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3 Select the composite curve which defines the split line. 

 
4 Fill in the dialog. 
Creating a split surface by fitting a surface to split lines 

The split surface is created by modifying an existing surface to fit 
split lines. The split surfaces: 

 preserve the outline of the surface and the tangency at the 
outline. 

 fit the wireframe at directions parallel to the principal plane. 

PowerSHAPE will also attempt to trim off the surface inside of the 
wireframe. 

1 Click  (Surface toolbar). 

2 Select the Surface option from the Split Surface dialog. 

 
3 Select the surface. 
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4 Select the Split lines option from the Split Surface dialog. 

 
5 Select the section of wireframe along which you want to split the 

surface. 

 
6 Click Preview to see the result. 

PowerSHAPE generates the split surfaces and attempts to trim 
off the surface inside of the wireframe. 

 
7 Change the selection if necessary. 

8 Click OK when you have the required results. 
 



 

312 • Surface modelling PowerSHAPE 2015 R2 Reference Help  

Split Surface dialog 
Use this dialog to create a split surface. 

 
Selection Mode - To add objects to a selection mode, turn on a mode 
and then select the objects. 

Split line only - Use the Composite curve mode to select the 
composite curve for the method of creating a split surface by 
offsetting a split line. The Composite curve option is preselected if 
a composite curve is present in the model. You can then select 
the required composite curve, if it is not already selected. 

Surface and split Lines - Use the Surface and Split lines (wireframe) 
modes to select the surface and wireframe for the method of 
creating a split surface by fitting a surface to split lines. There 
are no other options on this dialog for this method. 

The rest of the dialog contains options for the method of creating a 
split surface by offsetting a split line. 

Offset distance - This is the distance of the second side of the split 
surface from the split line. 

Angle - This is the angle of the second side of the split surface from 
the split line. Two arrows are drawn at right angles (normal) to the 
composite curve and are used to measure the angle. The direction 
of the arrows is determined by the Measure Angle From options. 
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Measure Angle From - You can create the split surface relative to 
either the principal plane or the normal of the underlying surface. 
The directions of the two arrows on the split line are determined by 
these options: 

Principal plane - One arrow points parallel to the principal plane 
 and the other parallel to the axis normal to the principal plane 
. 

 
The angle is measured from one arrow to the other as shown 
below: 
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 Arrow pointing along the axis normal to the principal plane. 

 Arrow pointing parallel to the principal plane. 

You can change the direction of the arrows by clicking them or 
typing one of the following commands in the command window: 

REVERSE PROFILE - reverses the 'normal' direction 
instrumentation arrow. 

REVERSE WITHDRAWAL_DIRECTION - this reverses the 
withdrawal direction instrumentation arrow. 

The arrow parallel to the principal plane determines the direction 
of the laterals in the split surface. You can set its direction using 
the Split direction options. 

Normal to underlying surface - For this option to be available, the 
composite curve must be created from the underlying surface. 

One arrow points along the normal of the underlying surface and 
the other parallel to the tangent of the underlying surfaces. 

In this example, if you click Normal to underlying surface, the 
arrows change as shown below. 

 
The angle is measured from the arrows as shown below. 
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 Arrow pointing along the tangent of the surface. 

 Arrow pointing along the normal to the surface. 

Click the arrow pointing along the surface normal to change its 
direction. 

 The arrow parallel to the tangent of the underlying surfaces 
will affect the direction of laterals in a split surface created 
at an angle. You can set its direction using the Orthogonal 
direction options. 

Process Split Surface - You can choose whether to retain the 
tangency across the split surface or smooth out any ripples in the 
surface. 

Preserve symmetry - This preserves the symmetry of the split 
surface when using the Align to Axes option in the Split Direction 
menu. 

 This option only preserves existing symmetry. It does not 
guarantee a symmetric result if the split curve is not itself 
symmetrical. 

In some cases, the curve may look symmetrical, but the points are 
distributed differently, especially around the corners where the 
decisions to change direction are made. This can cause an 
asymmetric result even with this option enabled. 

Trimmed plane – This option is active if the split curve is planar and 
the composite curve is closed. By default it is set to OFF. If you 
select Trimmed Plane, Offset distance is used as the distance the 
bounding box of the split curve is enlarged to create the edge of the 
trimmed plane. 

 If Trimmed plane is ON, all options apart from Offset Distance 
become inactive as they not required when using this method. 

 
Without the Trimmed plane option, it would be impossible to create a 
sensible split surface for the curve shown above. This result is 
shown by the model on the left. The model on the right shows the 
result when the Trimmed plane option is ON. 
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Split direction - If you measure the angle from the principal plane, 
you can set the direction of the laterals within the split surface using 
one of the following options: 

Align to axes - The laterals of the split surface are parallel to the 
axes of the principal plane (prior to smoothing). For example, if 
principal plane is the XY plane, the laterals of split surface will 
run parallel to the X or Y axis. Use this option when the split line 
is nearly at right angles to the axes. 

Radially out - The laterals of the split surface are normal to the 
composite curve. Use this option when the model is mostly 
convex. 

Surface normal - (Option only available if the composite curve has 
an underlying surface) The laterals of the split surface lie along 
the normal of the underlying surface projected onto the principal 
plane. Use this option when the split line is mostly convex. 

Surface internals - (Option only available if the composite curve 
has an underlying surface) The laterals of the split surface lie in 
the direction of the internal curves of the underlying surface 
projected onto the principal plane. This option works well for 
most shapes, but should be avoided for near vertical edges. 

Advanced - This displays the Split Segments dialog. You can use this 
dialog to break the split line into segments. For each segment, you 
can then specify the direction of the laterals. 

 - Create a Stepped Split Surface by specifying a number of 
parameters. Selecting this button displays the Stepped Split 
Surfaces dialog (see page 322). 

Orthogonal direction - When the Normal to underlying surface option 
is selected and the Angle value is greater than zero, Orthogonal 
direction affects the direction of laterals of the split surface using 
one of the following options: 
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Principal axis - Uses the axis normal to the principal plane as the 
direction of the laterals. This option is most useful for surfaces 
with edges that are trimmed at an angle. You must align the 
principal axis to the required direction of the split surface. This is 
done by creating a workplane before creating the split surface 
and pointing the workplane's principal axis in the direction you 
want to create the split surface. 

Curve normal - The direction of the laterals lie along the normal 
of the composite curve. This is the best option for creating split 
surfaces radially around flat surfaces, or when the composite 
curve is in the plane perpendicular to the required direction of 
the split surfaces. 

Surface internals - The direction of the laterals lie along the 
direction of the laterals and longitudinals of the underlying 
surface. This option can sometimes get the required result when 
the other two options fail. 

Preview - Displays the split surface created using the current 
settings in the dialog. You may continue to change the settings in 
the dialog until you are satisfied with the previewed split surface. 

 
Apply — Creates the split surface. 

OK - Creates a split surface and closes the dialog. 

Cancel - Closes the dialog and does not create a split surface. 
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Split Segments dialog 
Use this dialog to break the split line into smaller segments and use 
them to define the direction of the laterals in the split surface. 

 
In the diagram below, you can see a segment of a split surface at a 
rounded corner. 

 
Insert breakpoints - While this option is selected, you can insert and 
remove split segments from the split line. 

To insert breakpoints, click positions on the split line. In the 
example below, two breakpoints have been inserted at the corner 

. 

 
To remove a breakpoint, hold down the Ctrl key and click the 
breakpoint. 

Once you have entered the breakpoint, turn off the Insert 
breakpoints option. 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 319  

When  is showing, the breakpoint is selected as a single 
breakpoint. 

If you add a single breakpoint, it will look as shown below: 

 
The lateral at this point follows the direction of only one of the 
segments. 

To find out the direction of the lateral at the breakpoint, set the split 
direction of the segments on either side of the breakpoint and then 
select Preview. 

In the example below, you can see one lateral at each single 
breakpoint. 

 

When  is showing, the breakpoint is selected as a split point that 
can go in two directions. 

If you add a split breakpoint, it will look as shown below: 

 
This breakpoint represents two points which lie on top of each 
other. A lateral is created from each point. One lateral follows the 
split direction of the segment on one side and the other lateral 
follows the split direction of the segment on the other side. 
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In the example below, you can see two laterals at each split 
breakpoint. 

 
If you select the Along axis option on the Split surface dialog, 
breakpoints are automatically added where the curve changes 
direction. You can edit these breakpoints like the ones you insert 
manually. 

Clear - Removes all selected breakpoints. 

Current segment - Select a segment from the drop down list. The 
segment is highlighted in the model and has an arrow in it giving 
the default direction of the laterals . 

 
Split direction - Choose a direction from the menu. This menu 
contains three directions: 

Default - Uses the direction as specified on the Split Surface 
dialog. You can reverse the direction of the laterals. 

Radial - Uses the direction along the normal of the split line. 

Along axis - Uses the direction along the axis specified on the 
dialog. Select an axis from the options displayed. 

When you select an option, the arrow changes to the specified 
direction. 
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In this example, the Radial option was selected. 

 
To reverse the direction of the laterals to the opposite side of the 
composite curve, click the arrow. 

Angle - Defines the angle for the segment of the split surface. The 
default setting is the default angle for the split surface as a whole. 

Preview - This displays the direction of the laterals in the whole of 
the split surface. 

 
OK - Saves the changes and takes you back to the Split Surface 
dialog. 

To preview the new split surface, you need to click Preview on the 
Split Surface dialog. 

 

 The instrumentation arrow is placed at the midpoint in the 
following cases 

 if the span has only two points. 

 if the existing midpoint is coincident with an endpoint. 
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Stepped Split Surface dialog 
Use this dialog to create a stepped split surface. 

 
Colour coding has been used alongside the labels to help identify 
the values. 

Radius 1 —  Enter a value for the angle of the first radius. 

Radius 2 — Enter a value for the angle of the second radius.  

If you enter zero radii in the Stepped Split Surface dialog, the result 
is a sharp discontinuity with no fillet. This is needed in some 
complex cases where the fillet may need to be added manually 
later. 

 — Toggle between chamfered or filleted edges. The corners of 
the step can be either filleted or chamfered. The option can be set 
independently for Radius 1 and Radius 2. 

 Choosing the chamfer option does not create a chamfer of the 
length in the radius box, but keeps the distance between the 
points the same as they were for the fillet, joining them with 
a straight line. 

 The Land distance stays constant at the given value. 
Increasing the Radius 1 moves the draft part of the step out, 
rather than keeping it in the same place and reducing the 
land distance. 

Angle — Enter a value for the draft angle. 

Land distance — The initial flat split distance. 

Total distance — This value indicates the total extent of the stepped 
split surface. 
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Height 
Distance — Height of the step. This value can be specified in 
three ways: 

From active workplane — The height is the distance along the 
principal axis from the principal plane in the current workplane. 
This option means that the run-off part of the surface (the bit 
after the step) will always be planar. 

From land — The run off will be an offset continuation of the land 
and follow the 3D shape of the original split line. 

 
To Binder surface —  This option is active when you select a 
binder surface. The value entered for Distance is ignored. The 
step is effectively a draft onto the binder surface that is then 
filleted/chamfered back. 

 
Preview - View the stepped split surface. 

OK - Accept the values and close the dialog. 

Cancel - Return to the Split Surface dialog. As the direction of the 
laterals in the stepped split are identical to those in the basic split, it 
is useful to be able to return to the Split Surface dialog to change 
the Split Direction or to use the Advanced options before returning to 
the stepped split surface page. 

 

Editing a split surface 
A split surface is a Power Surface and is edited accordingly. For 
further details, see Editing Power Surfaces (see page 112). 
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Creating a draft surface 
Draft surfaces can be generated from either a set of surfaces or a 
composite curve. The creation method of the draft surfaces is very 
similar for both starting objects. 

When draft surfaces are generated from a set of surfaces, 
PowerSHAPE automatically generates composite curves known as 
draft curves on the surfaces. Each draft curve generates a draft 
surface as follows. One side of the draft surface is the draft curve. 
The draft surface projects along the draft angle until it touches 
either: 

 the principal plane. 

 a group of surfaces. 

If you are not entirely satisfied with the automatically generated 
draft curves, you can generate draft curves from a surface by using 
the Create a draft curve option (Curve toolbar) and edit them to your 
requirements. 

When a draft surface is generated from a composite curve, 
PowerSHAPE treats the composite curve as a draft curve. In this 
case, it also allows you to vary the draft angles along the draft 
surface. 

1 Click  (Surface toolbar). 

The Draft Surface dialog (see page 325) is displayed. 

2 Complete the dialog. 

 PowerSHAPE checks that you have an appropriate licence 
when you try to use Draft surfacing. An error message is 
displayed if the appropriate licence is not available. 
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Draft Surface dialog 
Use this dialog to create a draft surface. 

 
Valid selection — If valid objects are selected, a tick is displayed. 
Select one of the following: 

 A composite curve. 

 One or more surfaces. 

 One or more solids. 

Draft angle — This is the angle the draft surface will be projected 
from the selected objects. You can also use a negative angle when 
creating a draft surface. 

Variable — This option is only available if you are creating a draft 
surface from a composite curve. It enables you to create a draft 
surface with variable draft angles. 

Once this option is selected, the Preview button is greyed out. When 
you click Apply, the Variable Draft (see page 331) dialog is 
displayed. Use this dialog to input the variable draft angles. 

Measure angle from — The draft angle is measured (by default) from 
the axis normal to the principal plane. The Tangent to underlying 
surface option is only available if you are creating a draft surface 
from a composite curve that lies on one or more surfaces. 
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If you are creating a draft surface from surfaces or solids, an arrow 
is projecting out from the surfaces. It is parallel to the axis normal 
to the principal plane and is used to calculate where the draft curves 
lie on the surfaces. 

 
Remember that one side of the draft surface is defined by the draft 
curve. 

The points of the draft curves are positions on the surfaces where 
the angle between the tangent and the arrow equals the draft 
angle. 

 
The draft surface is projected along this tangent until it touches 
whatever you select as the Type of Projection on the dialog. 

Click the arrow to change its direction if you want the draft surfaces 
to project in the other direction. 

If you are creating a draft surface from a composite curve, two 
arrows are drawn on the composite curve. Both arrows determine 
the direction of projection of the draft surface. 
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With Normal to principal plane selected from Measure angle from 
options, one arrow is parallel with the principal plane and the other 
with the axis normal to the principal plane (see below). 

 
The draft angle is measured between the arrows as shown below. 

 
You can change the direction of the arrows by clicking them or 
typing one of the following commands in the command window: 

REVERSE PROFILE  — reverses the 'normal' direction 
instrumentation arrow. 

REVERSE WITHDRAWAL_DIRECTION — this reverses the 
withdrawal direction instrumentation arrow. 

Ensure that the arrow along the normal to the principal plane points 
in the correct direction, usually in the direction of the split surface. 
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If you require a draft surface that projects outwards, ensure the 
arrow parallel to the principal plane points outwards: 

 
If you want a draft surface that projects inwards, ensure the arrow 
parallel to the principal plane points inwards: 

 
If your composite curve is created from the underlying surface, you 
can use the tangent data of the surface to define the draft angle. To 
use the tangent data, select Tangent to underlying surface from the 
Measure angle from options. The arrows change direction such that: 

 the arrow pointing parallel to the principal plane now points 
along the normal of the underlying surface; 

 the arrow pointing normal to the principal plane now points 
tangent to the surface. 
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Consider the following composite curve on a surface. With Normal to 
the principal plane selected (by default) from the Measure angle from 
options, the arrows point as shown below. 

 
With Tangent to underlying surface selected, the arrows point as 
shown below. 

 
The draft angle is measured between the arrows as shown below. 

 
You can click the arrows to change their direction. 
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In our example, the following draft surface is created when we enter 
a draft angle of 5 . 

 
Type of projection — This allows you to choose where to project the 
draft surface. 

Project onto principal plane — This option projects the draft surface 
onto the principal plane. 

Project onto selected surface — You can project the draft surface 
onto a number of surfaces. Select the surfaces and a TICK appears 
in the box. If the surfaces overlap one another, the draft surface is 
projected onto the surface nearest to it. 

 If the draft surface does not entirely project onto the surface 
or the plane, a draft surface is created on the portion of the 
surface or plane that it can project onto. 

Options: Draft both sides of the surface — (Available only when 
creating draft surfaces from surfaces.) This ignores the arrow 
projecting out of the surfaces and creates draft surfaces from both 
sides of the surfaces. 

 If the surfaces are not symmetrical about the surfaces or 
principal plane onto which the draft surfaces are projected, 
PowerSHAPE matches the draft surfaces by increasing the 
draft angles along the draft surfaces, where necessary. 

Smooth — This smooths out any ripples in the surface. It frees 
projected tangents where appropriate and preserves straight spans. 

Preview — Displays the draft surface using the current settings on 
the dialog. You can continue to change the settings on the dialog 
until you are satisfied with the previewed draft surface. 

Apply — Creates draft surfaces in the model, trims the set of 
selected surfaces to the draft curves. The dialog remains on the 
screen for you to select more objects and continue creating draft 
surfaces. 

Cancel —Closes the dialog. 
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Variable Draft dialog 
This dialog adds variable draft angles on the draft surface. 

 
Projection lines are drawn at the ends of the composite curve to 
mark the draft angles of the draft surface. 

 
If the composite curve is closed, no projection lines are drawn. 

Click positions on the composite curve where you want to input 
specific draft angles. 

 
A projection line is inserted at each position. 

 
Current projection line - The number of the current line is given here. 
You can select a projection line from either the drop down list or the 
screen. 

Delete - Deletes the current projection line. You can't delete the 
projection lines at the ends of the composite curve. 
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Draft angle - This is the draft angle of the current projection line. If 
you change the angle, the current projection line moves to the new 
position. If the preview surface is displayed and you insert a new 
projection line, the value of the draft angle is taken from the 
preview surface. 

 
Interpolation - You can vary the draft angles either linearly or 
smoothly in between projection lines. 

 
Preview - Displays the draft surface using the current settings on 
the dialog. You can continue to change the settings on the dialog 
until you are satisfied with the previewed draft surface. 

OK - Creates the draft surface in the model. The dialog is removed 
from the screen and you are returned to the Draft Surface dialog. 

Cancel - No draft surface is created. The dialog is removed from the 
screen and you are returned to the Draft Surface dialog. 

 

Editing a draft surface 
You may wish to edit the outer boundary of the draft surface. A 
draft surface is a power surface and is edited accordingly. For 
further details, see Editing Power Surfaces (see page 112). 

 

Creating an extension of a surface 
You can extend a group of surfaces by creating a new surface which 
is tangent to the other surfaces along a common edge. 

1 Orientate the surface normals of your surfaces. 
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As a general rule, you should always keep the surface normals 
pointing out from the material. 

Make sure the outside of two adjacent surfaces match by 
reversing the surface normals if necessary. 

The surface normals of the surfaces determine the direction of 
the extended surface. 

2 From the edges of your surfaces, create a composite curve . 

 
When you create a composite curve from a surface, the tangent 
data of the surface is stored with the definition of the composite 
curve. 

3 Select the composite curve. 

4 Click  (Surface toolbar). 

5 Use the Surface Extensions dialog (see page 333) to extend the 
surface. 

 

Surface Extension dialog 
Use this dialog to create a surface tangent to the surface used to 
create the composite curve. 
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Angle — This is the angle the new surface is projected from the 
existing surface. 

Two arrows are drawn on your composite curve. One arrow points 
along the surface normal  and the other along the surface tangent 

. 

 
Both arrows are used to calculate the angle of the surface 
extension. The angle is measured from the arrow along the surface 
tangent to the one pointing along the surface normal (see below). 

 
You can change the direction of the arrows by clicking them or 
typing one of the following commands in the command window: 

REVERSE PROFILE — reverses the 'normal' direction 
instrumentation arrow. 

REVERSE WITHDRAWAL_DIRECTION — this reverses the 
withdrawal direction instrumentation arrow. 

For our example, we want the new surface to point downwards 
along the surface tangents. The arrow pointing along the surface 
tangent is in the correct direction. We leave the angle as zero. 

Distance — This is the distance the new surface is projected from 
the composite curve. 

In our example, we enter 5. 

Along — This sets the direction of the extension using one of the 
following options. 

Principal axis 
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Curve normal 
Surface internals 

We will use the following surface to illustrate these options. 

 
Principal axis — Uses the axis normal to the principal plane as a 
guide to extend the surface. 

In the example below, the Z axis is the principal axis. 

 
This option is most useful when extending an edge of a surface that 
is trimmed at an angle. 

You must align the principal axis to the required direction of the 
extension. This is done by creating a workplane before creating the 
extension and pointing the workplane's axis, which is normal to the 
principal plane, in the direction you want to create the extension. 
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Curve normal - Extends the surface along the normal of the 
composite curve. 

 
This is the best option for extending radially around flat surfaces, or 
when the composite curve is in the plane perpendicular to the 
required direction of the extension. 

Surface internals - Extends the surface along the direction of the 
existing laterals and longitudinals of the surface. 

 
This option can sometimes get the required result when the other 
two options fail. 

Advanced - This displays the Extension Segments (see page 337) 
dialog. You can use this dialog to break the composite curve into 
segments. For each segment, you can then specify the direction of 
the extension. 
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Preview - Displays the surface created using the current settings on 
the dialog. You can continue to change the settings in the dialog 
until you see the required solution on the screen. 

 
OK - Creates the tangent surface and removes the dialog from the 
screen. 

Cancel - Does not create the tangent surface and removes the 
dialog from the screen. 

 

Extension Segments dialog 
Use this dialog to break the composite curve into smaller segments 
and use them to define the direction of the laterals in the extension 
surface. 
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In the diagram below, you can see a segment of an extension 
surface at a rounded corner. 

 
We will show you how to improve this extension surface at the 
corner using the dialog. 

Insert breakpoints - While this option is selected, you can insert and 
remove breakpoints from the composite curve. 

To insert breakpoints, click positions on the composite curve. 

We inserted two breakpoints at the corner. 

 
To remove a breakpoint, hold down the Ctrl key and click the 
breakpoint. 

Once you have entered the breakpoints, turn off the Insert 
breakpoints option. 

Clear - Click to clear all guide-curves. 

 and  toggle - Click to toggle the direction of the breakpoints. 
For further details, see Split Segments dialog (see page 318). 
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Current segment - Select a segment from the combo box. The 
segment is highlighted in the model and has an arrow in it giving 
the default direction of the extension. 

 
Extension direction - Choose a direction from the menu. This menu 
contains the following directions: 

 Default - Uses the direction as specified on the Surface Extension 
dialog. You can reverse the direction of the laterals. 

 Curve normal - Uses the direction along the normal of the 
composite curve. 

 Along axis - Uses the direction along the specified axis on the 
dialog. 

 Surface internals - Uses the direction along the internal curves of 
the surface. 

When you select an option, the arrow changes to the specified 
direction. 

In our example, we choose the Curve normal option. 

 
To reverse the direction of the laterals to the opposite side of the 
composite curve, click the arrow. 

Angle - This is the angle the new surface segment is projected from 
the existing surface. 
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Preview - This displays the direction of the laterals in the whole of 
the extension surface. 

 
OK - Saves the changes and takes you back to the Extension 
Surface dialog. 

To preview the new extension surface, you need to click Preview on 
the Extension Surface dialog. 

 

 The instrumentation arrow is placed at the midpoint in the 
following cases 

 if the span has only two points. 

 if the existing midpoint is coincident with an endpoint. 
 

Fill edge surface creation 
This option is only available in Toolmaker mode.  
You can create a surface that will fill the gap between selected 
points on an existing surface. 

1 With PowerSHAPE running, click Module > Toolmaker 
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2 Select Surface  from the main toolbar to display the surface 
modelling toolbar. This includes Addendum surface and Fill edge 
regions buttons.  

 
3 Select the surface to be used. 

 

4 Click on Fill edge regions  to display the Fill Edge Regions 
dialog (see page 342). The points on the edge region are 
displayed on the model. 
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Fill Edge Regions dialog 
Use this dialog to create a surface using the fill edge regions. 

 

To use the Manual option 

1 Select Point 1 and Point 2 on the surface, as shown by  and  
. 

 
When you have made valid selections, both the  change to  
and the fill edge is highlighted. 
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Use the Reverse option on the Fill Edge Regions dialog to switch 
between the shortest path  and the longest path  for 
selected points. The surface that is created depends on the path 
that you select. 

 

 
2 Click Apply 

 

To use the Automatic option 
1 Adjust the Gap size to the maximum size of the gaps to be filled. 

Any gaps that are larger than the Gap size will not be filled. 

 
2 Click Fill all to Fill all the gaps the gaps that are smaller than the 

Gap size. 

3 Click OK. 
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Addendum surface creation 
This option is only available in Toolmaker mode. 
1 With PowerSHAPE running, click Module - Toolmaker 

 

2 Select Surface  from the main toolbar. The surface modelling 
toolbar is displayed. This includes Addendum surface and Fill edge 
regions.  
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3 Select the Binder surface and the surface that is to be used to 
create the addendum surface. This step is important as it is not 
possible to select the binder surface later. 

 

4 Click Addendum surface  to display the Addendum Surface 
Creation dialog (see page 345), with the Binder surface pre-
selected. 

5 Use the options on the dialog to enter the settings to be used 
when creating the surface. 

6 Click OK on the Addendum Surface Creation dialog to create the 
Addendum surface. 

 

Addendum Surface Creation dialog 
Use this to specify the parameters when creating an addendum 
surface. 
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 You cannot select the Binder surface during the creation 
process - it must be selected before you select the Addendum 
creation button from the surface modelling toolbar. 

Selection 
Use the options in this section to identify the surface and points that 
are to be used. 

1 Binder surface or Blank holder surface. The Binder surface must 
be larger than the part and situated below the part. The Binder 
surface  was selected before the dialog was displayed. 

 
2 Select Point 1 to be used to create the addendum surface. The  

changes to . The selection is indicated by  on the following 
model. 

3 Select Point 2 to be used to create the addendum surface. The  
changes to . The selection is indicated by  on the following 
model.  
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Points  
Use this section to add and delete points.  

 
On the model, green points are required to hold the edge of the 
addendum onto the part. If you remove a green point, you will end 
up with an overlap or a gap. Red points are redundant points. These 
can be deleted without causing any problem. 
To insert an additional boundary point: 

1 Click . 

2 Click on the boundary curve where the new point is to be 
created. 

To delete a point, or a selection of points from the boundary curve: 
1 Select your point(s). 

2 Click . 
To see an alternative solution for a surface that has sharp corners: 

1 Select   
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2 Click  and cycle through the possible solutions. 

 

 You can add or remove points either before or after creating 
your addendum surface. If you edit the points after creating 
an addendum surface, you will need to select Point 1 and 

Point 2 and click to create the amended surface. 

Selecting a profile 
Use the profile buttons to select an appropriate profile. 

  
If the profile is blue,  you cannot use the profile type you have 
selected. If the profile is yellow, the profile type you have selected 
can be used. The dimension options that are available is based on 
the profile you select. The Depth (D) is calculated automatically to 
ensure that the addendum surface intersects with the binder 
surface. 

 - Selecting this profile makes the following dimension options 
available 
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 - Selecting this profile makes the following dimension options 
available 

 

 - Selecting this profile makes the following dimension options 
available 

 

 - Selecting this profile makes the following dimension options 
available 

 

 - Opens the Parametric curve editor. Use the options in the 
Parametric curve editor to edit the selected profile. The buttons on 
the Parametric curve editor also appear on the 2D curve editing 
toolbar.  

  - Click to toggle between black and red width. This provides 
two solutions using different widths but keeping the remaining 
parameters the same. 
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Surfaces 

 - Create the addendum surface. 

 

 - Delete the currently selected addendum surface. You can 
select the addendum surface to delete by clicking on the surface 
itself, or by clicking on the points on the laterals. You can also 
delete the selected addendum surface using the Delete key. 

 - Click on any boundary point between the two surfaces you 
want to connect. Click to create the connected surface. You can 

delete the connection surface using the  button on the dialog or 
by using the Delete key. 

 

 - The Punch Open line is the intersection of the addendum 
surface and the binder surface and is typically a curve or a 
composite curve 

1 Select Point 1 and Point 2. 
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2 Select the curve or composite curve to be used as the PO line  

 

3 Click . 

The laterals that are used when creating the addendum surface 
will be extended to the PO line. 
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4 Click  to generate the addendum surface. 

 

String Length 
1 Click Display string length to activate the string length 

functionality. This controls the way oblique strings are displayed. 

 
2 Click Along X or Along Y to define the orientation of the oblique 

strings. 

3 Click on of the following: 

 Area to create 10 oblique strings with a sensible interval 
through all items (a main part + created addendum surfaces). 
The model below was created by selecting Along X and Area. 

 
 Point to create an oblique string through a picked on an item 

point.  

Pick a point. 
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The following model was created by selecting Along X and 
Point. 

 

 Switching off the Display string length option or closing the 
Addendum form removes all the oblique strings and labels.  

 

Creating a Drawbead surface 
This option is only available in Toolmaker mode. 
A Drawbead surface is a ridge constructed to hold the metal in 
position during the forming process. It is often created at the 
corners of the part. 

 
1 With PowerSHAPE running, click Module > Toolmaker. 
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2 Select Surface  from the Main toolbar. The surface modelling 
toolbar is displayed.  

 

3 Click  to display the Drawbead Creation dialog (see page 
354). 

4 Use the options in the dialog to define the Drawbead. 

5 When the Drawbead is correct, click OK. 
 

Drawbead Creation dialog 
This dialog lets you define the parameters to be used when creating 
the Drawbead surface. 

 
Selection - The options in this section let you choose the curve, 
surface and points to be used to create the Drawbead surface. 
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Curve selected - Select the curve to be used and The cross  icon 
changes to a tick  icon. 

Surface selected - Select the surface to be used and The cross  
icon changes to a tick  icon. 

Start point selected - Select the start point and The cross  icon 
changes to a tick  icon. 

End point selected - Select the end point and The cross  icon 
changes to a tick  icon. 

Parameters - The options in this section let you change the shape 
and size of the Drawbead surface by adjusting parameters. 

Offset selected curve - The selected curve will be offset by the 
value you enter. 

Full Rad - If ON, the radius R is applied to the profile and w* is 
automatically set to zero. 

R - Radius of the profile. 

Flip Vertical - If ON, the Drawbead is created in the -Z direction. 

H - Height of the profile. 

i - Angle of the side of the profile. 

W - Width of the base of the profile. 

w* - Width of the top of the profile. This is automatically set to 
zero if Full Rad is set to ON. 

Preview - Select to preview the results. You may make changes and 
preview again. 

Apply - Select to apply the results. 

Phase out - This tapers off the end of the Drawbead surface over a 
specified distance.  

Distance - Distance over which the phase out will occur. 
 

Untrimming a trimmed surface (Toolmaker mode only) 
This option is only available in Toolmaker mode. 
Create an untrimmed surface by selecting edges of existing trimmed 
surfaces and altering the boundaries out to make the surface larger. 
This is particularly useful for creating tangential split surfaces or 
addendum die faces. 

To create an untrimmed surface from existing trimmed surfaces: 
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1 Select a previously trimmed surface or surfaces. 

 
You can also select the composite curve that lies on the surface 
edges. 

 

2 Click  to display the Surface untrimming dialog. 

 



 

PowerSHAPE 2015 R2 Reference Help Surface modelling • 357  

Green and red markers have been added to the edges of the 
surface, as shown below: 

 
 indicates that there is trimmed edge available.  

 indicates an untrimmed edge. Selecting a red marker will not 
allow you to create a surface. 

3 Select Point 1. 

4 Select Point 2. 

The surface extension and drag handles are displayed on the 
model. 

 
5 Define the extent of the untrimmed  surface in one of the 

following ways: 
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 Use the drag handles that are displayed on the model. As you 
drag the handles, the value in Distance and the model are 
updated. 

 
 Enter a Distance in the dialog. Distance is the actual distance 

measured along the extension surface, not the projected 
distance.  

6 Click Apply to create the surface. The dialog is still displayed to 
let you create additional surfaces as required. 

 
7 When you have created the required surfaces, click OK. 
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